
Overview
Have you ever used the Internet, America Online, or CompuServe?    If so, you've probably encountered 
Zip files.    Are you a Windows user?    If so, WinZip is the way to handle these archived files.
WinZip® brings the convenience of Windows to the use of Zip files and other compression formats.
WinZip features include:

· Seamless Windows integration: WinZip includes tight integration with My Computer and 
Windows Explorer.    Drag and drop to or from Explorer, or zip and unzip without leaving Explorer.

· Internet support: WinZip features built-in support for popular Internet file formats:    TAR, gzip, 
UUencode, XXencode, BinHex, and MIME.    ARJ, LZH, and ARC files are supported via external 
programs.    You can use WinZip to access almost all the files you download from the Internet.    In
addition, the freely downloadable WinZip Internet Browser Support Add-On lets you download 
and open archives with one click using Microsoft Internet Explorer or Netscape Navigator.

· Automatic installation of most software distributed in Zip files:    If a Zip file contains a 
“setup” or “install” program, WinZip's Install feature will unzip the files, run the installation 
program, and clean up temporary files.

· The WinZip Wizard:    This optional feature uses the standard and familiar “wizard” interface to 
simplify the process of zipping, unzipping, and installing software distributed in Zip files.    The 
WinZip Wizard is not targeted at experienced users, but is ideal for the rapidly growing number of 
PC users getting started with Zip files.    When these users gain confidence or want to use more 
advanced zipping features, the full WinZip Classic interface is just a click away.

· Favorite Zip Folders: WinZip lets you organize Zip files into one convenient list that is sorted by 
date, making it easier to locate all Zip files, regardless of where they came from or where they are
stored.    Unlike the standard Open Archive dialog box, the Favorite Zip Folders dialog box treats 
the contents of multiple folders as though they were one folder.    A Search facility will find any Zip 
files lost on your hard disk.

· Create files that unzip themselves:    WinZip Self-Extractor Personal Edition is included with 
WinZip. Self-extracting files are ideal for sending compressed files to others who may not own or 
know how to use file compression software.

· Virus Scanner Support: WinZip can be configured to work with most virus scanners.
WinZip is extremely easy to use!    To open an archive simply double click on an archive listed in My 
Computer or Windows Explorer, drag and drop an archive onto WinZip, or use the standard Open dialog 
box.    The main WinZip window features a list with the names, sizes, and date/time stamps of all files in 
the open archive. This list can be scrolled and sorted on any field.    A configurable tool bar provides fast 
access to commonly used actions.    Extensive context sensitive help is always available.
Double clicking on a file in the main WinZip window has the same effect as double clicking in My 
Computer or Windows Explorer.    First, the file is extracted from the archive.    Then, if the file is 
executable, it is run.    Otherwise, the file is opened by the appropriate application (for example, WordPad 
for *.WRI files) based on standard Windows associations.
The Windows Drag and Drop interface is fully supported.    You can drag and drop files from WinZip to 
other applications.    WinZip will extract the files before dropping them on the target application.    The 
target application will treat the files as if they had been dropped from My Computer or Windows Explorer.  
You can also drop archives on WinZip to open them, or drop files on WinZip to add them to the open 
archive.



Awards and Magazine Quotes
WinZip® was voted Download of the Millennium on ZDNet and won the Shareware Industry Award 
2000 for Best Overall Utility, the Best Utility MVP Award from PC Computing (1/2000), the 2000 
People's Choice Award for Best Overall Utility, and the Winlist for 2000 on WinMag.com. 
Here's what magazine reviews say about WinZip:

· "This is the best Zip compression utility around, and if it's not on your hard drive, it should be" - 
CNet Review, 9/7/01

· "WinZip 8.1: The best compression utility keeps getting better" - ZDNet AnchorDesk, 8/30/01
· "… an indispensable package for extensive users of compressed files" - ZDNet Reviews, 8/30/01
· "WinZip is the granddaddy of unzippers, and it is still my all-time favorite" - ZDNet AnchorDesk, 

8/12/01
· "WinZip is the tool of choice, from compressing files to sending them over the Internet" - Rocket 

Download, 7/01
· "WinZip 8.0 [is] the standout in this category" - PC Magazine, 6/01
· "The … most celebrated shareware app in the history of computing" -Winmag, 8/15/00

Visit our web site for a more complete and up-to-date list of awards and magazine quotes.



Quick Start Information
There are several ways to get to know WinZip® quickly and easily; each tailored to a different style of 
learning. Choose one or more of the following approaches

· If you haven't installed WinZip yet, see WinZip Installation for brief installation instructions.
· Take a look at the Quick Start Guide, which introduces file compression terminology, describes 

the installation process, and takes a first look at basic WinZip operations.    (If you haven't 
installed WinZip yet, you'll have an opportunity during installation to print a nicely formatted 
version of the Guide.)

· Some users just like to dive right in! If you have experience with archives and Windows, you 
might want to do just that. Context-sensitive help is available at any time by pressing the F1 
key.

· You can get an overview of the primary operations of WinZip from the Brief Tutorial.
· If you like to “learn by doing,” try the WinZip Tutor Step by Step Instructions, which takes users

step by step through the process of zipping and unzipping.
· The WinZip Wizard leads you through the process of zipping or unzipping using a series of

panels or pages in a special window, commonly known as a “wizard.” This convenient 
alternative interface for WinZip can help to simplify zipping, unzipping and installing software.

Don't miss some of the other topics of interest that can help you get started:
· See Using the Explorer Interface for specific examples of how WinZip integrates with the 

Windows shell.
· Using Drag and Drop describes a useful WinZip feature.    Be sure to give it a try!
· The section on Hints and Tips lists many helpful ideas for using WinZip.
· For assistance in learning how to use the Windows help system, choose How to Use Help from 

WinZip's Help menu.



About Zip Files and Other Archives
What is an Archive?
Archives are files that contain other files.    Typically the files in an archive are compressed.    Archives 
usually have file names ending with ZIP, LZH, ARJ, or ARC, depending on how they were created.    
Archives make it easy to group files and make transporting and copying these files faster.
Typical Uses for Archives:

· Most files available on the Internet and on electronic services like America Online and 
CompuServe are distributed as archives.    Two benefits of using archives for electronic file 
distribution are that only one file transfer operation ("download") is required to obtain all related 
files, and file transfer time is minimized because the files in an archive are compressed.

· It is often useful to send a group of related files to an associate.    Rather than distributing 
individual files it is often easier to distribute the files as an archive to benefit from the file grouping
and compression.

· Some files are important but not used often.    To save disk space simply compress these files into
an archive when they are not used, and decompress them only when needed.

What is a Self-Extracting Zip File?
A self-extracting Zip file is an executable program file (.EXE file) that includes both a Zip file and software 
to extract or “unzip” the contents of the Zip file.    Users can extract the contents of a self-extracting Zip file
by simply running it.    This is convenient, because the end user does not need an unzip program (like 
WinZip®) to extract files from these self-extracting archives.
WinZip Self-Extractor Personal Edition, included with WinZip, creates Windows self-extracting Zip files.
Archive formats:

· Zip files are the most common archive format.    Zip files can span multiple disks, and provide 
both compression and file grouping.    WinZip does not use external programs to work with Zip 
files.

· TAR, Z, GZ, TAZ, and TGZ files are often found on Unix-based Internet sites.    TAR stands for 
“Tape ARchive”.    The TAR format does not provide compression; it is used only to group files. GZ
and Z files are gzip files.    GZ and Z files cannot contain multiple files.    TAZ and TGZ files are 
TAR files compressed in the gzip format.      Since almost all new archives are created in Zip 
format, WinZip does not provide facilities to add to or create files in these formats (however, all 
other WinZip functions are supported).    WinZip does not use external programs when working 
with files in these formats.

· File formats such as UUencoded, XXencoded, BinHex, and MIME are used primarily to transfer 
binary files by Internet e-mail.    If you encounter one of these files, you can open it and extract its 
contents with WinZip.    You can UUencode an archive using the UUencode entry in the WinZip 
Actions pull-down menu. WinZip does not use external programs when working with files in 
these formats.

· WinZip also handles most files in the old Microsoft Compress format (also known as LZEXPAND 
format). However, there are several variations on this format, and Microsoft has not released 
documentation on these variations. WinZip issues an appropriate message if you attempt to 
decompress a file not supported by your version of Windows.    Microsoft Compress files usually 
end with a trailing underscore, for example, “commdlg.dl_”.    Like Z and GZ files, Microsoft 
Compress format files contain only one file.    This format is used for many files on the Windows 
3.1 distribution disks and many older Microsoft products.    Note that not all files ending with an 
underscore are Microsoft Compress format files. WinZip does not use external programs when 
working with files in these formats.

· The Microsoft CAB (short for Cabinet) format is used by most Microsoft setup programs, including
those used to install Windows.    CAB files provide both file compression and file grouping.    You 



can use WinZip to open and extract the contents of CAB files.    WinZip will handle most self-
extracting CAB files. WinZip does not use external programs when working with CAB files.

· ARC, ARJ, and LZH are older formats that provide both grouping and compression, like Zip files.   
Unlike other supported file formats, WinZip's optional support for these formats requires external 
programs that are not included as part of the WinZip distribution package (see the section titled 
System Requirements for details).



Brief Tutorial
This help file includes a brief tutorial that introduces you to each of the main WinZip® concepts and 
features to get you working productively as quickly as possible.
You have probably reached this topic by using the browse buttons (the arrow buttons in the toolbar); the 
Brief Tutorial has been placed in its own section, which can be reached by clicking on the link at the 
bottom of this page.
You may bypass the tutorial by clicking on the forward browse arrow [ >> ]
Click on Brief Tutorial to exit this section and start the tutorial.



Brief Tutorial - Contents
Click on each tutorial topic, in sequence, to learn all about WinZip:

 1. Introducing WinZip  2. The WinZip Window  3. Opening Archives
 4. Viewing Files  5. Extracting Files  6. Creating New 

Archives
 7. Adding Files  8. Deleting    Files  9. Custom 

Configurations
 10. Additional Features

This brief overview tutorial introduces you to each of the main WinZip® concepts and features to 
get you working productively as quickly as possible. 
Note: if you prefer a strict “learning by doing” approach, you may prefer the WinZip Tutor, which uses a 
“step by step” approach to introduce new users to zipping and unzipping.
You will get the most benefit from these lessons if you change the size of this Help window to leave 
enough room on the screen to have WinZip opened at the same time. As each screen describes an 
operation, you may want to try certain things with WinZip to gain an even better understanding. You can 
move through the tutorial as quickly or as slowly as you like. If you ever have any questions when you are
using WinZip, remember that context-sensitive help is available by pressing the F1 key.
As you explore this tutorial, you will find highlighted text that will take you to additional information about a
particular topic. If you elect to take the detour, you can click on the Back button at the top of this window 
to return to where you left off in the Brief Tutorial.
Important: WinZip offers many convenient ways to work with archives.    This tutorial approaches the 
topic using the main WinZip window as its base of operations.    This is not the only way to access 
WinZip's convenient features.    For example, you can use WinZip to zip and unzip files without leaving 
My Computer or Windows Explorer.    Once you are comfortable with the basic operations described in 
this tutorial, be sure to read Using the Explorer Interface, Using Drag and Drop and Hints and Tips.
Next>



Brief Tutorial - Introducing WinZip
Click on each tutorial topic, in sequence, to learn all about WinZip:

 1. Introducing WinZip  2. The WinZip Window  3. Opening Archives
 4. Viewing Files  5. Extracting Files  6. Creating New 

Archives
 7. Adding Files  8. Deleting    Files  9. Custom 

Configurations
 10. Additional Features

WinZip® is a tool to make working with Zip files and other types of archive files easier. Let's start off by 
discussing some of the words used to describe the files and the processes.
Archives are files that contain other files, and Zip files are the most common archive format.    Typically, 
the files in an archive are compressed.    WinZip uses the term “Add” to mean “compress files and add 
them to an archive”.    “Extract” means “decompress files in an archive, creating separate files on a disk”.   
Some people use the verbs “zip” or “pack” instead of Add, and “unzip” or “unpack” instead of “extract”.

See About Zip Files and Other Archives for more detailed information.
<Back    Next>



Brief Tutorial - The WinZip Window
Click on each tutorial topic, in sequence, to learn all about WinZip:

 1. Introducing WinZip  2. The WinZip Window  3. Opening Archives
 4. Viewing Files  5. Extracting Files  6. Creating New 

Archives
 7. Adding Files  8. Deleting    Files  9. Custom 

Configurations
 10. Additional Features

The WinZip® window is where you start many of your operations. You can open it through the Start menu.
The WinZip window also opens automatically if you double click on an archive in My Computer or 
Windows Explorer.
The WinZip window includes standard Windows components. Of particular interest:
The Title Bar displays not just the WinZip product title, but the name of the archive you are currently 
working with. The Toolbar provides quick ways of performing the most common tasks.    The Main 
Window Area displays information about the files in the archive, and you'll find as we get further into this 
Tutorial that many operations can be done directly with these files. Finally, the Status Line displays the 
number and sizes of currently selected files, along with other archive information.
<Back    Next>



Brief Tutorial - Opening Archives
Click on each tutorial topic, in sequence, to learn all about WinZip:

 1. Introducing WinZip  2. The WinZip Window  3. Opening Archives
 4. Viewing Files  5. Extracting Files  6. Creating New 

Archives
 7. Adding Files  8. Deleting    Files  9. Custom 

Configurations
 10. Additional Features

The first step is to open an archive.    Use the Open toolbar button or select Open Archive from the 
WinZip® File pull-down menu to activate the standard Open Archive dialog box.

Then, select the archive you want to open in the Open Archive dialog box.    This dialog box works just like
the Open dialog boxes in other applications: just select the file you want to open from the list of files.    (If 
you want to create an archive instead of working with an existing archive, see the section Brief Tutorial - 
Creating New Archives).

Once an existing archive is open you can extract or work with the files in the archive.    The files in an 
archive are listed in a list box in the main WinZip window.

· You can look at all the file names, with details, stored in the archive, using the scroll bar, arrow 
keys or usual Windows commands.

· You can quickly sort the main window by clicking once on the header (e.g. click on “Name” in the 
header above the list of files to sort the list by filename).

<Back    Next>



Brief Tutorial - Viewing Files
Click on each tutorial topic, in sequence, to learn all about WinZip:

 1. Introducing WinZip  2. The WinZip Window  3. Opening Archives
 4. Viewing Files  5. Extracting Files  6. Creating New 

Archives
 7. Adding Files  8. Deleting    Files  9. Custom 

Configurations
 10. Additional Features

You can easily view any of the files stored in an archive by double clicking on the file in the main WinZip® 
window.    WinZip will open the file with the associated application. For example, a Word (.doc) file may be
displayed in Word, and a text (.txt) file in Notepad. When you double click on a program file (.exe), it is 
run.
Or, you can view a file with the built-in viewer or a viewer of your choice by selecting View from the 
Actions pull-down menu.
<Back    Next>



Brief Tutorial - Extracting Files
Click on each tutorial topic, in sequence, to learn all about WinZip:

 1. Introducing WinZip  2. The WinZip Window  3. Opening Archives
 4. Viewing Files  5. Extracting Files  6. Creating New 

Archives
 7. Adding Files  8. Deleting    Files  9. Custom 

Configurations
 10. Additional Features

When you extract a file, WinZip® decompresses it and places it in the folder of your choice.    You can 
restore whole folders and retain the structure of any sub-folders.
If you select Extract from the Actions pull-down menu or click the Extract toolbar button, WinZip lets you
choose the folder where you'd like to place the extracted files.    For more details on that dialog box and its
options, press F1 later, when you encounter it, or click on Extracting Files from an Archive now.
Note: if a Zip file contains a “setup” or “install” program, you can use the Install Feature to automatically 
extract the files, run the installation program, and clean up temporary files.
<Back    Next>



Brief Tutorial - Creating New Archives
Click on each tutorial topic, in sequence, to learn all about WinZip:

 1. Introducing WinZip  2. The WinZip Window  3. Opening Archives
 4. Viewing Files  5. Extracting Files  6. Creating New 

Archives
 7. Adding Files  8. Deleting    Files  9. Custom 

Configurations
 10. Additional Features

You can create a new archive by selecting New Archive from the WinZip® File pull-down menu or by 
clicking the New toolbar button.    This activates the New Archive dialog box.
First, you type the name of the archive you want to create, not the names of the files you want to 
compress.    This dialog box works similarly to standard Windows file dialog boxes, so you can choose the
drive and folder where the archive will be created.    The names of any existing archives on the selected 
drive and folder are listed to help you choose a name that is not already in use.
Normally after creating an archive you will want to add files to the archive, so verify that the Add dialog 
check box is checked to automatically activate the Add dialog box.

<Back    Next>



Brief Tutorial - Adding Files to an Archive
Click on each tutorial topic, in sequence, to learn all about WinZip:

 1. Introducing WinZip  2. The WinZip Window  3. Opening Archives
 4. Viewing Files  5. Extracting Files  6. Creating New 

Archives
 7. Adding Files  8. Deleting    Files  9. Custom 

Configurations
 10. Additional Features

You can add files to an existing archive you've opened or to a new archive you've created, as in the 
previous section.    If the Add dialog box is not displayed, select Add from the Actions pull-down menu or 
click the Add toolbar button.
In the Add dialog box, select the files you want to add to the archive.    The easiest way to do this is 
usually to click on the desired files in the list near the top of the Add dialog box. You can select multiple 
files using normal Windows file selection conventions (for example, hold down the shift key while clicking 
to select multiple files).    For details on alternate ways to specify which files you want to add, see the topic
titled Adding Files to an Archive.
Once you are done making your file selection, click the Add button to add the files.    Once WinZip® 
finishes, it will update the file list in the main window to reflect the new files in the archive.
You can also add files to an archive by dragging the files from My Computer or Windows Explorer and 
dropping them on the WinZip window using the drag and drop interface.

Note:    When you add files to an archive, the original files on disk are not deleted.    If you want to delete 
the original files automatically after the Add operation completes, select Move (and replace) files from 
the Action combo box.
<Back    Next>



Brief Tutorial - Deleting Archives and Files
Click on each tutorial topic, in sequence, to learn all about WinZip:

 1. Introducing WinZip  2. The WinZip Window  3. Opening Archives
 4. Viewing Files  5. Extracting Files  6. Creating New 

Archives
 7. Adding Files  8. Deleting    Files  9. Custom 

Configurations
 10. Additional Features

WinZip® can remove selected files from within an existing archive, or delete the entire archive.      Delete 
from the Actions menu activates the Delete dialog box.    There are two ways to start the action to delete 
files from an archive:

· Select entries from the list box in an open archive, then select the Delete entry from the Actions 
pull-down menu or press the Del key.

· Select the Delete entry from the Actions pull-down menu to bring up the Delete dialog box.    You
can then specify the file names you want to delete (standard Windows wildcards are accepted, so
you could use “*.doc” to delete all .doc files).

Note: these operations cannot be undone.
To delete an entire archive, select the Delete entry from the Actions pull-down menu to bring up the 
Delete dialog box.    Then click the Entire archive option button and the Delete push button.    
Alternatively, you can select Delete Archive from the File menu.
<Back    Next>



Brief Tutorial - Custom Configurations
Click on each tutorial topic, in sequence, to learn all about WinZip:

 1. Introducing WinZip  2. The WinZip Window  3. Opening Archives
 4. Viewing Files  5. Extracting Files  6. Creating New 

Archives
 7. Adding Files  8. Deleting    Files  9. Custom 

Configurations
 10. Additional Features

Many WinZip® operations can be tailored using configuration options.    For example, you can change the
default folders for the Extract and Add dialog boxes.    Most options are intended for advanced users.    For
an overview of available options see the section titled Options.
<Back    Next>



Brief Tutorial - Additional Features
Click on each tutorial topic, in sequence, to learn all about WinZip:

 1. Introducing WinZip  2. The WinZip Window  3. Opening Archives
 4. Viewing Files  5. Extracting Files  6. Creating New 

Archives
 7. Adding Files  8. Deleting    Files  9. Custom 

Configurations
 10. Additional Features

This is the end of the Brief Tutorial. As you get to know WinZip® better, be sure to explore the following 
more advanced features:

· WinZip's Drag and Drop operations simplify archiving.
· Internet, America Online, CompuServe, and other online services users: see the section titled 

Downloading and Processing Files with WinZip
· The Install and Checkout features make it easy to try software distributed in archives.
· WinZip can be integrated with Windows Explorer.    See the section titled Explorer Interface for 

details.
Reminder: press the F1 key at any time while working with WinZip for context-sensitive help.
You may want to review the tutorial and explore some of the many links it contains by pressing the 
buttons above.
<Back



 WinZip stores compressed files in archives.    You can think of an archive as being like a folder or 
directory, though an archive is really a special kind of file.    WinZip recognizes a file as an archive when it 
has a .zip or other special extension.



 When you compress a file you make it much smaller.    Other words for compress are zip and pack.



 When you add a file to an archive, WinZip automatically compresses it.



Switch Interface Dialog
The Switch Interface dialog box is displayed when you start WinZip® with the Wizard interface and close 
it while using the Classic interface, or vice versa.    This dialog box gives you a chance to control whether 
WinZip will start in Wizard or Classic mode next time you run WinZip.
Using the Switch Interface dialog

· If you want WinZip to start next time with the Wizard interface, click Next time start WinZip with 
the Wizard interface.

· If you want WinZip to start next time with the Classic interface, click Next time start WinZip with 
the Classic interface.

· Click Return to WinZip to close the dialog and return to WinZip.
Suppressing the Switch Interface dialog
If you want WinZip to always close without displaying the Switch Interface dialog, even if you have 
changed interfaces, check the checkbox labeled Do not display this dialog again.    If the dialog is 
suppressed, WinZip will always start with the original interface--the one you started with this time--unless 
you change the startup interface as described below.
If you change your mind and want the Switch Interface dialog back, you can restore it from either Classic 
mode or the Wizard:

· In the Wizard, click Options in the Welcome panel, click the Misc tab, and check Show "Switch 
Interface" dialog box.

· In Classic mode, choose Configuration from the Options menu, click the Miscellaneous tab, 
and check Bring back all caution messages, and click OK.    Note that this will restore all 
caution messages, not just the Switch Interface dialog.

Changing the startup interface
You can always change the startup interface, regardless of whether or not the Switch Interface dialog is 
enabled.    To do this:

· In the Wizard, click Options in the Welcome panel, choose the Misc tab, and click either Next 
time start WinZip with the Wizard interface or Next time start WinZip with the Classic 
interface.

· In Classic mode, choose Configuration from the Options menu, click the Miscellaneous tab, 
and check or uncheck Next time start with the Wizard interface.    If the box is checked, WinZip 
will start next time with the Wizard interface; if it is not checked, it will start next time with the 
Classic interface.



WinZip Search
WinZip can help you find Zip files if you don't know exactly where they are.    Select Search hard disk(s) 
on this PC to search all your hard drives on your PC (network disks and CD-ROM disks are not 
searched).    Select Search Favorite Zip Folders to search for Zip files in your Favorite Zip Folders.    
Select Search disk to search a specified disk (for example, a floppy disk or CD-ROM).    Select Let me 
find it if you want to look for the file yourself.



File Type Filters
The File/New Archive, File/Open Archive dialog boxes use the file type filters in the following table.    The 
File/Favorite Zip Folders dialog box uses the first three entries in this table.

Zip files *.zip
All archives *.zip; *.z; *.gz; *.tz; *.taz; *.tgz; *.lzh; *.arj; *.arc; 

*.tar; .cab; *.wmz; *.yfs; *.wsz
Encoded files *.uu; *.uue; *.xxe;*.bhx; *.b64; *.hqx; *.mim
Archives and .exe files *.zip; *.z; *.gz; *.tz; *.taz; *.tgz; *.lzh; *.arj; *.arc; *.tar; 

*.cab; *.wmz; *.yfs; *.wsz; *.exe
Archives, encoded, and .exe files *.zip; *.z; *.gz; *.tz; *.taz; *.tgz; *.lzh; *.arj; *.arc; *.tar; 

*.cab; *.wmz; *.yfs; *.wsz; *.exe; *.uu*; *.xxe; *.bhx; *.b64;
*.hqx; *.mim

All files (*.*) *.*

UUencoded, XXencoded, BinHex, and MIME files
This help file includes a section outlining how WinZip® can open and extract UUencoded, XXencoded, 
BinHex, and MIME files (base64, plain/text, and quoted-printable), and can UUencode files. It also 
explains the need for these features and abilities, and includes instructions for using them.
You have reached this topic by using the browse buttons (the arrow buttons in the toolbar); the 
UUencoded, XXencoded, BinHex, and MIME files topic has been placed in its own section, which can be 
reached by clicking on the text at the bottom of this page.
You may bypass this section by clicking on the forward browse arrow [ > > ]
Click on UUencoded, XXencoded, BinHex, and MIME files to exit this section and learn more about these 
files and how WinZip can serve your needs.



UUencoded, XXencoded, BinHex, and MIME files
WinZip® can open and extract UUencoded, XXencoded, BinHex, and MIME files (base64, plain/text, and 
quoted-printable), and can UUencode files. This section explains the need for these features and abilities,
includes instructions for using them, and shows how they can bring a whole new dimension to your e-mail
operations.

Use the browse buttons  above or the index below to page through this tutorial, and learn 
about using these important and useful WinZip features.
These instructions assume that you understand basic Windows and WinZip operations, and the basic use
of your e-mail program.

UUencoded, XXencoded, BinHex, and MIME files
Sending Files using Internet Mail

The Why behind UUencoding and Other Schemes
Receiving and Preparing Files for Decoding

Decoding Files using WinZip
UUencoding a File using WinZip

Mailing a UUencoded File
Hints, Tips, & Troubleshooting



Sending Files using Internet Mail
If you have a direct connection to the Internet, you may already be using an e-mail program that allows 
you to attach files to messages. However, many e-mail programs, including MSMail and some versions of
CompuServe Information Manager (WinCIM), cannot easily transfer files to Internet addresses. In the 
case of CompuServe, users with older accounts who have not converted to “new mail” cannot easily send
files beyond the bounds of their own service, to Internet subscribers and others. WinZip® allows you to 
send and receive files using nearly any e-mail program, including these two.
Note: If your e-mail program does have the ability to transfer files, consider using WinZip to compress 
them before transfer -- it will usually take far less time since the file will be smaller. If the recipients are 
unfamiliar with Zip files, you can use WinZip to create a self-extracting archive for their convenience.

UUencoded, XXencoded, BinHex, and MIME files
Sending Files using Internet Mail

The Why behind UUencoding and Other Schemes
Receiving and Preparing Files for Decoding

Decoding Files using WinZip
UUencoding a File using WinZip

Mailing a UUencoded File
Hints, Tips, & Troubleshooting



The Why behind UUencoding and Other Schemes
The Internet was not designed to carry binary (program and other non-text files) files. It is able only to 
transfer messages made up of conventional text (printable ASCII) characters. In order to get around that 
limitation, UUencode and other methods were created.
These solutions all perform the same basic operation: they encode the non-transferable binary file into 
ASCII characters that the e-mail system can handle. The person receiving the message can then decode 
the strings of characters to recreate the original file. Perhaps you have seen one of these completely 
unintelligible messages; here's an example:

_=_
_=_ Part 001 of 001 of file encoded.txt
_=_

begin 666 encoded.txt
:;F<@=7-I;F<@5VEN6FEP+@T*#0I%;FIO>2$`
`
end

WinZip® can easily open and extract UUencoded, XXencoded, BinHex, and MIME files (base64, 
plain/text, and quoted-printable) that have been sent to you, and create Uuencoded files for you to send.

UUencoded, XXencoded, BinHex, and MIME files
Sending Files using Internet Mail

The Why behind UUencoding and Other Schemes
Receiving and Preparing Files for Decoding
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Receiving and Preparing Files for Decoding
The message you receive with an encoded file will need to be prepared for the simple WinZip® decoding 
operation. The steps you take will depend on the e-mail program you are using.
If you are using CompuServe Information Manager (WinCIM),

1. Double click on the message to open it,
2. Select Save As from the File menu item,
3. Enter a file name using .UUE as the extension; for example: FILENAME.UUE.

If you are using MSMail,
1. Highlight the message (DO NOT open it; large messages are not handled well by MSMail)
2. Select Save As from the File menu item,
3. Enter a file name using .UUE as the extension; for example: FILENAME.UUE.

If you are using another e-mail program, one of the two methods described above may also work with 
your program. Be aware that some e-mail programs may crash or cut off parts of unusually large 
messages, so saving them as a file without opening them is the preferred method.
Your e-mail program may save a message attachment as an external file in a folder designated to receive
them. In that case, it may automatically be named; you may wish to rename it, using a .UUE extension, 
for maximum convenience.
Sometimes you may receive multiple messages, where a file is split up into more than one message 
because of size limitations. You will need to use a text editor or the DOS COPY file command to paste the
files together into one large file, and save it as a text file with a .UUE extension.
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Decoding Files using WinZip
You do not need to worry if the file being received is UUencoded, XXencoded, BinHex, or a MIME file 
(base64, plain/text, and quoted-printable). WinZip® will detect the method being used and automatically 
decode it.
As is the case with Zip files, WinZip offers more than one way to open encoded files.    For example:

· Double click the encoded file in My Computer or Windows Explorer.    WinZip will open and 
decode the file. If it is a Zip file, it will offer to open it; if it has not been compressed, it will be 
shown in the usual manner.

· Drag and drop the encoded file onto the WinZip icon.
· Use WinZip in the regular manner to Extract the file to your folder of choice.

Note: You can also open a file using WinZip's Open toolbar button, or drag and drop a file into WinZip, 
regardless of the file's extension.
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UUencoding a File using WinZip
WinZip® UUencodes Zip files for mailing, so you must choose and open an existing Zip file to encode or 
create a new one.

· If the file is already archived as a Zip file, open it in WinZip using your favorite method.
· If the file(s) you wish to send are not already archived, use WinZip to create a Zip file, and leave 

the program open for the next step.
· Click on the Actions menu item, and choose UUencode.

A UUencoded file has been created from your Zip file. For example, you will find a TESTFILE.UUE file in 
the same folder along with your original TESTFILE.ZIP.
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Mailing a UUencoded File
Note: most modern e-mail programs automatically encode attachments when necessary, so you will not 
need to.    If, however, you are using an older e-mail program that does not automatically encode 
attachments, the following information could be useful.    Please read about UUencoding if you are not 
familiar with encoded files and why they are used.
To send a UUencoded attachment, first UUencode the attachment using WinZip, then attach it to your 
message.    How you attach a UUencoded file to a message will depend on your e-mail program.
If you are using CompuServe Information Manager (WinCIM) with “old mail” (i.e., you have an older 
account and have not converted to “new mail"),

1. Create a message in the usual manner.
Note: If you are sending a file to another CompuServe address, it is unnecessary to UUencode it, 
but zipping it using WinZip® will shorten transmission times.

2. Click on the Attach button to open WinCIM's File Attachment window.
3. If you are using WinCIM 2.0, click on File (when using version 3.0, this step is not necessary).
4. Use the standard file dialogs to choose the .UUE file you created previously.
5. If you are using CompuServe Information Manager 3.0, highlight the attached file in the Attach 

Files dialog box, select “Text” in the File Type combo box, then click OK (when using version 2.0, 
this step is not necessary).

6. E-mail your message as you would normally.
If you are using MSMail,

1. Create a message in the usual manner.
2. Click on the menu item Attach, and select File.
3. Use the familiar file dialogs to choose the .UUE file you created previously, then click OK.
4. E-mail your message as you would normally.

If you are using another e-mail program, one of the two methods described above may also work with 
your program. A “Send File” or similar option may be available and of use in this situation. It may be 
necessary to open the .UUE file you have created using a text editor, copy the entire contents, or portions
of it, to the Windows clipboard, and paste it into your open e-mail message. Further information on 
handling large files is included in the next topic, Hints, Tips, & Troubleshooting.
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Hints, Tips, & Troubleshooting
WinZip® makes decoding these file attachments very convenient. Here are some hints to make the road 
even smoother:
The most common problems we encounter with files that cannot be decoded are incomplete data and 
missing header information. The integrity of the message is critical, and the header must be intact for 
decoding. We have included short examples of each of the following encoding formats. You may find 
them helpful for comparison purposes with messages you receive, to confirm that they appear properly 
encoded and are not missing header and closing data. Click to review any of these brief file examples.

UUencoded Example          XXencoded Example          BinHex Example          MIME (base64)
Example

Multi-Part Encoded Files must be combined before WinZip can process them.    If you encounter 
encoded data spread across multiple files, you can either combine the parts using a text editor, and then 
open them with WinZip, or you can use another program, like the UUDeview package from Frank Pilhofer.
(WinZip's decoding subroutines are based on the UUDeview package.)    The original UUDeview is a text 
mode command line driven program, or you can download a Windows interface by Michael Newcomb.    
These free programs are available from Internet sites in Germany and the USA.
Further information about encoding files can be found in many places on the Internet.    A good place to 
start is the “Introduction to Decoding” article from the UUDeview home page.      The MIME specification is
defined in RFC 1521, and is widely available on the Internet.
Bug Reporting: If, after examining and confirming that a file seems properly encoded, you believe that 
WinZip should handle it, please contact WinZip support.    Send e-mail to support@winzip.com with 
details, and include a Zip file of the file so that it is not changed by any mail gateways or e-mail program. 
Do not remove any header or other information. Please include the name of the program that created it, if 
possible. Smaller files are preferred over huge sample files.    We will examine the file and respond as 
soon as possible.
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UUencoded Example
Here is an example of a UUencoded file:

begin 666 encoded.txt
:;F<@=7-I;F<@5VEN6FEP+@T*#0I%;FIO>2$`
`
end

Return to Hints, Tips, & Troubleshooting



XXencoded Example
Here is an example of a XXencoded file:

begin 666 encoded.txt
hJ4JnR02B0Uo8FqJiR4lZ637ZMKFZQXcB0Uo8J4VdQm-dQm-iPrFcOKtb64pj
hQaIUR4VVPW-V65FZQrEUNaZgNG-XQaJVR4JY65Fj65-mPrNdN4IUNaxYN4Jm
h64NjQW-oO4IURa3mOKxpQm-ZPaBjN4ZiNm-nMqVZPKJn9W-7NW-tPrIUML7Z
h65JnOKtb64Zo65Fj65FZQrEg64BjPaRmMLFpP43oOKxiQm-jPW-tPrJm643b
hOKldR5YUOKsUMrJoR4ZiNmkUQ43nR4ZiNmkUQq3qOKtb90-VPaEUN4JXPqFd
OPaQURLBdPaQUJqZiKaZk9Uo81Ed3PadjSG2+
+
end

Return to Hints, Tips, & Troubleshooting



BinHex Example
Here is an example of a BinHex file:

VGVzdCENCg0KR2VudGxlIFJlYWRlcjoNCg0KVGhpcyBpcyBub3RoaW5nIG1vcmUgdGhhbiBhIHRl
c3QgZmlsZSBjcmVhdGVkIHRvIHByb3ZpZGUgZm9kZGVyIGZvciB0aGUgdmFyaW91cyBlbmNvZGlu
ZyBzY2hlbWVzLiBJZiB5b3UgYXJlIHVzaW5nIGl0IHRvIHRlc3QsIGNvbmdyYXR1bGF0aW9ucyBv
biB5b3VyIGFnaWxpdHkgaW4gY3V0dGluZywgcGFzdGluZywgc2F2aW5nLCBhbmQgZGVjb2Rpbmcg
dXNpbmcgV2luWmlwLg0KDQpFbmpveSE=

Return to Hints, Tips, & Troubleshooting



MIME (base64) Example
Here is an example of a MIME file:

---
Content-Type: application/octet-stream; name="encoded.txt"
Content-Transfer-Encoding: base64
Content-Disposition: inline; filename="encoded.txt"
Content-MD5: V8ttTjZgvmMkzwVFKr5Olw==

VGVzdCENCg0KR2VudGxlIFJlYWRlcjoNCg0KVGhpcyBpcyBub3RoaW5nIG1vcmUgdGhhbiBh
IHRlc3QgZmlsZSBjcmVhdGVkIHRvIHByb3ZpZGUgZm9kZGVyIGZvciB0aGUgdmFyaW91cyBl
bmNvZGluZyBzY2hlbWVzLiBJZiB5b3UgYXJlIHVzaW5nIGl0IHRvIHRlc3QsIGNvbmdyYXR1
bGF0aW9ucyBvbiB5b3VyIGFnaWxpdHkgaW4gY3V0dGluZywgcGFzdGluZywgc2F2aW5nLCBh
bmQgZGVjb2RpbmcgdXNpbmcgV2luWmlwLg0KDQpFbmpveSE=

-----

Return to Hints, Tips, & Troubleshooting



System Requirements
WinZip® requires Windows 95, Windows 98, Windows Me, Windows XP, Windows NT 4.0, or Windows 
2000.    It will not run under Windows 3.x or Windows NT 3.1 or 3.5. 
No other programs are required to add or extract files from Zip files.    However, some optional 
WinZip operations do require external programs or files:

· Optional virus scanning support requires that a supported virus scanning program be installed on 
your system.    See below for specific information and how to find a list of virus scanners 
automatically detected by WinZip.

· Optional support for some older formats (ARC, ARJ, and LHA) requires one of the supported 
programs listed below.    For step by step instructions on installing these programs see the section
titled Installing Optional External Programs.

Here are more details on some of the optional programs:
· You can create self-extracting Zip files with WinZip Self-Extractor Personal Edition, included with 

WinZip, or you can use the full WinZip Self-Extractor, a $49 companion product, which includes 
features tailored for software distribution, and the ability to create a single self-extracting Zip file 
that can be run under Windows.

· To access LZH files, the LHA.EXE program from Haruyasu Yoshizaki is required.    You can 
download LHA.EXE from most bulletin boards.    The latest version is distributed in the self-
extracting LZH file LHA213.EXE.    WinZip has been tested with LHA 2.13 and will not work with 
earlier versions (in particular, it will not function with LHARC, the predecessor to LHA).

· To access ARJ files, the ARJ program from Robert Jung is required.    You can download the 
Shareware version of ARJ from most bulletin boards.    The latest version as of this writing is 
distributed in the self-extracting ARJ file ARJ275A.EXE.    WinZip has been tested with ARJ 2.50, 
2.60, 2.70, 2.71, 2.75, and 2.75a and will not work with earlier versions.

· To access ARC files, one of the following programs is required:
ARCE.COM and ARC-E.COM version 4.0e - Vern Buerg's ARC extraction utility, available on 
CompuServe and other bulletin boards.    WinZip was not tested with earlier versions.
PKXARC.COM version 3.5 from PKWARE, Inc.    WinZip was not tested with earlier versions.    
This program is still available on some bulletin boards.
PKXARC.EXE version 3.6 from PKWARE, Inc.    This program is still available on some bulletin 
boards.
PKUNPAK.EXE version 3.61 from PKWARE, Inc.    This program is still available on some bulletin
boards.
ARC.EXE version 5.20 or 6.0 from System Enhancement Associates, Inc.    This is the last 
version of ARC available as Shareware, and is still available on some bulletin boards.    WinZip 
was not tested with earlier versions.    SEA's address is 925 Clifton Ave., Clifton, NJ 07013.

WinZip will automatically detect several popular virus scanners; for a current listing, visit the WinZip web 
site at http://www.winzip.com/xvirus.htm.
WinZip can also be configured to work with most virus scanning utilities.    For important details, see the 
section titled Virus Scanner Configuration.
Some toolbar configuration options require version 4.71 or later of the Windows Common Control library. 
This library is part of Windows 98, Windows Me, Windows 2000, Windows XP, Microsoft Internet Explorer 
4.0 or greater, and is available as a separate download from the Microsoft web site as described in the 
section Windows Common Control Library.



WinZip Installation
To install WinZip® from the distribution CD-ROM, Insert the CD-ROM into your drive.    The autorun 
capability of Windows will start the WinZip 8.1 setup program.    If it does not, select the Run… option from
the taskbar Start Menu and type:
                D:\setup.exe
replacing D: with your CD-ROM drive. Select "Install WinZip".
The Setup program will issue a number of prompts.    Unless you have a reason to override the defaults it 
is strongly recommended that you accept the installation default settings (just press OK, Yes, or Next, as 
appropriate).
If you are interested in information on installing WinZip site licenses in a networked environment, please 
see the web page http://www.winzip.com/site_install.htm.



WinZip Uninstallation
There are three ways to uninstall WinZip® should you wish to do so.
Control Panel
Activate the Control Panel, double click Add/Remove Programs, and double click the WinZip list box 
entry.
Start Menu
From the Start menu, click Programs, then WinZip, and then Uninstall WinZip.
Run Dialog:
You can also uninstall WinZip by running WINZIP32.EXE and specifying the /uninstall parameter.    To do 
this, click the Start button, choose Run, type

winzip32 /uninstall
and click OK.
Technical details:
The “Uninstall WinZip” procedure performs the following steps:

1. Verify that it is safe to uninstall.
2. Remove WinZip File Manager Extension from WINFILE.INI if it is installed.
3. Delete files in WinZip folder if they were installed by this version of WinZip and if the file's 

date/time stamp matches WINZIP32.EXE.    The WINZIP.GID, WINZIP.FTS, and WINZIP.PIF files 
are deleted regardless of their date/time stamp.

4. Remove any WinZip file associations from WIN.INI.
5. Remove [WinZip] entry from WIN.INI.
6. Remove the WinZip icons, WinZip desktop shortcut and Start menu entries, and Quick Pick.
7. Remove the WinZip entries from the registry.



Installing Optional External Programs
WinZip® includes built-in support for the Zip, CAB, Microsoft Compress, gzip, TAR, UUencode, 
XXencode, BinHex, and MIME formats, so no other programs are required for most WinZip operations.    
However, virus scanning and operations involving ARC, ARJ, and LZH files require external programs.    
These optional external programs are not distributed with WinZip.    You must tell WinZip where to find 
these programs as described in the section titled Program Locations.    The following sections provide 
step by step examples of how to install LHA and ARJ.
Remember: the use of these external programs is optional.    If you are just getting started with WinZip 
you will probably want to skip this section and work without the external programs until you encounter a 
need for them (and are more familiar with WinZip).
These instructions assume you are comfortable working with My Computer or Windows Explorer, know 
how to use standard Windows features such as dialog boxes and menus, and have a little experience 
using WinZip.    See Quick Start for introductory information and how to quickly become familiar with 
WinZip.
Note: The first step in installing an external program is to acquire the external program.    See System 
Requirements for information on obtaining these programs.

Related Topics:
Installing LHA
Installing ARJ



Installing LHA
Here are step-by-step instructions for installing LHA, an optional external program required to work with 
LZH files.

1. LHA is distributed as a self-extracting archive called LHA213.EXE.    First download LHA213.EXE 
from your favorite online service.

2. Use My Computer or Windows Explorer to create the folder C:\LHA.    You can use a different 
folder but then you will need to substitute that folder name in the following instructions.

3. Use My Computer or Windows Explorer to copy LHA213.EXE from your download folder to the 
C:\LHA folder.

4. Double click on LHA213.EXE to run it.    This will cause the files in LHA213.EXE to “self-extract” 
into the C:\LHA folder.    Then go back and delete C:\LHA\LHA213.EXE, as it is not needed for 
day-to-day work with LHA and WinZip.

5. Start WinZip.    Pull down the Options menu and select Configuration, then click the Program 
Locations tab.

6. In the LHA field of the Program Locations tab of the Configuration dialog box, type

c:\lha\lha.exe

and press the OK button.
That's all there is to installing LHA.    You can now access .LZH files (created by LHA) the same way you 
access Zip files.



Installing ARJ
Here are step by step instructions for installing ARJ, an optional external program required to work with 
ARJ files.

1. ARJ is distributed as a self-extracting archive named ARJn.EXE, where n is a version number.    
The earliest version of ARJ supported by WinZip® is ARJ 2.50 (ARJ250.EXE); the current version
as of this writing is ARJ 2.75a (ARJ275A.EXE).    First download the file from your favorite online 
service.

2. Use My Computer or Windows Explorer to create the folder C:\ARJ.    You can use a different 
folder but then you will need to substitute that folder name in the following instructions.

3. Use My Computer or Windows Explorer to copy the ARJ installation executable from your 
download folder to the C:\ARJ folder.

4. Double click on the file to run it.    This will cause the files to “self-extract” into the C:\ARJ folder.    
You can then delete the installation executable if you wish, as it is not needed for day-to-day work
with ARJ and WinZip.

5. Start WinZip.    Open the Options menu and click Configuration, then click the Program 
Locations tab.

6. In the ARJ field of the Program Locations tab of the Configuration dialog box, type

c:\arj\arj.exe

and click the OK button.
You can now access ARJ files the same way you access Zip files.
Note: like WinZip, ARJ is not free software.    As with all shareware, if you use these programs you should 
register them with the appropriate vendor.    See the license.doc file in your ARJ folder for details.
Note: ARJ 2.60 and later versions provide long filename support under Windows 95, Windows 98, and 
Windows Me.    ARJ does not currently support long filenames under Windows NT 4.0, Windows 2000, or 
Windows XP.
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Using WinZip: Introduction
If you've used WinZip® for a while, or if you've looked at any of the overview or Quick Start information, 
you know that there are three basic ways to use WinZip.

· You can use the WinZip Wizard.    This is ideal if you just want to do quick zipping and unzipping 
and you don't want to worry about the details of archives.    (The WinZip Wizard is documented 
separately.)

· You can use WinZip in Classic mode, that is, you can open WinZip and use its menus and 
toolbars to perform all of your archive operations.    This mode gives you complete access to all 
WinZip functionality.

· You can use WinZip's Windows integration features, which include drag and drop features and 
WinZip's Windows Explorer interface.    These features allow you to perform most of the 
commonly needed archive operations right from your desktop, Windows Explorer, or My 
Computer; in most cases, you don't need to open WinZip at all.

Which technique you use depends on your preferences and your archiving needs.    You may use more 
than one.    A little experimentation should find what's right for you.
This section of the WinZip documentation describes the entire WinZip menu system and WinZip's 
Windows integration features.
Section contents
WinZip Menus
Using the Explorer Interface
Using Drag and Drop
WinZip Self Extractor Personal Edition



Menu Tree
File Menu Working with whole archives
New Archive Open a new archive
Open Archive Open an existing archive
Favorite Zip Folders Open the Favorite Zip Folders dialog
Close Archive Close the open archive
Properties Display the open archive's properties
Create Shortcut Add a shortcut to the open archive to the desktop
Move Archive Move the open archive to a different drive or folder
Copy Archive Copy the open archive to a different drive or folder
Rename Archive Change the file name of the open archive
Delete Archive Delete the open archive
Print Print a listing of the open archive's contents
Wizard Switch to the Wizard interface
Mail Archive E-mail the open archive
Exit Close WinZip

Actions Menu Performing tasks with the open archive
Add Add files to the open archive
Delete Delete files from the open archive
Extract Extract files from the open archive
View View files in the open archive
Select All Select all files in the open archive
Invert Selection Reverse selected and unselected file status in the open archive
Virus Scan Run a virus scan program against archive contents
Make .Exe File Create a self-extracting archive
UUencode UUencode the open archive
Split Split a Zip file into multiple parts of a specified size
Test Test integrity of the open archive
Comment View, add, edit, or delete a Zip comment
CheckOut Examine and/or run programs in the open archive
Install Install the software contained in the open archive

Options Menu Configuring WinZip
Configuration Change WinZip settings
Password Set password for subsequent archive operations
Sort Specify sort order for list of files in archive
Reuse WinZip Windows Don't open new windows when WinZip is started
Save Settings on Exit Control whether options are saved when WinZip is closed
Save Settings Now Save configuration settings immediately
Set Installation Defaults Set many options to original installation defaults
View Last Output View output from the last command issued by WinZip

Help Menu Getting help and information
Help Contents and Index Start Help and display the WinZip help file contents and index



Brief Tutorial Display brief WinZip tutorial
How to Use Help Display instructions for using help system 
Frequently Asked Questions Open this Help File to that topic
Hints and Tips Display hints and tips
Tip of the Day Open the Tip of the Day window
Enter Registration Code Access the dialog for entering registration information
License Agreement Display license agreement
Ordering Information Display order form
WinZip Home Page Start your default browser and visit the WinZip web site
About WinZip Display copyright notice and version information

The File Menu
Use the File menu for actions that affect entire archives or WinZip® itself.    The menu contains the 
following entries:

· New Archive creates new archives.
· Open Archive opens existing archives.
· Favorite Zip Folders displays a list of Zip files in your favorite Zip folders.
· Close Archive closes the currently open archive.    This menu entry is included primarily for 

completeness, since the New and Open menu entries automatically close the open archive, as 
does closing WinZip.

· Properties displays a dialog box showing the properties of the currently open archive.
· Create Shortcut creates a shortcut to the open archive on your desktop.
· Move Archive, Copy Archive, Rename Archive, and Delete Archive facilitate Archive 

Management.
· Print prints a listing of the files in the archive.
· Wizard activates the WinZip® Wizard.
· Mail Archive, available only if your system is configured to use MAPI (the standard Mail 

Application Program Interface), makes it easy to mail an archive.
· Exit closes WinZip.
· Recently opened archives can be re-opened directly from the File menu.

Note that the File menu does not contain the common Save or Save As menu entries.    Save is not 
necessary because WinZip automatically saves changes to your archives as you make them.    Copy 
performs a similar action to Save As: it creates a copy of your archive using a name that you specify. 
However, the original archive will remain open.



Creating a New Archive
To create a new archive, click New Archive from the WinZip® File pull-down menu.    This activates the 
New Archive dialog box.    Type the name of the archive you want to create.    Do not enter the names of 
the files you want to compress.    This dialog box works almost like the standard Windows Open dialog 
box.    You can use the Save in combo box to choose the drive and folder where the archive will be 
created.    For example, to create an archive on your floppy drive, select “3 ½ Floppy” in the Save in 
combo box.    The names of any existing archives on the selected drive and folder will be listed to help you
choose a name that is not already in use.
Check the Add dialog check box in the New Archive dialog box if you would like to automatically activate 
the Add dialog box after the new archive is opened.
To list self-extracting archives in the New and Open dialog boxes, choose the “Archives and .exe files” 
entry in the Files of type combo box.    Note: When self-extracting archives are listed in the open dialog 
box, all EXE files in the selected folder will be listed, even if they are not self-extracting archives.    WinZip 
is not able to check whether a file is a self-extracting archive until it is opened.
See the section File Type Filters for details on the File Type filters in the Files of type combo box.



Opening an Existing Archive
To open an existing archive, select Open Archive from the WinZip® File pull-down menu.    This activates
the standard Open Archive dialog box.    Then select the archive you want to open in the Open dialog box. 
Opening an archive is just like opening a document in Write or a spreadsheet in Excel; the only difference
is that you open an archive instead of a document or spreadsheet.    Use the combo box at the top to 
select the appropriate folder and click on the archive in the list below.    Press the Open button when you 
have made your selection.
You can also click the Favorites button to see a list of files in your Favorite Zip Folders.    To open an 
archive from this list, just double click its name.
To list self-extracting archives in the New and Open dialog boxes, select the “Archives and .exe files” 
entry in the Files of type combo box.    Note: when self-extracting archives are listed in the open dialog 
box, all EXE files in the selected folder will be listed, even if they are not self-extracting archives.    WinZip 
is not able to check whether a file is a self-extracting archive until it is opened.
See the section File Type Filters for details on the File Type filters in the Files of type combo box.



Favorite Zip Folders
About Favorite Zip Folders:
The “Favorite Zip Folders” feature organizes Zip files into one convenient list that is sorted by date, 
making it easier to locate all Zip files, regardless of where they came from or where they are stored.    For 
example: by default, CompuServe downloads go into the c:\cserve\download folder, while AOL downloads
go into the c:\aol\download folder.    Unlike the standard Open Archive dialog box, the Favorite Zip Folders
dialog box treats the contents of multiple folders as though they were one folder.
Using the Favorite Zip Folders Dialog Box
Click the Favorites button on the toolbar or select Favorite Zip Folders from the File pull-down menu to 
activate this facility. When you open the Favorite Zip Files dialog box, all Zip files in your Favorite Zip 
Folders are listed by date, with the most recently modified files listed first.
The first time you activate the Favorite Zip Folders dialog box, it will automatically search your computer 
for folders containing or likely to contain Zip files.    You can easily add and remove folders from your list of
“Favorite Zip Folders” using the Options button.
To open a Zip file, select it and click Open, or simply double click on the Zip file.
Click Search to search for Zip files in other folders.    The results of your search will temporarily replace 
the list of files in the Favorite Zip Folders dialog box.
To add folders to your Favorite Zip Folders
To add a folder to the list of Favorite Zip Folders, click the Options button in the Favorite Zip Folders 
dialog and then click Add a folder to list.    In the resulting folder-browsing dialog, select the desired 
folder and click OK.
Here's another way to add folders to the list: click the Search button in the Favorite Zip Folders dialog 
box, select the type of search you want, and click OK.    When the search completes, the list of files in the 
Favorite Zip Folders dialog is temporarily replaced by the search results; select a Zip file and click Open, 
or double click the Zip file.    If the Zip file resides in a folder that is not currently in your Favorite Zip Folder
list, then by default, WinZip will ask if you would like to add the folder to your Favorite Zip Folders.
WinZip can be configured to handle the folder in one of three ways: it can automatically add the folder to 
your Favorite Zip Folders, it can ask if you want to add the folder to the Favorite Zip Folders (as described
above), or it can skip adding the folder to the Favorite Zip Folders. You can change this section by clicking
Options in the Favorite Zip Folders dialog and then clicking the Other Zip Folders tab.
This setting should be chosen prior to running a search and only applies when opening a Zip file from 
search results.    In particular, note that setting the option to "Add the folder to Favorite Zip Folders 
automatically" does not automatically add the folder of every Zip file you open to your Favorite Zip 
Folders.



Viewing Archive Properties
The Properties menu entry in the WinZip® File menu displays a dialog box with the path, file's name, 
actual archive size (in bytes), number of files in the archive, average compression ratio, and the date and 
time that the archive was last updated.    The Details button displays extensive internal information about 
the archive and the files contained within it.



Archive Management
The Copy Archive, Move Archive, Rename Archive, and Delete Archive entries in the File menu 
facilitate archive management.
Copy Archive copies the open archive to another folder or disk.    The Copy dialog box is displayed so 
you can choose the destination for the copy operation.
Move Archive moves the open archive to another folder or disk.    The Move dialog box is displayed so 
you can choose the destination for the move operation.
Rename Archive gives you an opportunity to change the file name of the open archive.    The Rename 
dialog box lets you change the open archive's file name but not the filename extension (file type).    Simply
type the new file name and press the OK button.
Delete Archive deletes the open archive.    A confirmation dialog is displayed to avoid accidental deletion. 
If you choose to continue the archive is closed and deleted.



Printing a List of the Files in an Archive
To print the list of files shown in the main WinZip® window, choose Print from the File pull-down menu.    
The columns shown in the WinZip window will be printed.    The standard Print dialog box lets you choose 
which printer should be used, how many copies are printed, whether to print in landscape or portrait 
mode, etc.
You can also print a listing of the files in an archive from a My Computer or Windows Explorer window.    
Simply right click the archive and choose Print from the context menu.
Hint: you can change the content of the printed file listing by changing the columns that are shown in the 
WinZip window. To do this, cancel the print request, right click any column header and choose the 
columns you want, and click Print again.
How to Print a List of the Files in an Archive to a Text File on Disk
You can also use the Print item on the File pull-down menu to save the list of files in an archive in a text 
file on disk.    However, you first may need to set up a “printer port” to do this.
To set up such a printer port, perform the following steps:

1. From the Start menu, click Settings, then Printers.
2. Double click Add Printer.    The Add Printer Wizard will start. Click Next to advance to the next 

panel.
3. Check the Local printer option button, and click Next.    Windows may display a small window 

and progress meter while it builds a printer information database. If you see such a window, wait 
until the process completes.

4. You should now see a panel with two lists: one of printer manufacturers and another of printers. 
Scroll down the list of Manufacturers until you see the item Generic, and then click this item. The 
Printers list should automatically change to have the entry “Generic/Text Only”. Click Next.

5. Windows then may need to load a driver from files already on your hard disk or from your 
Windows distribution CD-ROM or diskettes. Follow the instructions for doing so. If instead you 
see a panel that says “A driver is already installed for this printer ...”, check the Keep existing 
driver option button, and click Next.

6. In the next panel, select "File" from the Available ports window, and click Next.
7. In the next panel, you can use the Windows-generated name for the printer, or you can enter a 

more descriptive name such as “Print to Disk File” in the Printer name field, and then click Next.
8. In the next panel, check the option button labeled Yes in response to the question “Would you like

to print a test page?”, and then click Finish.
9. Windows will prepare a test page, and then display a “Print To File” dialog. You can use this 

dialog to specify the file and folder into which the print output should go.
10. After printing is complete, there should be a file containing the print output in the location you 

specified. Using a utility such as Notepad, check the output to make sure it looks all right. 
Windows will ask you if the test page printed correctly. Assuming it did so, click Yes.

From now on, when you print to your new “Print to Disk File” printer, the output will go to a plain text file 
on your disk, and you can then use a utility such as Notepad to view and edit the output.
In WinZip, to save an archive listing to a text file, select Print from WinZip's File menu. When the Print 
dialog appears, click the arrow on the Name drop-down list, select your “Print to Disk File” printer, and 
click OK.    Windows will ask for a file name for your text file and then WinZip will direct the listing to the 
text file.
Windows tip: you can use your new Print to Disk File printer to send print output to disk from almost any 
Windows application, as long as the application allows you to select a printer when you produce print 
output. Just select your “Print to Disk File” printer as the destination for the output.





Using WinZip to e-mail archives
WinZip® includes three features that make it easy to e-mail compressed files to others via the Internet:

· The Zip and E-Mail feature provides "one click" compression and mailing of files and folders from 
My Computer or Windows Explorer.    It quickly compresses selected files and folders into a 
temporary Zip file, creates an e-mail message, and attaches the Zip file to the message.    You 
can then address the message, add any desired text, and send the e-mail as you usually would.   
WinZip automatically deletes the temporary Zip file when it is no longer needed.
To use the feature, simply select the desired files or folders in My Computer or Windows Explorer,
click the right mouse button, and choose Zip and E-Mail filename.zip from the popup menu.    
The filename shows the name that WinZip will use for the Zip file it creates.

· The Zip and E-Mail Plus feature is similar to Zip and E-Mail but allows you to specify the name of 
the Zip file and add password protection if desired.    To use the feature, simply select the desired 
files or folders in My Computer or Windows Explorer, click the right mouse button, and choose 
Zip and E-Mail Plus from the popup menu.
Note that if you find that you are using either Zip and E-Mail or Zip and E-Mail Plus all the time, 
you can remove the one you don't use from the context menu using the Explorer Enhancements
tab of WinZip's Configuration dialog.

· You can e-mail the currently open archive by choosing Mail Archive from the File menu.    WinZip
will create a new e-mail message and attach the open archive to it. You can then address the 
message, add any desired text, and send the e-mail as you usually would.

Like the Windows “Send To Mail Recipient” feature, these WinZip e-mail features use a protocol called 
Simple MAPI to “talk” to your e-mail program.    MAPI, which is provided by your e-mail software and not 
by Windows itself, allows Windows and application programs to instruct your e-mail program to create 
new mail messages, add attachments, etc.    WinZip's e-mail features require that you have a MAPI-
compliant e-mail program installed and correctly configured (just as the Windows Send to Mail Recipient 
feature does).
Examples of MAPI-compliant e-mail programs are Outlook, Outlook Express, Eudora, and AOL 7.0.
AOL versions 4.0 - 6.0 do not support Simple MAPI. Therefore, neither Windows' Send To Mail Recipient 
nor WinZip's e-mail features can be used with these AOL versions.
Compressing attachments from within your e-mail program
There is another technique you can use to compress attachments while composing messages in your e-
mail program. This technique does not require that your e-mail program support the MAPI interface that 
WinZip uses for the above features; it works with most e-mail programs that use the standard Windows 
"Open File" dialog box to attach files.    Here is the technique:

1. In your e-mail program, open the dialog box you normally use to attach files to your e-mail 
messages. 

2. Using the standard Open File dialog box, locate the file or folder you wish to attach. 
3. Position the mouse pointer over the file or folder name in the dialog box, then click the right 

mouse button and choose Add to filename.zip from the pop-up menu (note: the filename shown 
in the menu entry will be the name of the file you selected). This will create a Zip file called 
"filename.zip". 

4. Still in the Open File dialog box, click once on filename.zip (the zip created in the previous step). 
This file will normally be at the end of the current directory listing. 

5. Click the appropriate button to attach the Zip file (this is typically labeled Open, Attach, or Insert).
Note: this technique has been tested with current versions of the most popular e-mail programs (such as 
Outlook and Eudora).    We can't promise that it will work with all e-mail programs or with future versions 
of the programs we have tested.



Related topic
Why aren't WinZip's e-mail features working for me?



The Actions Menu
Use the Actions menu for commands that affect the currently open archive or selected files within the 
archive.    The menu contains the following entries:

· Add adds new files to the archive or updates files that are already in the archive.
· Delete removes files from the archive.
· Extract uncompresses files in the archive and saves the uncompressed files to disk.
· View allows you to look at the contents of files in the archive.
· Select All selects all of the files in the archive.
· Invert Selection selects all files that are currently unselected and deselects all files that are 

currently selected.
· Virus Scan uses your external virus scanner to check files in the archive for viruses.
· Make .Exe File converts the archive into a self-extracting archive.
· UUEncode encodes the archive so that it can be sent via mail systems that do not support binary

e-mail.
· Split splits the archive into multiple smaller parts of a size that you specify.
· Test performs internal testing to make sure that the archive is not damaged.
· Comment allows you to add or edit the Zip file comment.
· CheckOut makes it easy for you to examine archive contents by extracting files to a temporary 

folder and setting up a Windows Explorer window to display the files.
· Install helps you to install software from archives that contain SETUP or INSTALL programs.



Adding Files to an Archive
New users: for introductory information, please see the section Brief Tutorial - Adding Files to an Archive.
This section describes the Add dialog box.    There are other ways to add files to an archive:

· The drag and drop interface
· The Explorer interface.

The Add dialog box:
To open the Add dialog box, click on the Add button on the toolbar or select the Add entry from the 
Actions pull-down menu to bring up the Add dialog box.
You can select the files you want to add in several ways:

· Click on the desired files in the list near the top of the Add dialog box. You can select multiple files
using normal Windows file selection conventions (for example, hold down the Shift key while 
clicking to select multiple files).    Then press the Add button.

· Type the name(s) of the files you want to add.    If you specify multiple filenames, each filename 
must be enclosed in double quotes.    Then press the Add button.

· To add files with wildcards (for example, “*.doc” to add all files with an extension of .doc), type the
filename with wildcards in the File name edit field, then press the Add with wildcards button.    
Standard wildcards are accepted.

See Add Dialog Box Options for a description of the options available in this dialog box.



Add Dialog Box Options
The Add dialog box include these options:

· The Action drop-down list provides four choices. Note that all of these choices replace any files 
already in the archive that have the same name and folder information as files that are being 
added or updated:
· Add (and replace) files: adds all specified files to the archive.
· Freshen existing files: updates files already in the archive that match the specified files.    

No new files are added.
· Move (and replace) files: the same as Add except that files are deleted from disk or moved 

to the Recycle Bin after they have been added. 
· Update (and add) files: works the same as Freshen, but adds any specified files that are not

already in the archive.    
· The Compression drop-down list determines the compression method.    Faster compression 

options usually result in larger archives.
· The Multiple disk spanning drop-down list controls how WinZip®    handles disk-full conditions 

while creating a new Zip file on removable media, such as a diskette.    This drop-down list is 
disabled (not available) unless you are working with a new Zip file on removable media.    When 
this drop-down list is available, you can select from one of three available values:
Automatic will automatically prompt for another diskette when the diskette on which you are 
creating a Zip file is full.
Automatic + wipe first disk prompt is the same as Automatic, but will give you the opportunity 
to erase any files on the first diskette.
No Spanning results in a “disk full” error message if the size of the Zip file exceeds the space 
available on the removable diskette.

· The Include subfolders checkbox determines whether WinZip traverses all folders underneath 
the specified folder when looking for files to add.    This provides an easy way to archive all files 
underneath the folder containing the specified file.
Note:    to restore a branch of a folder added with the Include subfolders option, be sure to select
the Use folder names check box in the Extract dialog box.

· The Save full path info checkbox causes WinZip to store complete path information (from the 
root folder) with all files added.

· The Password button will password protect (encrypt) the file(s) you are adding.    Please be sure 
to read about Password Security before using passwords.

· The Add with wildcards button adds the files specified in the File name field. (In Windows 
“wildcards” are the asterisk and question mark characters. These let you specify multiple files at 
once, for example, “*.Txt” refers to all files with a file type of “Txt”.)

· The Store filenames in 8.3 format checkbox causes WinZip to store the short 8.3 MS-DOS 
compatible form of any long filenames.    “8.3” refers to the maximum of 8 characters in the 
filename portion of the name and 3 characters in the extension, for example, “12345678.123”.

· The Attributes section controls WinZip's handling of file attributes. Attributes are an advanced 
subject; you do not need to understand attributes for normal WinZip operation.    If you are 
interested but not familiar with read-only, hidden, system, and archive attributes, please refer to 
your Windows documentation.    This section contains three options:
The Include only if archive attribute is set option excludes files whose archive attribute is not 
set.
The Reset archive attribute turns off a file's archive attribute after the file is added to the Zip file.



The Include system and hidden files option causes WinZip to add files with the system and 
hidden attributes.    Normally files with these attributes are included.

Note:
The Include only if archive attribute is set checkbox will exclude files whose archive attribute is not set.
This option does not control which folders are searched when the Include subfolders option is selected.



Deleting Files from an Archive
There are two ways to delete files from an archive:

· Select entries in the main WinZip® window, then click Delete from the Actions pull-down menu. 
You can then delete the selected file, all files in the archive, or files specified by name (standard 
Windows wildcards are accepted, so you could use “*.doc” to delete all .doc files).

· Select entries in the main WinZip window, right-click any selected file, and click Delete from the 
pop-up menu.    This displays the same Delete dialog described above.

Notes:
These operations cannot be undone.
To delete an entire archive, click Delete from the Actions pull-down menu to bring up the Delete dialog 
box.    Then click Entire archive and click the Delete button.    Alternatively, you can choose Delete 
Archive from the File menu.



Extracting Files from an Archive
New users: For introductory information, please see the section Brief Tutorial - Extracting Files.
This section describes the Extract dialog box.    There are other ways to extract files from an archive:

· Using the drag and drop interface
· Directly from My Computer or Windows Explorer, as described in the section Using the Explorer 

Interface.
· If a Zip file contains a “setup” or “install” program, you can use the Install Feature to automatically

extract the files, run the installation program, and clean up temporary files.
The Extract dialog box:
Use the Extract button on the toolbar or select Extract from the Actions menu to display the Extract 
dialog box.    Use the Extract dialog box to extract or “unzip” files from the open archive to your disk.
WinZip® extracts files from the archive to the folder specified in the Extract to field.    You can specify this
folder in one of four ways:

· Select a folder and drive in the Folders/drives list boxes.
· Type a folder name in the Extract to field.
· Pull down the Extract to combo box and select a folder from the list of previous Extract to 

folders.

· Click the "new folder" button  and create a folder.
The Extract dialog box provides the following options:

· The Selected files option button instructs WinZip to extract only files that are selected in the main
WinZip window. You can use conventional file selection methods to choose files. This option is 
disabled if no files are selected.

· The All files option button instructs WinZip to extract all files from the archive.
· The Files option button and edit field allow you to specify which files are extracted using 

filenames (standard Windows wildcards are accepted, so you could use “*.doc” to extract all .doc 
files)

· The Overwrite existing files checkbox determines whether you are prompted before existing 
files are overwritten with files from the archive.

· The Skip older files check box determines whether WinZip skips (does not extract) existing files 
when the date/time stamps of the file in the archive is older than the file on disk.

· The Use folder names check box determines whether WinZip will use folder names (also known 
as path names) stored in the archive.    You will probably want to check this option for most extract
operations.    If this option is checked, any folder names stored in the archive will be appended to 
the Extract to folder when appropriate.    If this option is not checked all files will be extracted to 
the same folder, regardless of any folder names in the archive.
For example, assuming the Extract to folder is “c:\temp", the file “mydir\filename” will be 
extracted to the folder “c:\temp\mydir” if the Use folder names option is checked, or the folder 
“c:\temp” if the option is not checked.

· If the Open Explorer window checkbox is checked, a Windows Explorer window is opened after 
the extract operation is complete.    The window will show the folder to which the files were 
extracted.    This checkbox is not present if you are extracting from multiple Zip files directly from 
Windows Explorer using the WinZip context menu.

· If you extract from multiple Zip files using WinZip's Extract to… Windows Explorer context menu 
entry, there will be a checkbox labeled Use Zip file names for folders.    If this checkbox is 
checked, WinZip will create a folder for each Zip file under the Extract to folder; the folders will 



be named with the base names of the Zip files. For example, if the Extract to folder is "c:\temp", 
WinZip will extract files from "NewDocs.zip" to "c:\temp\NewDocs".    If this checkbox is not 
checked, files will be extracted to the Extract to folder.    In most cases, you will probably want to 
leave this option checked when you extract from multiple Zip files.

· The "new folder" button  activates the Create Folder dialog box.    Note that you can extract 
files and create a folder without this dialog box: simply type the name of the new folder in the 
Extract to field of the Extract dialog box and press the Extract button.

Note:    You can change the default Extract to folder using the Folders tab of the Configuration dialog 
box.



Viewing Files in an Archive
You can view files in an archive in several ways:

· With the View button in the toolbar or the View entry in the Actions pull-down menu.    This 
activates the View Dialog Box.

· With the drag and drop interface.
· With the features described in the section titled CheckOut Feature.
· Most files can be viewed by double clicking on the file name in the main window's list box, as 

described in the section titled Double Clicking



View Dialog Box
When you push the View button in the toolbar or choose the View entry in the Actions menu the View 
dialog box is displayed.    This dialog gives you a choice of viewing the selected file(s) in one of three 
ways:

· Using the associated program.    The associated program is listed in parentheses.    This method 
is similar to double clicking on a file in the main window (unless the file is executable; in which 
case the executable file is opened with the program specified in the Default association field in 
the Program Locations tab of the Configuration dialog box).

· Using the built-in internal ASCII text viewer.    Multiple files can be viewed in one view operation 
using this viewer.

· With any viewer available on your system.    You must specify the name of the viewer.



Built-In Viewer
The built-in ASCII text viewer can be used to view text files in an archive, the results of the last operation 
using the View Last Output entry in the Options pull-down menu, and system configuration information 
using the System Info button in the About dialog box.
Unlike most dialog boxes, the viewer window can be resized and maximized.
Click on the Clipboard Copy push button to copy selected text to the system clipboard.    If no text is 
selected all the text is copied to the clipboard.
Note: The viewer is limited to plain ASCII text, just like the Windows Notepad application.



Select All and Invert Selection
The Select All entry in the Actions menu selects all the files in the main window's list box. Invert 
Selection deselects the currently selected files and selects the currently unselected files. Selected files 
can then be easily deleted, extracted, or viewed.



Virus Scan
Use the Virus Scan entry in the Actions pull-down menu to determine whether files in the archive 
contain viruses.    To use this feature a virus scanner must be configured, as described in the section titled
Virus Scanner Configuration.    Note that the CheckOut feature also provides optional virus scanning.
The Virus Scan operation performs the following actions:

1. Creates a temporary folder
2. Extracts all files in the current Zip file to the temporary folder
3. Runs the virus scanner against files in the temporary folder
4. Deletes all files in the temporary folder and removes the temporary folder
5. Displays the results of the scan operation in the View window



Creating a Self-Extracting Archive
Use the Make .Exe File entry in the Actions menu to convert the open archive to a self-extracting 
archive.    Self-extracting archives have an extension of .EXE, and can be run as commands.    When a 
self-extracting archive is run, the files in the archive are automatically extracted.    This is convenient, 
because the end user does not need an unzip program (like WinZip®) to extract files from these self-
extracting archives.
When working with a Zip file, this operation normally runs WinZip Self-Extractor Personal Edition, but you 
can also configure WinZip to use another program.    When working with an LZH file, this operation runs 
the external LHA program with the s option.    When working with an ARJ file, this operation runs the 
external ARJ program with the y option.    For details on configuring WinZip to work with external 
programs, see the sections titled System Requirements and Installing Optional External Programs.
Notes:
If the first file in a self-extracting LZH file is named “!” (i.e. an exclamation mark is the only character in the
filename) this file will be displayed when the self-extracting executable is run.    To ensure that this file is 
the first file in the archive, first create a new LZH file, then add the “!” file (do not add other files in this 
step), and finally add the remaining files.



UUencoding an Archive
Use the UUencode entry in the Actions pull-down menu to UUencode the open archive.    The 
UUencoded file can be sent across mail systems that do not support binary e-mail. For further details on 
UUencoded, XXencoded, BinHex, and MIME files, refer to that section of this help file.



Splitting Zip files
WinZip® makes it easy to create Zip files that are split into smaller pieces of a size that you specify. There
are several reasons why you might want to do this, such as:

· To overcome e-mail size limits.    Some e-mail systems limit the size of attachments; if you want to
e-mail a large Zip file that exceeds your limit, you can split it into smaller parts and e-mail them 
separately.

· As an alternative to spanned Zip files when you want to make multiple copies of the disk set.
· As an alternative to spanned Zip files when you want to make the disk contents as a separate 

step from making the disks themselves.
· To assist with large downloads. Some users may have difficulty downloading very large Zip files 

from web sites, FTP sites, etc.    You can use the split Zip feature to break large files into smaller 
pieces that can be downloaded separately.

To split a Zip file into smaller pieces:
1. Open or create the Zip file.
2. Choose Split from the Actions menu.
3. Specify the name to be used for the split Zip file.    The name must be different from the name of 

the open Zip file.
4. Specify the size to be used for the individual parts.    You can choose from common sizes using 

the Part size drop-down list or you can specify your own size.    To specify your own size, choose 
"Other size" in the drop-down list and type the desired size in the Other size field.    You can 
specify the size in bytes, kilobytes (KB), or megabytes (MB); indicate which you're using by 
clicking the appropriate radio button.    The minimum size allowed is 65,536 bytes (64KB).

5. Click OK to create the split Zip file.
Notes

· Each of the segments of the split Zip file will have a different extension. WinZip creates files with 
names like Data.Z01, Data.Z02, and so on, except for the very last segment of the new Zip file. 
The last segment will always have the .zip extension (e.g., Data.zip).

· To open the split Zip file, open the file with the .zip extension.    Don't try to open any of the files 
with the numbered extensions; WinZip won't recognize them as Zip files.

· Once the split Zip file has been opened, you can work with it much as you would work with a 
regular Zip file, except you can't add any new files or remove existing files.    Some operations 
such as creating self-extracting Zip files and editing comments are also disabled for split Zip files.

· The sizes listed as "1.2MB," "1.44MB," and "2.88MB" are approximate.    The segments of the 
split Zip file are sized appropriately to fit on media of the specified size.    You cannot, however, 
use decimal points when specifying sizes in the Other size field.

· The split Zip file format is an extension of the Zip 2.0 specification.    Therefore, some Zip utility 
programs may not be able to open split Zip files.    Please see Split Zip file compatibility 
information for more details.

See also
Multiple disk spanning



Testing an Archive
Use the Test entry in the Actions pull-down menu to test the integrity of the open archive.    A dialog box 
is displayed with the results of the test operation.
Press the Esc key during the Test operation to terminate the integrity test.



Zip Comments
Use the Comment entry in the Actions pull-down menu to activate the Comment dialog box.    This 
feature is available for Zip files only.
A comment is optional text information that is embedded in a Zip file.    It can be viewed, created, edited, 
or deleted using the Comment dialog box.    Simply type in your text or use any common Windows cut, 
copy, or paste method.
Use the Close button to close this dialog.
Click Save to save any comment or edits you've made.
Clear erases the comment text.    Clicking Save after Clear removes the comment from the Zip file.
Click Font to specify a new display font. It does not affect the comment in the Zip file, but is retained as 
your preference for viewing comments in future sessions.
Zip comments are limited in length.    If you have recent versions of the Windows "Rich Edit" control 
installed, the limit is about 64,000 characters; otherwise, the limit is about 48,000 characters.    For 
greatest compatibility with other users' systems and with other Zip file utilities, we recommend limiting 
comments to 48,000 characters.
Tip: if you would like WinZip® to automatically display comments when opening Zip files that contain 
comments, choose Configuration from the Options menu, click the Miscellaneous tab, and check the 
box labeled Show comments when opening Zip files.



CheckOut Feature
The CheckOut feature makes it easy to examine and/or run files in an archive.    It creates a temporary 
folder, extracts all files from the archive into the folder, creates entries in the Programs menu for the 
extracted items, and opens a My Computer-style window showing shortcuts to the files in the folder.    
Double click any item in the window to perform the action normally associated with the document or 
program (associations are described in the section titled Windows Associations).    WinZip® will optionally 
close the window and delete the temporary folder (and the extracted files) when you close the archive or 
close WinZip.
CheckOut Dialog Box
Use the CheckOut toolbar button or the CheckOut entry in the Actions pull-down menu to activate the 
CheckOut dialog box.    This dialog box lets you configure these aspects of the operation:

· Use the Folder edit field to specify the temporary CheckOut folder name.    The folder will be 
created if it does not already exist.    The suggested folder depends on the setting of the 
CheckOut base folder in the Folders tab of the Configuration dialog box.

· Use the Group name edit field to specify the name to use for the CheckOut window.
· Use the Maximum icons edit field to specify the maximum number of items to be placed in the 

CheckOut window.
· The Create icons for programs and documents only check box lets you control whether 

WinZip creates icons for all files in the archive or only for the specified files.    When this option is 
selected, icons are created for executable files and files with associations.    Icons are also 
created for any files with names starting with “read” (in order to catch files with names like 
“readme.1st", “read.me", etc.).

· The Run virus scanner check box lets you specify whether WinZip will run a virus scanner on 
the files in the archive. This option is disabled unless a virus scan utility is installed in the 
Program Locations tab of the Configuration dialog box.

Operations performed by the CheckOut feature:
When you click on the OK button in the CheckOut dialog box, WinZip performs the following operations:

1. If the specified folder does not already exist, WinZip will create it.    If it already exists and 
contains files, WinZip will delete the files (after asking your permission, of course).    This ensures 
that the folder will contain only files from the current archive.

2. WinZip extracts files in the current archive to the specified folder.
3. If the Run virus scanner check box is selected, your virus scanner is run against all files in the 

specified folder.    If the virus scan utility returns a non-zero error level, the CheckOut operation is 
cancelled and messages from the scanner are displayed.

4. WinZip creates a second folder, located in \Windows\Start Menu\Programs. If a folder with the 
specified name already exists, WinZip will delete it after getting your permission.    This ensures 
that the folder will contain only icons for files in the current archive.

5. In the second folder, WinZip creates shortcuts to the extracted files.    It then opens a My 
Computer-style window displaying icons for the extracted files.    These items will also appear in 
the Programs menu, accessible from the Start button.

Using the CheckOut window:
The window created by CheckOut is a My Computer-style view of the checkout folder and works like any 
similar window.    WinZip creates shortcuts in this folder for each extracted file so that you can use them 
as follows:

· If a file is executable, double clicking on the icon runs the program.
· If a file has an association, double clicking on the icon loads the file in the associated program so 

you can view the file.



· Otherwise, double clicking on the icon loads the file in the WinZip Default association program 
specified in the Program Locations tab of the Configuration dialog box.



Install Feature
WinZip's® Install feature makes it easy to install software distributed in archives.    The Install feature is 
available if an archive contains an “install” or “setup” program, a desktop theme, or a screen saver.    This 
help topic describes the software installer.    The Desktop Theme Installer and the Screen Saver Installer 
operate in a slightly different way and have their own help topics.
The software Install feature performs these functions:

1. extracts all the files to a temporary folder
2. runs the Setup program
3. deletes the temporary installation folder and files

The Install Dialog Box:
Click the Install button on the toolbar or select Install from the Actions menu command to open the 
Install dialog box.
Use the Minimize during install checkbox to control whether WinZip will be minimized while running the 
install program.
Press the OK button to begin the installation.
Notes:
Self-extracting Windows archives are treated as a special case.    If you have opened a self-extracting 
Windows archive, the Install feature will simply run the self-extractor instead of extracting all the files to a 
temporary folder, running the setup program, and deleting the temporary installation folder and files.
If the Install button is not displayed, but you recognize an installable file, you can use the CheckOut 
Feature to try to install the software in the archive.



The Options Menu
The Options menu allows you to set many WinZip® options.    The menu entries are:

· Configuration activates the main Configuration dialog box.    This dialog box controls most 
WinZip settings.

· Password activates the Password dialog box.    This dialog lets you set a password for 
subsequent archive operations.

· Sort lets you specify whether the list of files in the archive is sorted by name, type, date, size, 
compression ratio, packed size, CRC, file attributes, path, or whether the original archive order 
should be used.    Note: You can also change the sort order by clicking on the appropriate portion 
of the main list box header.    For example, click on the word “Date” in the header to sort by date.   
To reverse the sort order, click it again.

· Reuse WinZip Windows determines whether a new window is opened when you start WinZip by
double clicking in My Computer, Windows Explorer, or the desktop.    When this entry is checked, 
an existing WinZip window is used.    When this entry is not checked, a new WinZip window is 
created.    One advantage to reusing WinZip windows is that double clicking acts the same as 
drag and drop, and you never accidentally wind up with multiple WinZip windows.

· Save Settings on Exit determines whether your currently chosen configuration options are 
automatically saved when WinZip is closed.

· Save Settings Now saves selected options immediately.
· Set Installation Defaults sets many configuration options and folder names to the original 

installation defaults.
· View Last Output displays the results of the last WinZip operation.



Configuration Dialog Box
Choose Configuration from the Options menu to activate the Configuration dialog box.    This dialog box 
contains tabs that control most WinZip® settings. Click on any tab title for further information on its 
content.

· The View tab controls the appearance of the main WinZip window.
· The Toolbar tab lets you customize the look and content of your WinZip toolbar.
· The Folders tab offers choices for start-up, extract, add, working, checkout, and temporary 

folders.
· The System tab provides options for accessing WinZip through My Computer and Windows 

Explorer.
· The Explorer Enhancements tab provides options for configuring WinZip's Windows Explorer 

enhancements.
· The Program Locations tab controls the default viewer, virus scanner, and optional archive 

utilities.
· The Miscellaneous tab includes start-up, “on top,” Smart DOC, and other general options.



View (Configuration)
Select the View tab in the Configuration Dialog Box to control these options:
Columns

Select the columns that you want to appear in the file listing. Click the Defaults button to return 
the column selection and sizes to their original default values.
Tip: you can also choose columns right in the WinZip® window: just right click any column header
and choose the columns you want from the pop up menu. You can use your mouse to resize and 
hide columns by dragging the column dividers in the header area. You can also use your mouse 
to rearrange columns by dragging the column header from one location in the header area to 
another location.

General
Allow all upper case file names - WinZip normally shows filenames the same way as Windows: 
if the filename contains any lower case characters the filename is shown in mixed case.    
Otherwise the first letter of the filename is shown in upper case and the remainder in lower case.  
If this option is checked, filenames that contain no lower case characters will appear in all upper 
case (rather than initial upper case).
Full row select - WinZip's default action is to use Windows Explorer style of file selection, 
requiring that the file name itself be clicked. This option allows you to click anywhere on the file's 
row of information in order to select it.
Grid lines - Display grid lines to separate rows and columns in the main WinZip window.    Due to 
a problem in Windows XP, this option is not available for XP users.

Mouse selection
Normally the main WinZip window will automatically use the same mouse selection settings as 
your Windows desktop.    Should you need to change these settings for the main WinZip window, 
you can use these fields to do so.

Note:    these options are available only if you have version 4.71 or later of the Windows Common Control 
library. This library is part of Windows 98, Windows Me, Windows 2000, Windows XP, Microsoft Internet 
Explorer 4.0 or greater, and is available as a separate download from the Microsoft web site as described 
in the section Windows Common Control Library.

Related Topics (other Configuration tabs):
Toolbar      Folders      System      Explorer Enhancements      Program Locations      Miscellaneous



Toolbar (Configuration)
Select the Toolbar tab from the Configuration Dialog Box to control these options:

· Use Explorer-style toolbar buttons - use this option to display toolbar buttons that are similar in
appearance to the toolbar buttons used by Internet Explorer: the buttons appear in gray until the 
mouse pointer passes over them. This option has no effect unless Use flat toolbar buttons is 
also checked. On Windows XP, setting this option will switch from WinZip icons for Windows XP 
to the old Explorer Style icons when Use large toolbar buttons is selected.

· Use large toolbar buttons - use this option to display larger toolbar buttons.    On all versions of 
Windows except Windows XP, the Use Explorer-style toolbar buttons option affects the 
appearance of large toolbar buttons: if Explorer-style is checked, the large buttons are somewhat 
simpler in design than the standard WinZip large toolbar buttons. 

· Show button text - use this option to display the name of the button under the button graphic on 
the toolbar.

· Show tool tips - use this option to enable the display of brief, pop-up text describing a button's 
function when your cursor pauses over a button.

· Use flat toolbar buttons - use this option to give toolbar buttons a flat look instead of a 3D look.  
If Use Explorer-style toolbar buttons is also checked, the buttons appear in shades of gray and
change to color when the mouse pointer passes over them.. This option is not available under 
Windows XP.

· Use high color toolbar buttons when possible - use this option to control whether WinZip uses
more colors to draw color toolbar buttons on systems configured to display more than 256 colors. 
This option is not available under Windows XP.

Click Select Buttons to open the Select Buttons dialog box, which enables you to select and rearrange 
the toolbar buttons.
Note:    Some toolbar configuration options are available only if you have version 4.71 or later of the 
Windows Common Control library. This library is part of Windows 98, Windows Me, Windows 2000, 
Windows XP, Microsoft Internet Explorer 4.0 or greater, and is available as a separate download from the 
Microsoft web site as described in the section Windows Common Control Library.

Related Topics (other Configuration tabs):
View      Folders      System      Explorer Enhancements      Program Locations      Miscellaneous



Select Buttons (Toolbar Configuration)
Click Select Buttons in the Toolbar tab in the Configuration Dialog Box to select and rearrange the 
WinZip® toolbar buttons. You can also right click on the toolbar itself and click on Select Buttons.
The left side of the Select Buttons dialog box shows the buttons and separators that are available for use.
The right side displays the toolbar arrangement in a vertical, top to bottom format, which is then 
transformed into the horizontal, left to right format that WinZip uses.

· To Add a button, highlight the button in the left side of the dialog and click Add. It is easy to 
move it to the preferred location. If desired, you can highlight the button above which you'd like to 
insert the new button, first, and it will be placed in that position.

· To Remove a button, highlight the button in the right side of the dialog, and click Remove.
· To Rearrange toolbar buttons:

Select and drag a button to its new location; an arrow to the left of the button display will indicate 
its placement.
Highlight a button and use the Move Up and Move Down buttons to move it to the desired 
location.

· To Reset WinZip to its original toolbar configuration, click the Reset button. 
Notes:

· You can move buttons on the toolbar without using this dialog box: just press the Alt key on your 
keyboard, and while holding down the Alt key, click on and drag a toolbar button from its current 
location to the desired location.

· You can remove buttons on the toolbar without using this dialog box: just press the Alt key on 
your keyboard, and while holding down the Alt key, drag a toolbar button off the toolbar.

· The separator at the end of the toolbar cannot be moved or removed.
· This dialog box is only available if you have version 4.71 or later of the Windows Common 

Control library. This library is part of Windows 98, Windows Me, Windows 2000, Windows XP, 
Microsoft Internet Explorer 4.0 or greater, and is available as a separate download from the 
Microsoft web site as described in the section Windows Common Control Library.

Related Topics (other Configuration tabs):
View      Toolbar      Folders      System      Explorer Enhancements      Program Locations      Miscellaneous



Folders (Configuration)
Select the Folders tab from the Configuration Dialog Box to control these options:
Start-up folder
Unless you start WinZip® by double clicking on an archive, WinZip will optionally change to a folder of 
your choice when it starts up.    Files in this folder are automatically displayed in the Open archive and 
New archive dialog boxes.    The following choices control which folder is used.

· System default - WinZip does not change folders, so the system default folder is in effect.    
Usually this is the folder containing WINZIP32.EXE.

· Last open archive - WinZip changes to the folder containing the last open archive during your 
last WinZip session, unless it is on your A: or B: drive.

· Folder - WinZip always changes to the specified folder.
Extract folder
These selections determine the default folder that WinZip automatically lists in the Extract to field in the 
Extract dialog box.    You can, of course, type over this default folder name or select a different folder from 
the folder list.

· Open archive folder - WinZip lists the name of the folder containing the open archive in the 
Extract to field.    For example, if the archive c:\download\tools.zip is open, WinZip will list c:\
download.

· Last extract folder - WinZip will list the name of the folder you used during the last Extract 
operation, unless it is on your A: or B: drive.    This value is saved when you exit WinZip so you 
can use it during your next WinZip session.

· Folder - WinZip always lists the specified folder.    This value is saved when you exit WinZip so 
you can use it during your next WinZip session.

Add folder
These selections determine the default folder when the Add dialog box is opened.

· Open archive folder - WinZip uses the folder containing the open archive.
· Last add folder - WinZip uses the folder you used during the last Add operation, unless it is on 

your A: or B: drive.    This value is saved when you exit WinZip so you can use it during your next 
WinZip session.

· Folder - WinZip always uses the specified folder.    This value is saved when you exit WinZip so 
you can use it during your next WinZip session.

Working folder
If specified, temporary Zip files are created in this folder.    If this option is not specified, temporary Zip files
are created in the folder containing the open Zip file.    This option is particularly useful when you are 
updating an archive and there is not enough room on the destination drive for both the original archive 
and the updated archive.    This is most likely to occur when you are working with removable media (e.g. 
diskettes). You can tell WinZip to use this feature only when working with Zip files on removable media by 
checking the Use for removable media only checkbox.
When using ARJ to create an archive WinZip specifies this folder name via the -w switch.
CheckOut base folder
If specified, WinZip uses this folder as the prefix for the default folder in the CheckOut dialog box.    If this 
field is left blank WinZip will instead use the folder containing the open archive.
Temp folder
This entry specifies the location for temporary files created by WinZip, including files created during the 
View and Virus Scan operations. If you run out of disk space during a View or Scan operation, change the



Temp Folder to specify a drive and folder with sufficient free space.

Related Topics (other Configuration tabs):
View      Toolbar      System      Explorer Enhancements      Program Locations      Miscellaneous



System (Configuration)
Select the System tab from the Configuration Dialog Box to control these options:
General
Modifying the following system options will affect all users who log on to this computer.

· The Associate WinZip with archives checkbox determines whether Windows will use WinZip® 
to open archives from My Computer, Windows Explorer, most e-mail programs, etc.    WinZip can 
associate itself with the following archive types: ZIP, LZH, ARJ, ARC, CAB, TAR, TGZ, TAZ, GZ, 
Z, TZ, UU, UUE, XXE, B64, HQX, BHX, and MIM.    If you check this option, WinZip associates 
itself with all of the listed types. If you uncheck this option, WinZip removes all of its associations. 
When the option is checked, you can click Associations to control WinZip's associations with 
specific archive types.    See the section titled Windows Associations for more information on 
associations.

· If the Include WinZip Quick Pick in the taskbar tray checkbox is checked, the WinZip Quick 
Pick icon appears in the system taskbar tray.    You can use this icon to open WinZip, access 
recently used archives. etc.

· If the Include WinZip in the Start menu checkbox is selected, WinZip is automatically added to 
the Taskbar Start menu.    Uncheck this option to remove WinZip from the Start menu.

· If the Include WinZip on the desktop checkbox is selected, a shortcut to WinZip is added to the 
desktop.    Uncheck this option to remove the WinZip shortcut from the desktop.

Related Topics (other Configuration tabs):
View      Toolbar      Folders      Explorer Enhancements      Program Locations      Miscellaneous



Explorer Enhancements (Configuration)
Select the Explorer Enhancements tab from the Configuration Dialog Box to control WinZip's® Windows
Explorer enhancements.
You can disable all of the Explorer enhancements by clearing the checkbox labeled Enable Explorer 
enhancements (including additional Drag and Drop features).    If this box is checked, you can control
the enhancements individually as follows:
General

· The Display context menu items in a submenu checkbox controls whether the WinZip Explorer
context menu items are displayed in the main Explorer context menu or in a submenu.

· The Display icons on context menus checkbox determines whether a small WinZip icon is 
displayed to the left of the WinZip Explorer context menu items.

· The "Add to" includes folder information checkbox determines how folder information is stored
when you right click a folder in Windows Explorer or My Computer and then choose Add to 
folder-name.zip from the WinZip Explorer context menu.    If this box is checked, folder 
information will be stored for all files added.    If it is not checked, folder information will be stored 
only for files added from subfolders of the selected folder.

Check for self-extracting CAB files
When the WinZip Explorer context menu is displayed for an EXE file, WinZip can check to see if it is a 
self-extracting CAB file.    This operation can take a few seconds; you can use the following options to 
control whether or not it is performed on various types of media.

· If the On Local hard drives checkbox is checked, WinZip will check EXE files located on local 
hard drives.    This operation is normally quite fast.

· If the On removable disks (e.g., diskettes) checkbox is checked, WinZip will check EXE files 
located on removable media.    This operation may take a few seconds.

· If the On other drives (e.g., network drives) checkbox is checked, WinZip will check EXE files 
on other storage devices such as network drives.    The speed of this operation depends on the 
speed of the device, network connection, etc.

Display comment tool tips for Zip files
When the mouse pointer is hovered over a Zip file in a Windows Explorer or My Computer window, 
WinZip can display a tooltip containing basic information about the Zip file, including the number of files in
the Zip file and the Zip file comment.    This operation can take a few seconds; you can use the following 
options to control whether or not it is performed on various types of media.

· If On Local hard drives is checked, WinZip will display tooltips for Zip files located on local hard 
drives.    This operation is normally quite fast.

· If the On removable disks (e.g., diskettes) checkbox is checked, WinZip will display tooltips for 
Zip files located on removable media.    This operation may take a few seconds.

· If the On other drives (e.g., network drives) checkbox is checked, WinZip will display tooltips 
for Zip files on other storage devices such as network drives.    The speed of this operation 
depends on the speed of the device, network connection, etc.

Context menu commands
You can use this list to enable or disable many of the WinZip Explorer context menu entries individually.    
Check the appropriate checkbox to include a command in the WinZip menu, or clear it to remove the 
command from the menu (see Explorer context menu enhancements for descriptions of the individual 
commands).    
Note: the command labeled Open unassociated archives with WinZip corresponds to the submenu 
entry Open with WinZip that appears for self-extracting archives, certain media player "skin" files, etc.



Related Topics (other Configuration tabs):
View      Toolbar      Folders      System      Program Locations      Miscellaneous



Program Locations (Configuration)
Select the Program Locations tab from the Configuration Dialog Box to specify the paths and filenames 
for the optional external programs supported by WinZip®.    Note that these programs are not required for 
most operations involving Zip files.
If you are installing WinZip and are not familiar with these programs you can just press the OK button to 
continue the installation procedure.
External programs are not distributed with WinZip.    For more information on these programs, including 
availability and minimum version numbers, see the section titled System Requirements.    For step by step
installation examples for external archivers see the section titled Installing Optional External Programs.    
See the section titled Virus Scanner Configuration for information about that portion of the dialog box.
If a program is not installed on your system, just leave the corresponding field blank.    Otherwise, fill in the
program name.    The extension defaults to EXE.    If no path is included for an entry, WinZip assumes that
the program is in a folder specified in your system's PATH.
The program specified as the Default association is used when viewing a file that does not have an 
association.    For additional information on associations, see the section titled Windows Associations.    
The defaults for this field are:

· Quick View (quikview.exe), if you use Windows 95, Windows 98, or Windows NT 4.0 and you 
have installed this optional Windows component.    If you have one of these Windows versions 
and Quick View does not appear here, you may be able to install it.

· SCCVAPI.EXE, System Compatibility Corporation's “Outside In” file viewer, if it is found in a folder
specified by your system's PATH.

· NVIEWER.EXE, the Norton Desktop for Windows File Viewer, if it is found in a folder specified by 
your system's PATH.

· WNFV.EXE, the PC Tools for Windows File Viewer, if it is found in a folder specified by your 
system's PATH.

· NOTEPAD.EXE, the Windows Notepad program, if NVIEWER and WNFV are not found.
The entry for the Optional virus scanner could have any of these values (the filenames shown are 
examples):

Value Description
(blank) If the entry is blank, WinZip assumes that no virus scanner is installed

on your system.
SCANNER.EXE Just the filename is needed if the specified file (SCANNER.EXE, in 

this example) is in a folder specified in your system's PATH.
C:\SCANNER\SCANNER.EXE The full drive, folder, and filename are required if the specified file 

(SCANNER.EXE, in this example) is not in a folder specified in your 
system's PATH.    Note that C:\SCANNER is just an example, any 
other folder can be used.

The ARJ, LHA, and ARC file formats require external programs to be available for them to be handled 
using WinZip. You can type the names of these programs, or use the browse button     to locate them. If 
they are not available on your system, leave the fields blank. They are only necessary if you use these 
other archive formats and want WinZip to handle them for you.
See the section titled System Requirements for more information on version numbers and availability of 
the external programs supported by WinZip.
Note: When WinZip is installed it will attempt to locate the default programs for each field in the folders 
specified by your system's PATH.    If it cannot find these programs, it will leave the corresponding edit 
fields blank.

Related Topics (other Configuration tabs):



View      Toolbar      Folders      System      Explorer Enhancements      Miscellaneous



Miscellaneous (Configuration)
Select the Miscellaneous tab from the Configuration Dialog Box to control these options:
Start-up

· Next time start with the Wizard interface - Whether WinZip® should use the Wizard interface 
the next time it is started.

· Automatically show the Open Archive dialog box - Whether WinZip should automatically show
the Open Archive dialog box when you start WinZip.

Other
· Windows Explorer-style Extract dialog box - This feature determines whether the Extract 

dialog box contains a tree view control or the Windows 3.1 style folder control.
· TAR file smart CR/LF conversion - When selected, this option determines if “smart” CR/LF 

conversion should be performed when extracting from TAR files.    CR/LF is short for Carriage 
Return/Line Feed, the standard end of line indicator.    This option can be useful when a TAR file 
contains text files created on a Unix or Macintosh machine.    Unix text files usually contain lines 
ending in Line Feed characters only, and Macintosh text files usually contain lines ending in a 
Carriage Return character.    The standard Windows Notepad program and many other Windows 
programs require a Carriage Return and Line Feed at the end of each line.    When the TAR File 
smart CR/LF conversion option is in effect, WinZip determines whether to perform CR/LF 
conversion for each file inside a TAR file by looking at the first 80 characters in each file.    If the 
file is a text file then single LF and CR characters are converted to CR/LF pairs so the file can be 
viewed by Notepad and other Windows viewers.    Files are considered text when the first 80 
bytes contain only characters with ASCII values between 0x20 and 0x7f, carriage returns, line 
feeds, form feeds, tabs, and other alphanumeric characters (as determined by the Windows 
IsCharAlphaNumeric API).

· Always have WinZip on top - When checked, WinZip is assigned the “always on top” attribute, 
so that it is not overlaid by normal windows.

· Beep after long archive operations - WinZip will beep after archive operations that take more 
than one second to complete when this option is chosen.

· Smart DOC file handling - “Smart DOC Handling” is enabled when selected.    This feature is 
described in the section titled Double Clicking.

· Number of files in recent file list - Sets the number of files that appear in the list of recently 
used files in the File menu.    You can set this to any number from 1 to 9.

· Use Recycle Bin for move operations - When checked, if you select the Move (and replace) 
files action in the Add dialog box, WinZip will put files in the Recycle Bin instead of deleting them.

· Prompt when View button is pushed - Unchecking this option will bypass the View dialog.
· Desktop theme/screen saver installer - When checked, the Desktop Theme Installer and the 

Screen Saver Installer are enabled.    When unchecked, WinZip treats Zip files containing desktop
themes or screen savers as normal Zip files.

· Show comments when opening Zip files - When checked, WinZip will automatically display the
Zip comment when you open a Zip file that contains a comment.

· Bring back all caution messages - If this option is checked when you dismiss the configuration 
dialog, WinZip restores all caution dialogs that you have turned off (a caution dialog is "turned off"
by checking its "Do not display this dialog in the future" checkbox). 

· Display status dialog for long operations - When checked, WinZip displays an animated 
progress dialog during lengthy archive operations.    The dialog allows you to minimize WinZip 
while the operation is in progress or to cancel the operation.

Show Add dialog when dropping files on:



· An archive in Explorer - Controls whether or not a dialog is displayed when you drop files on an 
archive in Explorer.    If checked, WinZip displays an Add dialog, which allows you to specify 
various options to be used during the archiving process.    If not checked, the files are simply 
added to the archive and no dialog is displayed.

· An open WinZip window - Controls whether or not a dialog is displayed when you drop files 
from Explorer on a WinZip window.    If checked, WinZip displays an Add dialog, which allows you 
to specify various options to be used during the archiving process.    If not checked, the files are 
simply added to the open archive and no dialog is displayed.    Note: if no archive is open, WinZip 
must display the dialog even if this checkbox is not checked because you will need to use it to 
specify an archive name.

Related Topics (other Configuration tabs):
View      Toolbar      Folders      System      Explorer Enhancements      Program Locations



Virus Scanner Configuration
WinZip® supports many virus scanners that can be run from Windows or from the DOS command line, 
with a few important limitations noted below.    Virus scanners can be run using the Scan entry in the 
Actions menu or during CheckOut operations if the Run virus scanner option in the CheckOut dialog box
is selected.
Virus scanner configuration is done from the Program Locations tab of the Configuration Dialog Box.
When you first install WinZip, it automatically searches for virus scanners in the folders specified by your 
system's PATH and in the “App Paths” Windows registry entries.    If one of the supported virus scanners 
is found, WinZip will automatically use the scanner.    A listing of and further information about currently 
supported virus scanners can be found on the WinZip web site at http://www.winzip.com/xvirus.htm.
If the installation procedure does not automatically find one of the aforementioned virus scanners, you 
can have WinZip automatically fill in the Parameters field by selecting the desired scanner from the drop-
down combo box (for example, scan.exe) and then adding the full filename for the scanner to the Scan 
program field (for example, c:\mcafee\scan.exe instead of just scan.exe).
You can also configure WinZip to work with another scanner.    See the section titled Virus Scanner 
Configuration Details below for more information.
Notes:
WinZip's default virus scanner parameters work with the versions of the scanners that were tested.    If the
authors of a scanner change the command line parameters in future releases of the scanner, then 
WinZip's default parameters for the scanner may no longer work.    For example, McAfee SCAN 2.1 
parameters are incompatible with prior versions of SCAN.    Version 2 requires the /ALL parameter while 
version 1 requires /A.
Unless a virus is found, no manual intervention is required while running most virus scanners.    However, 
some virus scanners, such as TFINDVIR, always need to be closed manually, because they do not 
currently support options to close automatically.
Virus Scanner Configuration Details
This portion of the documentation describes how to configure WinZip to work with a scanner that is not 
listed above.    Do not use WinZip's virus scanning support with a different virus scanner unless you have 
read and understood the following information.
To configure WinZip to work with a scanner, fill in the following fields in the Program Locations tab of the
Configuration dialog box:

· The Scan program field should contain the name of the program (the full path name is required if
the program is not in a folder specified in your system's PATH).

· The Parameters field should contain the appropriate parameters to run the virus scanner as 
described below.

· The Run minimized box determines whether the scanner should be run minimized.    See below 
for important notes on using this parameter with DOS based scanners.    Note that some 
scanners, such as NAVW32.EXE, always run minimized, regardless how you set this option.

Special character sequences for the Parameters field are:
*.* indicates where WinZip should substitute the drive, folder, and the *.* characters for the files 

that are to be scanned.    For example, “c:\temp\dir\*.*”.
%d indicates where WinZip should substitute the drive and folder of the files that are to be 

scanned.    Note that the wild card characters *.* are NOT included when you use %d.
%f indicates where WinZip should substitute the name of a temporary “report file”.    Report files 

should ONLY be used when running DOS virus scanners.
%wscan a special parameter required for McAfee's WSCAN program.

If you do not specify any of the aforementioned special character sequences WinZip will append the 



filenames to be scanned at the end of the scanner command line.
Be sure to specify any parameters necessary to cause the scanner to check folders of the drive and folder
of the files that are to be scanned.
To configure WinZip for a Windows-based virus scanner, first ascertain that the virus scanner reports 
suspected viruses by displaying a dialog box.    If the scanner simply writes to a log file when a virus is 
found you (and WinZip) will not know about the problem.
To configure WinZip for a DOS-based virus scanner, be sure to verify that the scanner can either be used 
with the Run minimized option (see below for details) or issues a prompt if a virus is found.    If neither of 
these conditions is met and a virus is found you (and WinZip) will not know about the problem.
The Run minimized check box should only be used for DOS scanners under the following 
circumstances:

· The scanner is configured to run in “batch” mode, without any prompts.    If the scanner requires 
any keyboard input when running minimized, you will not be able to see the prompts, and the 
session will appear to be hung.

· The scanner writes all messages through DOS, or has an option to write results to a report file.    
Messages written directly to the video buffer are not captured by WinZip and will be lost.    To 
determine whether a scanner writes messages through DOS, run the scanner with its output 
redirected (for example, issue the command “scan > nul").    Any messages you see during this 
test will not be captured by WinZip.    If the scanner has an option to write results to a report file 
you can use %f in the Parameters field to cause WinZip to capture the results (see above for 
details).

· The scanner returns a non-zero error level if it encounters any problems.    If the scanner does not
return a non-zero error level, WinZip will assume that the files passed the virus check, and any 
warnings issued by the scanner will be lost.    (Note: if the scanner returns a non-zero error level, 
WinZip automatically displays all messages written to standard error or standard output.)



The Help Menu
The Help menu provides access to WinZip's® help information, hints and tips, frequently asked 
questions, and WinZip registration and ordering information.    The entries are:

· Help Contents and Index displays the table of contents and index of WinZip's help.    You can 
browse to the topic you need, look in the help index, or perform a full text search for keywords of 
interest.

· Brief Tutorial starts a brief step-by-step tutorial on using WinZip's main features.
· How to Use Help displays a Microsoft help file that explains how to use the help viewer.
· Frequently Asked Questions helps you get answers to questions you might have.    You can 

choose between the FAQs in the help or a more extensive set of FAQs on the WinZip web site.
· Hints and Tips displays a help topic that contains miscellaneous hints and tips on how to use 

WinZip productively.
· Tip of the Day displays a dialog containing a useful tip about WinZip.
· Enter Registration Code appears only in the evaluation version of WinZip.    Use this entry to 

register your copy of WinZip after you have purchased a WinZip license.
· License Agreement displays the WinZip License Agreement.
· Ordering Information displays information from the WinZip help about how to order WinZip.
· WinZip Home Page takes you to the WinZip web site.
· About WinZip displays the WinZip copyright notice, version number, and other information about 

your installation of WinZip.



Using the Explorer Interface
Using WinZip's® Explorer interface, you can access most WinZip functionality directly from Windows 
Explorer or My Computer context menus, from the Start menu, or from the desktop.

Working with the Explorer Context Menu
Working with the Start Menu and Desktop
WinZip Quick Pick taskbar tray icon

Related Topics:
Using WinZip Menus
Using Drag and Drop

See also
Hints and Tips
More Hints and Tips
Hints For Working With Downloaded Files
Frequently Asked Questions (FAQs)



Working with the Explorer Context Menu
You can initiate most common operations on archives from My Computer or Windows Explorer context 
menus. In many cases, you won't even need to display or use the main WinZip® window.
Unzipping files from My Computer or Windows Explorer

· Right click a Zip file in a Windows Explorer window, then choose WinZip from the context menu 
and pick the appropriate Extract choice from the WinZip submenu.    You can extract to the 
current folder ("here"), a recently used folder, a new subfolder created by WinZip, or any folder of 
your choice.

· Or, use the right mouse button to drag and drop a Zip file from a Windows Explorer window to any
folder, then choose Extract to from the context menu.    Be sure to use the right mouse button 
while dragging.

· You can extract from multiple Zip files in one operation, too: just select the Zip files in Explorer, 
right click any of the selected files, choose WinZip from the context menu, and pick the 
appropriate Extract choice from the WinZip submenu.

Zipping files from My Computer or Windows Explorer
· Select one or more files in a Windows Explorer window, then right click any of the selected files, 

choose WinZip from the context menu, and pick the appropriate Add choice from the WinZip 
submenu.    You can create a new Zip file or you can add the files to any existing Zip file.

· Alternatively, select one or more files, then drag and drop them on an existing Zip file in the same 
Explorer window, in another Explorer window, or on the desktop.    Note that you can create a 
new, empty Zip file in Explorer by right clicking and then choosing WinZip File from the New 
submenu.

Compressing and e-mailing files and folders from My Computer or Windows Explorer
· Select one or more files or folders in a Windows Explorer window, then right click any of the 

selected items, click WinZip from the context menu, and choose one of the Zip and E-Mail 
entries from the WinZip submenu.    Zip and E-Mail filename.zip quickly compresses the 
selected items, creates a temporary Zip file with the specified name, and attaches it to a new e-
mail message.    Zip and E-Mail Plus performs the same basic operation but allows you to apply 
password protection and to specify the name of the temporary Zip file to be created.

For a complete list of the actions available from the context menu, see the Explorer context menu 
enhancements.
See also
Using the Start Menu and Desktop
Using Drag and Drop
WinZip Quick Pick taskbar tray icon
Explorer context menu enhancements
Explorer Enhancements (Configuration)



Using the Start Menu and Desktop
Using the Windows Desktop:

· You can create a new, empty Zip file on the desktop: right click anywhere on the desktop and 
select WinZip File from the New submenu.    After you've created it, change the name if desired 
and then double click the icon to open it using WinZip®, or use drag and drop to add files to the 
new Zip file.

· Be sure to read about drag and drop for more things you can do on the desktop.
Using the Start menu:

· If you have WinZip configured to include a Start menu entry, you can start WinZip directly from 
the system Start menu.

· You can open recently used archives from the Documents submenu in the Start menu. 
Note: Windows XP does not display Zip files in the Documents submenu. You can use the 
WinZip Quick Pick taskbar tray feature to open recently used archives.

See also
WinZip Quick Pick taskbar tray icon
Working with the Explorer Context Menu
Using Drag and Drop



Explorer Add Dialog Box
The Explorer Add dialog box is displayed when you use the Add to Zip file entry in the My Computer or 
Windows Explorer context menus.
This dialog box lets you change the name of the open archive in one of two ways:

· Type the name of the archive in the Add to archive edit field.
· Click on the New or Open buttons to activate the standard New and Open dialog boxes, 

respectively.
These shortcuts provide a quick way to add files to a different archive without going through the File pull-
down menu.
See Adding Files to an Archive for a description of the options available in this dialog box.



Using Drag and Drop
The drag and drop Interface is one of the most natural ways to use WinZip®.    Using drag and drop, you 
can create, open, update, extract from, print, and e-mail archives--and more.    Almost any drag and drop 
operation you can think of will work.
To drag and drop a file or folder, click it with your left mouse button, then, without releasing the button, 
drag it to the desired location and release the mouse button to drop it.    Refer to your Windows help for 
more information if you haven't used drag and drop.
Creating a new Zip file

· Drag one or more files or folders from My Computer or Windows Explorer to the WinZip desktop 
icon or an open WinZip window.    Then, using the Add dialog, you can specify the name and 
location for your new Zip file.

Opening an archive
· Drag an archive from My Computer or Windows Explorer and drop it on the WinZip desktop icon 

or an open WinZip window.
· Remember, you can also double click the archive to open it, or right click it and choose Open 

with WinZip from the context menu.
Adding files to an archive
To add files to an existing archive, select one or more files or folders in My Computer or Windows 
Explorer and drop them on any of the following:

· an open WinZip window
· the WinZip desktop icon
· an archive shown in a My Computer or Windows Explorer window
· an archive on the desktop
· a shortcut to an archive

Extracting, viewing, and printing files in an archive
You can drag files from an archive open in a WinZip window to other applications, My Computer or 
Windows Explorer windows, the desktop, printers and shortcuts.

· If you drop files on a folder listed in My Computer or Windows Explorer, the files are extracted to 
that folder.

· If you drop files on the desktop, the files are extracted to the desktop.
· If you drop files on a printer icon, the files are printed.
· If you drop files on another application or on a shortcut to an application, the files are extracted to 

a temporary folder and passed to the application for handling.    The files are removed from the 
temporary folder when the archive is closed.

Note: it's important to remember that different applications handle dropped files in different ways.    For 
example, when you drop a file on the WordPad application distributed as part of Windows it will embed 
the file as an OLE object, but when you drop a file on the Notepad application distributed as part of 
Windows it will open the file.    You may need to experiment with drag and drop to understand how each 
application reacts to files dropped on it.
Dropping an archive on another application
Sometime it can be useful to drag an entire archive from WinZip and drop it on an application.    For 
example, you can drop an archive on an e-mail message to send it as an attachment, or on a Word 
document to embed it as an object.
To drop an open archive from WinZip to another application, click the WinZip status line, drag the mouse 
pointer to the application window, and release the mouse button.



Related Topics:
Using the Explorer Interface
WinZip Quick Pick taskbar tray icon
Add Dialog Box
Add Dialog Box Options



Add Dialog Box
The Add dialog box is displayed when you use the drag and drop interface to add files to an archive.    You
can either create a new archive or add the files to an existing archive.
The Add dialog box lets you specify the name of the open archive in one of two ways:

· Type the name of the archive in the Add to archive edit field.
· Click on the New or Open buttons to activate the standard New and Open dialog boxes, 

respectively.
These shortcuts provide a quick way to add files to a different archive without going through the File 
menu.

See Add Dialog Box Options for a description of the options available in this dialog box.



Create Folder
This dialog box lets you create a folder.    This folder becomes a sub-folder of the current folder unless you
specify a path.
Note: you can only create folders in existing folders; you cannot create multiple folders at once.    For 
example, if the following folder is empty

C:\Test Folder
You can create the folder

C:\Test Folder\One Level Is Ok
But cannot create the following two folders at once:

C:\Test Folder\Level One Folder\Level Two Folder



WinZip Self-Extractor Personal Edition
Overview
WinZip Self-Extractor Personal Edition is included with WinZip®, under the terms of the WinZip License 
Agreement.    It makes it easy to create files that unzip themselves.    The following information applies to 
both WinZip Self-Extractor Personal Edition and to WinZip Self-Extractor 2.2, a separately available extra 
charge companion product.
What is a Self-Extracting Zip File?
A self-extracting Zip file is an executable program file (.EXE file) that includes a Zip file and software to 
extract or “unzip” the contents of the Zip file.    Users can run (execute) a self-extracting Zip file just as 
they run any other program.
When a self-extracting Zip file created by WinZip Self-Extractor Personal Edition is run, a dialog box is 
displayed.    This dialog box makes it easy for the user to change the “Unzip to” folder before starting the 
extract or “unzip” operation.
Self-extracting Zip files created by WinZip Self-Extractor are 100% compatible with the Zip 2.0 file format, 
so they can be unzipped by a standard unzip utility like WinZip.
What are the advantages to Self-Extracting Zip Files?
Users can extract or “unzip” files from a self-extracting Zip file without running a separate unzip utility or 
knowing how to use an unzip utility.    Thus, self-extracting Zip files are particularly suited for distribution of
software to beginning users who are not familiar with the concept of Zip files.
Self-extracting Zip files created by WinZip Self-Extractor are native Windows programs so they are easy 
to use.
How Does it Work?
There are two parts to the process:

· The WinZip Self-Extractor program creates self-extracting Zip files.
· When WinZip Self-Extractor creates a self-extracting Zip file it includes part of itself in the self-

extracting Zip file.    The part of WinZip Self-Extractor included in the self-extracting Zip file is what
makes it possible to unzip the files by simply running the self-extracting Zip file.

The person who creates the self-extracting Zip file runs WinZip Self-Extractor once, specifying the name 
of the Zip file.    The resulting self-extracting Zip file can be distributed to many people, and will unzip itself
when it is run.

Related Topics:
WinZip Self-Extractor Personal Edition - Operation
WinZip Self-Extractor 2.2



WinZip Self-Extractor Personal Edition - Operation
To make a self-extracting Zip file, you must start with a normal Zip file (.zip extension) that you have 
created with WinZip®, downloaded, etc.    Then you can either

· open the file with WinZip and choose Make .Exe File from WinZip's Actions menu, or
· right click the Zip file in My Computer or Windows Explorer and choose Create Self-Extractor 

(.Exe) from the WinZip Explorer context menu.
Either of these actions will activate WinZip Self-Extractor Personal Edition unless you have specified a 
different program in the Make Exe field in the Program Locations tab of the Configuration Dialog Box.    
If you chose to create a WinZip Self-Extractor Personal Edition icon while installing WinZip, you can also 
start the program by double clicking on this icon.
WinZip Self-Extractor Personal Edition dialog box contains the following fields:
Create self-extracting Zip file from

The name of the standard (not self-extracting) Zip file to turn into a self-extracting Zip file.
Default “Unzip To” folder

The default target folder for the unzip operation.    If left blank the folder specified by the user's 
TEMP= environment variable is used.

Spanning Support
Removable disks such as diskettes have very limited storage capacity. Sometimes, self-extracting
Zip files you create will not fit onto a single diskette.    In this case, you can ask WinZip Self-
Extractor to save one Zip file across multiple diskettes.    This process of creating a Zip file that 
occupies multiple disks is called “spanning”.
When you span Zip files across multiple disks using WinZip Self-Extractor, no special software is 
required during extraction.    Your users are simply prompted to insert any additional disks in the 
multiple volume set at the appropriate time during extraction.
The following choices determine whether you want to make use of the spanning feature to create 
a single Self-Extractor on more than one removable disk, and which method to use.
· No Spanning - WinZip will not create a .EXE that spans removable disks.
· Safe spanning method - Selecting the Safe method causes WinZip Self-Extractor to put two 

files onto the first disk: a Zip file with the first portion of your compressed data, and a 
small .EXE file with the executable code that is required to extract your data. The second and
subsequent disks contain Zip files with the remaining portions of your compressed data. The 
Safe method is the default, and recommended, method.

· Old spanning method - In contrast, the Old spanning method puts a .EXE file on the first 
disk that contains both the executable code used to extract the compressed data and the first 
portion of that data. The second and subsequent disks contain the remaining portions of your 
compressed data in files that (even though they don't actually contain any executable code) 
have an extension of EXE. This is potentially dangerous because, if a user inadvertently tries 
to run the EXE file on the second or succeeding disks, random error messages, and even 
system hangs, can occur.

Note: The WinZip Self-Extractor cannot make use of unformatted disks.    All of the disks that you 
use with WinZip Self Extractor must already be formatted.

Overwrite by default
This check box determines if the “Overwrite files without prompting” option in the self-extracting 
Zip file's dialog box should be checked by default.

Click OK to create the self-extracting Zip file.    Be sure to test the self-extracting Zip file before distributing
it.



Related Topics:
WinZip Self-Extractor Personal Edition - Overview
WinZip Self-Extractor 2.2



WinZip Self-Extractor 2.2
WinZip Self-Extractor Personal Edition is included with WinZip®, under the terms of the WinZip License 
Agreement.    WinZip Self-Extractor 2.2, a $49 companion product to WinZip, includes the following 
features not available in the Personal Edition:

· Features to automate and customize software installation, such as the ability to specify an icon 
and text for the main self-extractor dialog box, and to delete temporary files after running a setup 
program.    It includes support for the InstallShield 3.0 SETUP program.

· Ability to run a command when the unzip operation completes.
· Self-extracting files can be created from the command line.
· All versions can be created with English or German messages.
· Ability to automatically extract files when the EXE file is run.
· A Wizard to simplify the process of building self-extracting files.

Click here for information on obtaining WinZip Self-Extractor 2.2.

Related Topics:
WinZip Self-Extractor Personal Edition - Overview
WinZip Self-Extractor Personal Edition - Operation



Obtaining WinZip Self-Extractor 2.2
WinZip Self-Extractor 2.2 costs $49 for a license to create an unlimited number of re-distributable self-
extracting Zip files on a single machine. Click here for information on the differences between WinZip 
Self-Extractor 2.2 and the Personal Edition included with WinZip®.
You can order WinZip Self-Extractor 2.2 online via the WinZip Self-Extractor Ordering Information web 
page at http://www.winzip.com/orderse.htm.
You can also order WinZip Self-Extractor 2.2 by sending a check for $49 to WinZip Computing, Inc. at 
P.O. Box 540, Mansfield, CT 06268, USA. All payments must be in US funds drawn on a US bank. 
Shipping by postal mail is included in the $49 price. Be sure to include your name and your organization 
name.
Phone orders for WinZip Self-Extractor 2.2 can be placed through DigiBuy, a credit card ordering service. 
You can reach DigiBuy at 1-877-724-4600 (toll free; U.S. only) or 1-952-253-8488.
You can download a fully functional evaluation version of WinZip Self-Extractor 2.2 from the WinZip 
Self-Extractor web page at http://www.winzip.com/winzipse.htm.



Double Clicking
Double clicking on a filename listed in the main WinZip® window will perform the same action performed 
when you double click on a file in My Computer or Windows Explorer.    If the file is executable (has a 
filename extension of EXE, COM, BAT, or PIF), WinZip will run it.    Otherwise WinZip will open the file 
with the appropriate application.    For example, files with a filename extension of .TXT are opened by the 
Windows Notepad application (unless you have changed the TXT association).    The appropriate 
application is determined via Windows Associations.    If no application is associated with the file, WinZip 
will run the program specified as the Default association in the Program Locations tab of the 
Configuration Dialog Box.    If you modify the file while viewing it, WinZip will offer to add the modified file 
to the archive.
If the Smart DOC file handling option in the Miscellaneous tab of the Configuration Dialog Box is 
enabled and you double click on a file with a file type of .DOC, WinZip will run one of two programs:

· If the .DOC file looks like plain ASCII text WinZip will run the program specified as the Default 
association in the Program Locations tab of the Configuration dialog box.

· If the .DOC file looks like a file created by a word processor WinZip will run the program 
associated with .DOC files.

Smart DOC file handling avoids the overhead of loading a word processor such as Microsoft Word when 
viewing ASCII text files like “readme.doc”.    Note that Smart DOC file handling is used for double clicked 
files only; it is not used when you right click on a .DOC file and choose Open from the context menu.    In 
that case, WinZip uses the same program to open the document that Windows Explorer would; for most 
users, this will be Microsoft Word or another word processor.
Note: Pressing the Enter key performs the same action as double clicking.    Single clicking also performs 
the same action as double clicking if you have: 

· chosen Single click to open a file in the View tab of the Configuration dialog, or
· enabled "Single click to open an item" in your system settings, and you have chosen Use current

system folder settings in the View tab of the Configuration dialog.



File Properties
The File Properties dialog box is displayed when you select Properties from the right click context menu 
for files listed in the main WinZip® window.    This dialog box lists the following information: Name, Type, 
File size, Packed Size, Ratio, Modified (last modification date/time), Path, and CRC. This feature is 
particularly helpful when you have elected not to display some of these values in the View tab of the 
Configuration dialog box.



Windows Associations
Windows associations
Microsoft has defined the word “associate” as follows:
To identify a filename extension as belonging to a certain application, so that when you open any file with 
that extension, the correct application is opened automatically.
For example, by default, Windows associates .WRI files with the Write or WordPad application, and .TXT 
files with the NOTEPAD application.    Most Windows application installation procedures create 
associations. For example, Word for Windows creates an association for .DOC files, while WinZip 
generally creates associations for files with the extensions ZIP, LZH, ARJ, ARC, CAB, TAR, TGZ, TAZ, 
TZ, GZ, Z, UU, UUE, XXE, B64, HQX, BHX, MIM.
WinZip® uses associations when you Double Click on a filename listed in the main WinZip window and 
when you use the CheckOut Feature.
WinZip, My Computer, and Windows Explorer all use associations the same way.    When you open a file 
with an association, the application associated with the file is run, and the application automatically opens
the file.    WinZip's CheckOut facility establishes associations when it creates the CheckOut window for 
two reasons: to display the right icon for each file and to ensure that the appropriate application is run 
when you double click an icon.
You can view, add, and remove Windows associations using My Computer or Windows Explorer.    
Choose Options from the View pull-down menu (Tools in Windows 2000) in My Computer or Windows 
Explorer, and then click the File Types tab.    Press the F1 key for detailed instructions.
WinZip associations
You can easily review and modify the types of archives with which WinZip is associated from within 
WinZip.    When an archive type is associated with WinZip, Windows will use WinZip to open files of that 
type.
To view and modify WinZip associations, choose Configuration from the Options menu, click the 
System tab, and click the Associations button.    In the dialog that follows, you will see a list of archive 
types.    You can specify whether an archive type should be associated with WinZip by checking or 
unchecking the checkbox next to the archive type.



Zip and E-Mail Plus
The Zip and E-Mail Plus dialog allows you to specify the filename to be used for a Zip file that WinZip 
creates and attaches to the new e-mail message.    It also allows you to specify a password if desired.
To use Zip and E-Mail Plus, simply select files or folders in a My Computer or Windows Explorer window, 
right click on any selected item, and choose Zip and E-Mail Plus from the WinZip Explorer context menu.
When the dialog appears:

1. Choose the name to be used for the Zip file.    You can accept the suggested name, or you can 
specify a name of your own by clicking Use this name and typing in the desired name.    Don't 
specify a folder name, because the Zip file is temporary and will be created in a temporary folder.

2. Check the Password protect Zip file checkbox if you want to add password protection to the Zip
file.

3. Click OK.
If you've chosen to password protect the Zip file, a second dialog will appear that allows you to specify the
password.    Then WinZip compresses the selected items into a temporary Zip file, creates a new e-mail 
message, and attaches the temporary Zip file to the message.    You can address the message, add any 
desired text, and send it as you normally would.    WinZip automatically deletes the temporary Zip file 
when it is no longer needed.



Zip and E-Mail Plus password
WinZip® uses the industry standard Zip 2.0 encryption format.    Password protecting files in a Zip file 
provides a measure of protection against casual users who don't have the password and are trying to 
determine the contents of your files.    The Zip 2.0 encryption format, however, is not as secure as DES 
and the RSA public key formats used by programs such as PGP, and does not provide absolute 
protection against determined individuals with advanced cryptographic tools.
Note: there are two reasons why WinZip does not implement a more secure encryption format:    (1) a 
different format would not be compatible with the Zip 2.0 standard, so other Zip utilities would not be able 
to decrypt the files, and (2) there are currently severe U.S. government restrictions on the export of 
encryption technology.    If you require strong encryption, we recommend you use a specialized encryption
software instead of the Zip 2.0 encryption format.
In the Zip and E-Mail Plus password dialog, use the Mask password checkbox to control whether the 
password is hidden while typed.    If you check this option, you will have to re-type the password for 
confirmation (to avoid typographical errors).
Be sure to remember any passwords you use, so that you can extract your files!



Multiple Disk Spanning
WinZip® makes it easy to create Zip files that “span” multiple disks.    This is useful if the files you are 
working with will not fit on one disk.
To make a Zip file that spans multiple disks, simply create a Zip file on a removable disk, then add files to 
the Zip as you normally would.    If the disk fills during Add operation, you will be prompted for another 
disk.    Simply insert the next disk and click the OK button.
Important: disk spanning is not available when adding files to an existing archive; it is only available 
while creating a new archive.    Also note that you cannot add or remove files from a Zip file that spans 
disks.    WinZip requires pre-formatted disks (you can format disks using My Computer or Windows 
Explorer).
Example:
To zip the files in your c:\data folder to a Zip file called A:\DATA.ZIP:

1. Start WinZip.
2. Drag and drop the c:\data folder from My Computer or Windows Explorer to the WinZip window.
3. In the Add dialog box, type the filename of the Zip file (A:\DATA.ZIP).
4. Click the Add button.

If more than one disk is needed, you will be prompted for additional disks.
See also
Split Zip files



Invalid split size
The size specified in the Other size field is invalid:

· It is an invalid number, or
· it is too small (less than 65,536 bytes or 64KB), or
· it contains a decimal point, or
· it is a very large number.



Split Zip file compatibility information
The file format used by WinZip® to create split Zip files is an extension to the Zip 2.0 standard.    As a 
result, some Zip utility programs may not be able to open split Zip files.
However, the only differences between split Zip files and spanned Zip files, which are supported by most 
Zip products, are the names and the locations of the parts of the file:

· Each part of a split Zip file has a different extension (name.Z01, name.Z02, etc., and name.zip for
the last part).    All parts of a spanned Zip file have the same name (name.zip).

· The parts of a split Zip file can all be located in the same folder; the parts of a spanned Zip file 
must reside on separate diskettes (because they all have the same name).

Internally, the parts of split Zip files and spanned Zip files are identical.    Therefore, you can convert from 
one format to another if necessary by simply copying and renaming the parts as follows:
To convert a split Zip file to a spanned Zip file

1. Copy each part of the split Zip file to a separate diskette.
2. After copying each part, change the filename extension to .zip.    For example, January.Z01 

becomes January.zip, January.Z02 becomes January.zip, etc.    Only the last part of the split Zip 
file does not have to be renamed, because it already has a .zip extension.

To convert a spanned Zip file to a split Zip file
1. Copy each part of the spanned Zip file, in order, from diskettes to a single folder.    You must know

the correct order of the diskettes in order to do this.
2. As you copy each part, change the .zip extension to .Zn, where n is a sequence number 

beginning with 01 for the first part.    That is, the first part of the spanned Zip file January.zip 
becomes January.Z01; the second part becomes January.Z02, etc.    If there are more than 99 
parts, just continue the numbering with .Z100 and so on.    Don't change the extension of the last 
part--it remains .zip.



Keyboard Usage
WinZip® is easier to use with a mouse, but you can also use the standard Windows keyboard interface.    
Keyboard accelerators defined for WinZip include:
F1 Activate help system
Ctrl+N Create a new archive.
Ctrl+O Open an existing archive.
Shift+F Favorite Folders.
Shift+L Close an archive.
F7 Move an archive.
F8 Copy an archive
Shift+R Rename an archive.
Shift+M Mail an archive.
Shift+A Add files to an archive.
Shift+D Delete files from an archive.
Shift+E Extract files from an archive.
Shift+V View files in an archive.
Ctrl+P Print a listing of files in an archive.
Shift+W Switch to the Wizard interface.
Ctrl+A Select all items in the list box.
Shift+S Run virus scanner.
Shift+T Test an archive.
Shift+U UUencode an archive.
Shift+H Split a Zip file.
Shift+G View, add, or edit a comment.
Shift+K Create a self-extracting archive.
Shift+C Activate the CheckOut feature.
Shift+I Install files in an archive.
Direction key(s) Move the cursor and/or scroll a list.
Shift+direction keys Select multiple items in a list box.
Enter Same as Double Clicking in the main window.
Alt+F4 Exit (terminate) WinZip

What's New in WinZip 8.1
Major changes in Version 8.1
WinZip® 8.1 continues to improve integration with Windows Explorer via expanded, configurable Explorer
context menu items--and you can now select multiple Zip files for extraction in a single operation from the 
Explorer window.    For those who have problems with limited size of e-mail attachments, or who want to 
split up large downloadable Zip files, the new split Zip file feature allows you to split Zip files into multiple 
parts of a size that you specify. And WinZip Quick Pick, the new taskbar tray icon gives you instant 
access to recently opened Zip files and other WinZip features. And Windows XP users will appreciate 
WinZip 8.1's support of new XP features.
Details on these and other enhancements follow.
Enhanced Explorer Integration

· You can now select multiple Zip files in a Windows Explorer window and extract from all of them 



in one operation.
· You can now choose which items WinZip should add to Explorer's context menu for Zip files and 

other archives.    This feature can be accessed directly from the Explorer context menu if WinZip 
is configured to display its context menu items as a submenu; otherwise, it is available from the 
Explorer Enhancements tab of WinZip's Configuration dialog.    (For a complete list of WinZip's 
context menu entries, see Explorer context menu enhancements.)

· There is a new Explorer context menu entry that allows you to print a list of files in a Zip file.    
Note that, because Print is part of the standard Windows interface, it appears in the main context
menu (not in the WinZip submenu) and has no WinZip icon.

· You can now extract directly to recently used folders or to the open folder from the Explorer 
context menu.    This means that, in combination with the existing extract options, you can perform
most of the commonly used extract operations without leaving Explorer.

· The new Zip and E-Mail Plus context menu entry extends the Zip and E-Mail feature by allowing 
you to change the name of the attachment and to use password protection.

Split Zip Files
· WinZip now supports split Zip files, which are Zip files that have been split into multiple smaller 

pieces.    This feature is very useful to overcome limits on the size of e-mail attachments and as 
an alternative to disk spanning.

WinZip Quick Pick Taskbar Tray Icon
· The new WinZip Quick Pick taskbar tray icon gives you instant access to WinZip and your Zip 

files.    Just left click the icon to open WinZip or right click it to instantly reopen recently used Zip 
files, access your Favorite Zip Folders, open WinZip help, or start WinZip itself.

WinZip Classic Interface Enhancements
· The Extract dialog now has an option to open the folder where the files were stored when the 

extract operation is completed.
· Right clicking on a column header in the main WinZip window now displays a menu that allows 

you to change the columns that are displayed.
· Under Windows 98, Windows Me, Windows XP, and Windows 2000, many dialogs that were 

previously fixed size can now be resized.
· If the open archive is a Zip file, the Properties dialog contains a new Details button that displays 

extensive technical information about the Zip file and the files it contains.
· The Open dialog contains a new Favorites button that gives you quick access to the files in your 

Favorite Zip Folders.
WinZip Wizard Enhancements

· If the open Zip file contains a setup or install program, the Wizard now allows you to choose 
whether to run the installation or to simply extract the files.

· In the panel used to select files to be added to a Zip file, the WinZip Wizard now displays a tooltip
showing the complete filename when the mouse is hovered over a truncated filename.

· The Wizard can now extract files from split Zip files and multiple disk ("spanned") Zip files. 
Windows XP features

· When running under Windows XP, WinZip 8.1 operates as a native Windows XP program. There 
is no need to set compatibility mode. 

· WinZip includes the following support for Windows XP themes: 
· Menus, buttons, controls, lists, and checklists conform to the current theme. 
· Shaded columns and XP-style sort arrows indicate the column by which the file list is sorted 

and the sort order. 



· Resizable dialogs use grippers matching the current theme. 
· Both the WinZip program itself and self-extracting Zip files created by WinZip Self-Extractor 

Personal Edition use "highest quality" XP-style color images and background blending for 
WinZip-related icons wherever they are displayed by Windows Explorer or My Computer, as 
well as for WinZip's own toolbar icons. 

· Self-extractors created by WinZip Self-Extractor Personal Edition support XP themes when 
displaying dialogs and messages. 

· Shared computer support includes: 
· With Fast User Switching, another user can log on and perform other operations (including 

using WinZip) while a long WinZip operation is being performed. 
· WinZip's Favorite Folders feature now monitors more folders, including Windows XP's 

"Shared Documents" folder and its subfolders, making it easier to find Zip files created or 
stored by other users. 

Other Changes in WinZip 8.1
· WinZip can now open "skin" files for Microsoft Media Player 7 (.WMZ), Yahoo! Player (.YFS), and 

WinAmp (.WSZ). Once open, you can use most of the operations available with any Zip file.
· WinZip can now display Zip file comments of up to approximately 64,000 characters if your 

system provides the necessary "rich edit" control.
· Support for filenames containing multi-byte character set (MBCS) characters used with Asian 

languages such as Japanese, Chinese, and Korean has been improved.
· The limit on the number of entries created by the CheckOut feature in the Programs menu has 

been increased from 50 to 500.
· WinZip removes from the list of recently used files any files that no longer exist and were opened 

from the temporary or Internet files folders. This means that, for example, Zip files opened from 
your e-mail program no longer appear in your recently used file list after they have been deleted 
by the e-mail program.

· Additional miscellaneous improvements to the WinZip program and help files.
A list of features introduced in earlier versions of WinZip is available from the WinZip web site at 
http://www.winzip.com/version.htm.



Hints and Tips
Here are the hints and tips displayed by the “Tip of the Day” dialog box:

· The Tip of the Day dialog box is normally displayed when you start WinZip®, except when you 
are opening a Zip file.    You can change this behavior so tips are never displayed or always 
displayed when WinZip is started. 

If you turn the Tip of the Day off and later want to see the tips, choose Tip of the Day from 
WinZip's Help menu, then choose from the combo box at the bottom of the dialog.

· If you are new to Zip files, you can use the Wizard interface to walk you through the process of 
zipping and unzipping or installing software from Zip files, MIME files, and other encoded files. 
Choose Wizard from the WinZip File menu to activate the Wizard.

· You can add, remove, or reorder buttons on the WinZip toolbar by right clicking on the toolbar and
choosing Select Buttons.

· WinZip's toolbar buttons look much better if your display is in high- or true-color mode.
Click Control Panel in the Start menu's Settings entry.    Double click Display and choose the 
Settings tab.    Choose High Color or True Color mode for Color Palette (under Windows NT 4.0
choose 65536).

· Learn to use the Windows help system! You will quickly make up for the time you spend learning 
it by being more productive in all your Windows applications. To get started choose How to Use 
Help from the Help menu. 

· For some quick lessons on how to use WinZip's main features, choose Brief     Tutorial   from 
WinZip's Help menu.

· For quick zipping and unzipping, you can right click on a file listed in Windows Explorer and 
choose Add to Zip file or Extract to from Windows Explorer's context menu.

· The WinZip QuickPick taskbar tray icon provides instant access to recently used archives, your 
Favorite Zip Folders, WinZip help, and WinZip itself. Learn about it here.

· For answers to Frequently Asked Questions (FAQs), choose Frequently Asked Questions from 
WinZip's Help menu.

· You can unzip all files from a Zip file without leaving Windows Explorer.    Use the right mouse 
button to drag and drop a Zip file from an Explorer window to any folder, then choose Extract to 
from the context menu. Be sure to use the right mouse button while dragging.

· You can extract from multiple Zip files in one operation.    Simply select two or more Zip files in a 
Windows Explorer or My Computer window, right click one of the files, and choose one of the 
Extract entries in the WinZip context menu.    The best choices for this operation are usually 
Extract to or Extract to here using filenames for folders because both of these entries allow 
you to use a separate folder for each Zip file.    You can use the other choices, however, if you 
want to extract all of the files to a single folder.

· You can create Zip files in Windows Explorer: right click in the Contents pane, then choose New 
and WinZip File.    An empty Zip file will be created in the current folder.

· Mailing your Zip files is easy! If you are using a MAPI-compatible mail system, you can mail Zip 
files using the Mail Archive entry in the WinZip File menu. Or, use the Zip and E-Mail or Zip and
E-Mail Plus features from Windows Explorer's context menu to quickly zip and e-mail any file.

· If you usually use the same folders when opening, extracting, or adding files, choose 
Configuration from WinZip's Options menu and specify the folders in the Folders tab.

· You can run your virus scanner on the files inside downloaded Zip files. Choose Virus Scan from 
WinZip's Actions menu.



· If you need to send files to users who may not have an unzip utility, try “WinZip Self-Extractor 
Personal Edition” (included with WinZip). The self-extractor makes files that unzip themselves. 
First create a Zip file, then choose Make .Exe File from the WinZip Actions menu.

· To change the default WinZip window size and position to the current window size and position, 
choose Save Settings Now from the Options menu.

· To display details about the open Zip file (for example, the date the Zip file was last modified or 
the name of the folder containing the Zip file), click on the WinZip status line or choose 
Properties from the WinZip File menu.

· You can make a Zip file that spans multiple disks.    Simply create a Zip file on a removable disk, 
then add to the Zip file as you normally would.    If the disk fills up while files are being added, you 
will be prompted for another disk.    Just insert the next disk and click the OK button.

· The file listing in the main WinZip window can be quickly sorted by any of the fields displayed in 
the file listing.    Just click on any column title to sort on it.

· You can quickly extract files from a Zip file by dragging the files from WinZip to any folder or 
Windows Explorer window (or even to the desktop).

· You can quickly add files to a Zip file by dragging the files from any folder or Windows Explorer 
window to WinZip.

· WinZip has many features that make it easy to work with files downloaded from the Internet, 
bulletin boards, and online services like America Online and CompuServe.    For a list of hints, see
the section Hints For Working With Downloaded Files

· Besides Zip files, WinZip processes many other formats, including TAR, Z, GZ, TGZ, CAB, 
UUencode, BinHex, and MIME.

· If you can't remember where you put your Zip files, you can use the Favorite Zip Folders feature 
to find them.    Choose Favorite Zip Folders from the WinZip File menu.

· You can easily view files in a Zip file by dragging them to an application or a shortcut to an 
application.

· You can easily print files by dragging them to a printer icon or a shortcut to a printer. (To print a list
of files in a Zip file, choose Print from WinZip's File menu.)

· Zip files opened with WinZip are added to the Start menu's Documents list.    To quickly open Zip 
files that you have recently worked with, choose Documents from the Start menu.
Note: Windows XP does not display Zip files in the Documents submenu. You can use the 
WinZip Quick Pick taskbar tray feature to open recently used archives.

· You can add selected files to a Zip file directly from Windows Explorer with complete control over 
the options. Right click on any file (or selected group of files) and choose Add to Zip file from the
context menu.

· WinZip can install software, desktop themes, and screen savers contained in Zip files.    To use 
this feature, simply open a Zip file containing a software installation (SETUP.EXE or 
INSTALL.EXE), theme, or screen saver and click the Install button.

· To open or view multiple files in an archive contents list, hold down the Ctrl key while clicking the 
files.    Then click the View button on the toolbar to view the files or right click on any selected file 
to display the context menu.

· WinZip displays useful information about Zip files you select in Windows Explorer.    The 
information appears in a tooltip or, if "View as Web Page" is enabled, in the description area of 
the web page.    The Windows Desktop Update (Active Desktop) must be installed and WinZip 
shell extensions enabled in order to use this feature.

· Most of WinZip's major dialogs have "What's This?" help. Click on the question mark in the 
dialog's title bar, then click on a control for quick information about how it's used.

· WinZip can automatically display the Zip comment when you open a Zip file that contains a 



comment.    And, when the open Zip file has a comment, you can click the comment icon on the 
status bar to view and edit the comment.

· If you like the look of Internet Explorer's toolbar, you can have the same look in WinZip.    Choose 
Configuration from WinZip's Options menu, click the Toolbar tab, and check Use Explorer-
style toolbar buttons and Use flat toolbar buttons.    Clear the Use large toolbar buttons 
checkbox if you'd also prefer smaller buttons.

Related Topics:
More Hints and Tips
Hints For Working With Downloaded Files
Using the Explorer Interface
Frequently Asked Questions (FAQs)



More Hints and Tips
Here are more Hints and Tips:

· To switch to another program during an archive operation, click on the window for the other 
program, or hold down the Alt key and press the Tab key repeatedly until the program's icon is 
selected.    Note: you cannot use the WinZip® system menu or minimize button during archive 
operations.    However, you can minimize WinZip by checking Display status dialog for long 
operations in Miscellaneous configuration and clicking the dialog's minimize button.

· You can move or copy files from one archive to another by opening multiple WinZip windows, one
for each archive, and dragging files from one to the other.    Note that you need to turn off the 
Reuse WinZip Windows entry in the Options pull-down menu in order to start multiple WinZip 
windows.

Long Filename Tips
· The current versions of most optional external archivers used by WinZip are DOS programs and 

do not support long filenames.    Therefore, WinZip will pass the short 8.3 version of all long file 
and folder names to these external programs.    Since normal 8.3 names are usually more 
meaningful than the shortened versions of long filenames, it is recommended you use standard 
8.3 filenames when working with external archivers.

· The exception is ARJ 2.60 and 2.7x, which support long filenames when running under Windows 
95, 98, or Me (but not under Windows NT, 2000, or XP).    If WinZip detects that you are using 
ARJ 2.60 or 2.7x and you are using Windows 95, 98, or Me, it will pass long filenames to ARJ.

· MS-DOS programs (other than ARJ 2.60 and 2.7x) and 16-bit Windows programs usually have 
trouble with long filenames and files with spaces in the name.    Therefore, it is recommended that
you do not use long filenames and files with spaces in the name if you plan to work with these 
files from DOS.    For example, LHA.EXE will extract the file “A Long Filename” as “A LONG F", 
ignoring the extra characters.    To avoid this problem check the Store filenames in 8.3 format 
checkbox in the Add dialog box when adding files.

Related Topics:
Hints and Tips
Hints For Working With Downloaded Files
Using the Explorer Interface
Frequently Asked Questions (FAQs)



Hints for Working with Downloaded Files
WinZip® makes it easy to work with files downloaded from Internet, bulletin boards, and online services 
like America Online and CompuServe.

· The WinZip Internet Browser Support Add-On adds features to work hand in hand with Netscape 
Navigator/Communicator or Microsoft Internet Explorer.

· The Install feature makes it easy to install most software distributed in Zip files: if a Zip file 
contains a “setup” or “install” program, a desktop theme, or a screen saver, WinZip will unzip the 
files, run the installation program if present, and clean up temporary files.    If the Zip file does not 
contain any of these, you can use the CheckOut Feature to try the downloaded file.

· The Favorite Zip Folders feature makes locating Zip files you want to open much easier.
· The Downloading and Processing Files with WinZip topic provides further hints, tips, and helpful 

procedures.
· The Archive Management features make it easy to move archives to floppies, or to delete them if 

they don't meet your needs.
To print this page, click on Print Topic in the Help window's File pull-down menu.
One strategy for handling downloaded files involves three folders:

\DOWNLOAD Recently downloaded files
\UPLOAD Files you are planning to upload
\ARCHIVES Archives you are planning to keep

A relatively empty download folder makes it much easier to stay organized.    It is a good idea to download
all archives into your \DOWNLOAD folder, and after each on-line session perform the following steps for 
each archive:

1. Open the archive.    An easy way to open files is to first open the \DOWNLOAD folder in My 
Computer or Windows Explorer.    Then double click on an archive to open it.    You will probably 
want to click on the Modified column header in My Computer or Windows Explorer so that the 
most recent files are shown at the top of the list.

2. Read about the software in the archive.    Many archives contain a file named “file_id.diz”.    By 
convention this file contains a brief description of the archive contents.    If this file is listed in the 
main WinZip window, double click on it to view its contents.    When you are done viewing the file, 
close the program being used to view the file.    Repeat this process for any files with the word 
“read” in the filename (e.g. “readme.txt” or “read.me").

3. Try the software if the archive looks interesting.    One easy way to do this is with the Install or 
CheckOut buttons on WinZip's toolbar.    If the archive contains an “install” or “setup” program, a 
desktop theme, or a screen saver, the Install button will be displayed,    otherwise, it will contain 
the CheckOut button. Note: downloaded software should always be scanned for viruses 
before you install or use it. If you download archives containing software, you should obtain a 
reliable virus scanner, keep it up to date, and always use it on the contents of such downloaded 
archives. See the section titled Virus Scanner Configuration for information on configuring WinZip 
to use your virus scanner to test the contents of archives for virus infection.

4. Move each archive out of your download folder after trying the software.    If you want to keep the 
archive on your hard disk select Move Archive from the File pull-down menu to move the archive
into your \ARCHIVES folder, or, if you want to post the archive on another BBS, move it into your \
UPLOAD folder.    Note that the folders you have most recently used for move and copy 
operations are available for quick access in a drop-down list.    If you don't want to keep the file 
you downloaded you can easily move it to a floppy or delete it using the Delete Archive entry in 
the File pull-down menu.

Of course, these are just suggestions. There are other good ways to use WinZip to work with downloaded



files. Feel free to use whatever method works best for you.

Related Topics:
Hints and Tips
More Hints and Tips 
Using the Explorer Interface
Frequently Asked Questions (FAQs)



Frequently Asked Questions
For more complete and up-to-date FAQs, please visit the WinZip® web site.
Basic
How do I get started?

Technical
How do I use disk spanning?
How do I compress a folder and later restore it?
How do I view graphic/spreadsheet/word processing files in an archive?
How do I use WinZip to e-mail archives?
Why aren't WinZip's e-mail features working for me?

Non-technical
How do I purchase WinZip?
Do you keep track of address changes?

Related Topics:
Hints and Tips
More Hints and Tips
Hints For Working With Downloaded Files
Using the Explorer Interface



Fixing Zip Files
If a Zip file is damaged it can sometimes be repaired with the PKZIPFIX command.    PKZIPFIX is not part
of WinZip®; it is part of the MS-DOS text mode Zip utility PKZIPâ 2.04g from PKWAREâ, Inc. This utility 
is available on many ftp and download sites as PK204G.EXE.    If you download and install this file, you 
can run PKZIPFIX by simply typing

PKZIPFIX filename
at the DOS prompt, and PKZIPFIX will create the “fixed” file PKFIXED.ZIP.



Message WZ11
A required file was not found.
The file listed in the dialog box was not found in your path or the specified location.    Also, WINZIP.HLP, 
WZ32.DLL, WZVINFO.DLL, WZINST.HLP, WZWIZARD.HLP, WZ.COM, and WZ.PIF must be in the same 
folder as WINZIP32.EXE.    The Installation section describes the complete installation procedure.



Message WZ13
This dialog box is displayed if a filename is invalid or if WinZip® was unable to open the specified archive 
or read the archive folder.    It is possible that the file is not an archive or does not exist.    Alternately, it is 
possible that the archive has been corrupted.    Other reasons for this error include insufficient memory 
and disk errors while reading the archive.
If you are working with a Zip file, you can try repairing the file as described in the section Fixing Zip Files.



Register WinZip
If you paid the WinZip registration fee:
If you paid the WinZip® registration fee and received a registration number from WinZip Computing, Inc. 
or an authorized reseller, please enter your name and registration number exactly as they appeared on 
the instructions you received when you registered WinZip.    You cannot substitute a different spelling 
for your name or use a different name.    If entered correctly, your name will appear in the About dialog 
box, and the registration reminder dialog box will no longer be displayed when you start WinZip.    Please 
save this information for possible use with future upgrades, or in case you re-install WinZip.
Note: if your name is spelled incorrectly in the instructions, please write to the address in the About dialog 
box with the correct spelling, and you will receive a new registration number.
If you have not yet paid the WinZip registration fee:
If you downloaded an evaluation version of WinZip, or if you received this version of WinZip on a CD with 
a book or with other hardware or software, and you have not paid the WinZip registration fee, you are 
licensed to use WinZip for evaluation purposes only, subject to the Evaluation License.
For information on purchasing a license to use WinZip for non-evaluation purposes, see the section 
Ordering Information.



Internal Error
This dialog box is displayed when an unexpected WinZip® internal error occurs.    Please contact WinZip 
Computing, Inc. with as much information about the error as possible.    For a list of contact points, choose
About from WinZip's Help pull-down menu.



Message WZ14
This dialog box is displayed when a required edit field is empty or no entries are selected in a list box.    
For example, it is displayed if you don't specify which file you want to delete in the Delete dialog box.    
Specify the required information and try again.



File already exists
To view a file, WinZip® normally extracts the file to disk, reads it, and erases the temporary disk file.    
WinZip determines which disk to extract to by checking the value of the WZTMP=, TMP=, TEMP=, and 
PKTMP= environment variables.    To conserve space on the DOS command line, WinZip creates 
temporary files in the root folder of the specified drive.    If none of these environment variables is set, 
WinZip extracts to the root folder of your C: drive.
The message The disk file “filename” already exists.    Should WinZip overwrite it so that the file in the 
archive can be viewed? is issued if a file with the requested name already exists on disk.    If you choose 
Yes, the existing disk file will be overwritten, and processing will continue.    If you select No, WinZip will 
cancel the view operation for this file.



Warning WZ16
This dialog box is displayed if WinZip® cannot display the entire file you are viewing because it contains 
binary zeros.    WinZip uses a standard multi-line edit field to display files, and these controls truncate text 
at the first binary zero.



Message WZ8
This dialog box is displayed if an external command (for example, LHA or ARJ)    is over 127 characters 
long (the longest command allowed under MS-DOS is 127 characters).    The total command line length 
includes several components used internally by WinZip® in addition to the external command.    There are
a few ways to reduce the length of the command line:

· Move WINZIP32.EXE (and the related files) to a folder near the root folder (for example, a folder 
like C:\WINZIP is better than C:\WINDOWS\UTILITY\SHAREWAR\WINZIP).

· Move the archive you are working with to a folder near the root folder.
· Move ARJ.EXE, LHA.EXE, SCAN.EXE, etc. to a folder specified by your PATH= environment 

variable and remove any folder names for these programs in the Program Locations configuration
dialog.

· If you are adding, deleting, extracting, or viewing multiple files at one time, specify them via a list 
box rather than an edit field.    This causes WinZip to create an ARJ or LHA response file, which 
usually takes less room on the command line than multiple file names.



Text Successfully Copied To Clipboard
This dialog box is displayed to let you know the text in the View dialog box has been copied to the system
clipboard.    You can paste the text into another application (for example, Notepad) by choosing Paste 
from the application's Edit pull-down menu.



Message WZ18
This dialog box is displayed when WinZip® could not create a required temporary file on the disk drive 
listed in the dialog box.    Possible causes are that the disk drive is invalid, or that the root folder of the 
disk is full.
WinZip determines which disk to use for temporary files by checking the values of the WZTMP=, TMP=, 
TEMP=, and PKTMP= environment variables.    To conserve space on the DOS command line, WinZip 
creates temporary files in the root folder of the specified drive.    If none of these environment variables is 
set, WinZip creates temporary files on your C: drive.



Message WZ19
When working with format files the “action” operation requires the program external program.    This 
program is not installed or improperly installed.
This message is issued when the external program “program” required for the “action” operation is either 
not installed, or is installed in a folder other than the one specified in the Program Locations configuration 
dialog.    If the specified program is installed, choose Configuration from the WinZip® Options menu, 
click the Program Locations tab, and specify the correct path information.    If you do not have a copy of 
the specified program, see System Requirements for information on obtaining the program.



Message WZ20
The program required to perform the function you selected is either not installed, or is installed in a folder 
other than the one specified in the Program Locations configuration dialog (choose Configuration from 
the Options menu, click the Program Locations tab).
For a complete list of supported external programs and information on obtaining and installing these 
programs see System Requirements and Installing Optional External Programs.
For example, this problem can occur if you try to extract files from an ARC file, but have not specified an 
ARC extraction program in the Program Locations configuration dialog.



Message WZ21
WinZip® can't find one of the programs specified in the active dialog box.    If you specified a folder (for 
example, you entered C:\UTILITY\LHA.EXE), then WinZip can't find the program in that folder.    If you did 
not specify a folder (for example, you entered LHA.EXE) then WinZip can't find the program in any of the 
folders specified by your PATH= environment variable.    
Note: if you update the PATH statement in your AUTOEXEC.BAT, the changes will not take effect until you
reboot your machine.



Message WZ22
WinZip® does not recognize the name of the specified program.    For example, you will get this error if 
you specify XYZ.EXE as the name for LHA.EXE.    WinZip lets you specify the drive and folder containing 
the program, but prevents the use of unsupported file names to prevent unexpected errors.



Message WZ23
An external program returned a non-zero error level.    Consult the documentation for the external 
program for the meaning of the error, and/or use the View Last Output entry in the Options pull-down 
menu to check for error messages issued by the external program.
Note:
One likely cause for this error is using an old version of external programs. See System Requirements for 
version information.



Delete Entire Archive
This dialog box is displayed to give you a chance to confirm that you really want to delete the entire 
archive.    Select No to cancel the operation or Yes to delete the archive.



CheckOut Delete
This dialog box is displayed before closing an archive to give you a chance to have WinZip® delete the 
CheckOut folder and associated entries in the Programs menu.    Select Yes to delete these items and 
close the archive.    Select No to leave the CheckOut folder and Programs menu entries intact and close 
the archive.    Select Cancel to cancel the close operation.



Message WZ24
WinZip® does not provide facilities to create files in the CAB, Microsoft compressed, ARC, BinHex, MIME,
TAR, gzip, z, WMZ, WSZ, or YFS formats; however, you can open an existing archive in these formats 
and extract, run, or view the files inside these types of archives.    You can create UUencoded files using 
the UUencode entry from the Actions menu.



Message WZ25
This dialog box is displayed when WinZip® cannot run a program.    This can happen when a program 
specified as a Windows Association was deleted from your system or was moved to a different drive or 
folder.    The following are the error codes Microsoft has documented:

0 Out of memory
1 File not found
2 File not found
3 Path not found 
4 Too many files open
5 Attempt to dynamically link to a task
6 Library requires separate data segments for each task
8 Insufficient memory to start application
10 Incorrect Windows version
11 Invalid .EXE file (non-Windows .EXE or error in .EXE image)
12 OS/2 application
13 DOS 4.0 application
14 Unknown .EXE type 
15 Attempt in protected (Standard or 386 Enhanced) mode to load an .EXE created for 

an earlier version of Windows
16 Attempt to load a second instance of an .EXE containing multiple, writeable data 

segments
19 Attempt was made to load a compressed executable file. The file must be 

decompressed before it can be loaded.
20 Dynamic-link library (DLL) file was invalid. One of the DLLs required to run this 

application was corrupt.
21 Application requires Microsoft Windows 32-bit extensions
26 File sharing error
27 Incomplete association for file type in system registry
28 Dynamic Data Exchange (DDE) timeout
29 Dynamic Data Exchange (DDE) failure
30 Dynamic Data Exchange (DDE) is busy
31 No association found for file type in system registry
32 A dynamic-link library (DLL) required by the program could not be found

Message WZ26
WinZip® encountered an error trying to view a file.    Possible errors include insufficient memory and disk 
errors.



Message WZ27
An incomplete filename was entered.    If either a drive or folder is specified, then both must be specified.   
For example, the following two filenames are incomplete:

C:LHA.EXE
\UTILITY\LHA.EXE

In the first example, a drive is specified but no folder is specified.    This can cause unexpected errors if 
you change the current folder on the C: drive.    
In the second example, a folder is specified but no drive is specified.    This can cause unexpected errors 
if you change the current drive.
Specify a filename like C:\UTILITY\LHA.EXE instead.    Note that if the file is in a folder specified by your 
PATH= environment variable you do NOT need to enter a drive and folder.



Warning WZ28
You used the Drag and Drop Interface to drop multiple files onto a WinZip® window or icon, and at least 
one of these files had an extension of ZIP, LZH, ARJ, or ARC.    Press Yes to add these files to the open 
archive.



Message WZ30
WinZip® could not change to the specified folder, so it is closing the open archive.    Possible causes for 
this error include removing the folder or changing disks in the middle of a WinZip operation.



Message WZ31
An unexpected system error was encountered trying to run the specified DOS command.    This problem 
is usually caused by a system configuration problem or using buggy video drivers, including “beta test” 
video drivers.
If you encounter this error message and are not using a Microsoft-supplied video driver, try installing the 
VGA driver distributed with Windows to determine if the problem is caused by a video driver.



Overwrite?
The specified file already exists on disk.    Choose Yes to overwrite the file or Yes to All to overwrite this 
file and avoid this prompt for all other files during this operation.    Choose No to bypass this file and 
continue the operation, or Cancel if you want to cancel extraction of all remaining files.



File has been changed
WinZip® detected that you modified a file while viewing it.    Choose Yes to add the modified file to the 
archive or No if you don't want to update the archive.



Warning WZ35
The original file included folder information, but no folder information was included when the file was 
added to the archive.    Thus, both the original and the new file are included in the archive.



Missing File
A required file, the name of which is shown in the dialog box, could not be found.    You may need to re-
install WinZip®.    See WinZip Installation for information about installing WinZip.



Delete Temporary File?
Choose Yes to delete the temporary file or No if you want to keep it.    Note that the file resides in a 
“temporary” folder specified by your WZTMP=, TMP=, TEMP=, and PKTMP= environment variables, so 
you should probably move the file to a “permanent” folder if you really want to keep it.



Message WZ38
WinZip® cannot accept dropped files while the Add dialog box is active as the result of dragging and 
dropping files.    Close the Add dialog box before dropping more files on WinZip.



Message WZ39
WinZip® requires ARJ 2.50, 2.60, or 2.7x. Please obtain a newer version of ARJ.    See System 
Requirements for information on obtaining the most recent version of ARJ.



Message WZ40
The Zip file cannot be opened.    If this Zip file is part of a multiple-disk set, please insert the last disk of 
the set and try again (this is required by the standard Zip multi-disk format).    You may subsequently be 
prompted to insert other disks from the set.
If you downloaded this file, the most likely cause of this problem is a bad download.    The best solution is 
almost always to download the file again.    If this does not solve the problem, see the web page 
http://www.winzip.com/downprob.htm for hints on resolving download problems.
If you did not download this file, and it is not part of a multiple-disk set, it is either not a valid Zip file or it is
corrupt, perhaps because of a bad diskette.



Message WZ44
An invalid CheckOut folder was specified.    You cannot specify a root folder (e.g. C:\), and you must 
specify a drive letter (e.g. C:\CHECKOUT, not just CHECKOUT).    The CheckOut folder cannot be the 
folder containing the open archive because all files in the CheckOut folder are deleted at the beginning of 
the CheckOut operation.



Message WZ47
WinZip® could not create the specified folder.    Possible causes are:

· A file exists with the same name as the folder
· Disk is read-only
· Folders preceding the final folder do not exist.    For example, to create the folder “C:\UTILITY\

FILES” the folder “C:\UTILITY” must exist.
Solution: specify a different folder name.



Message WZ48
Due to a limitation in Windows, it is impossible to remove a Program Group while closing Windows.    
Thus, if you want to remove Program Groups created by WinZip®, you need to close WinZip before 
shutting down Windows.



Message WZ50
An error occurred opening, writing to, closing, or deleting the specified file.    Possible causes include a 
misspelled filename, a full disk, a read-only or locked disk, or a read-only or locked file.    The operation in 
progress will be cancelled.    Another dialog box with more specific information may be displayed.
This message may also be displayed because of an invalid archive.    For example, if an archive is 
damaged (possibly due to line noise while downloading from an online service) it may contain invalid 
data.



Message WZ51
The open archive no longer exists on disk.    It was probably deleted by another task.



Message WZ52
Nothing To Do: no files were found for the specified action.    Examples of when this message is issued 
include attempts to add a non-existent folder to an archive and attempts to freshen an archive that is 
already up to date.



Message WZ53
An invalid archive operation was initiated.    For example, an attempt to add the same file from two 
different folders can cause this error.    Check the warning messages for additional details about the 
problem.



Message WZ54
This error occurred during internal Zip processing.    Correct the error and retry the operation.



Message WZ55
WinZip® could not access the correct version of the specified DLL.    It is possible that the DLL from a 
previous version of WinZip is still loaded, or that the wrong version of the DLL is in the WinZip folder.    To 
solve this problem follow both of these steps:

1. Verify that the DLL in your WinZip folder has the same date as WINZIP.EXE or WINZIP32.EXE.    
If not, reload all WinZip related files from the distribution CD.    DO NOT use WinZip to extract files
from the online distribution version of WinZip to the folder from which you are running WinZip, 
since that can cause unpredictable results.

2. Exit Windows and then run WinZip again.    Closing Windows ensures that old versions of the DLL
are not loaded.



Message WZ57
There is insufficient free memory (RAM) on your system.    Close one or more other applications and retry 
the operation.



Warning WZ58
One or more warning messages were issued.    Press the Yes button to view all messages issued while 
processing the last action, including informational and warning messages.



Extract error
One or more errors occurred while WinZip was processing your extract request.    Click View Output to 
see all messages issued while extracting, including informational and warning messages.



Virus Scan Complete
This message is issued when a Windows-based virus scanning operation completes.    If no error or 
warning dialog boxes were displayed by the virus scanner, then this dialog box indicates that no viruses 
were found.    The Norton AntiVirus scanner, the McAfee VirusScan program, and any other properly 
configured virus scanner will display error or warning dialog boxes if a virus is found.



Message WZ62
WinZip® could not copy, delete, rename, or move the file.    Possible causes include: the file is read-only, 
the file is open by another process, or the file has already been deleted by another process.



Message WZ64
WinZip® uses the standard Windows “Common Dialog Boxes” as a basis for the Add dialog box.    Due to 
a limit in the Common Dialog Boxes the total length of all selected files cannot exceed 2000 characters.    
You have exceeded or may exceed this limit.    You can circumvent this limit by using the Drag and Drop 
interface to add files instead of the Add dialog box, or by specifying wildcards in the File name field in the 
Add dialog box (for example, *.c).



Message WZ65
WinZip® could not make the specified folder the current folder.    Probable cause: invalid or non-existing 
folder name.



Message WZ66
The temporary folder must be a fully qualified path.    You must specify both the drive and folder, for 
example, C:\TEMP or C:\WINDOWS\TEMP.    If you don't know the location of your temporary folder, click
Cancel.



Operation Interrupted
The archive operation was interrupted because you pressed a key or clicked on the WinZip® window 
during the archive operation.    Press the Continue button to continue the operation or the Stop button to 
terminate the operation.
This message will be displayed if you try to minimize WinZip during an archive operation.    To switch to 
other tasks you can click on another window or use the Windows taskbar.



File Is In Use
A file can be “in use” for one of two reasons:

· The file is open by another process.    For example, a document might be open by a word 
processing application.

· The file is “in use” by Windows.    Files that are “in use” are typically programs (.EXE files) or 
dynamic link libraries (.DLL files) being run by the system.    For example, you will get this 
message if you attempt to overwrite the program file of a program that is currently running.    The 
solution is to extract to a different folder.

WinZip® will not let you overwrite or delete a file that is “in use” by the system because this operation 
could cause unpredictable results, including system crashes.    Windows may read from files that are “in 
use” at any time, and does not expect these files to change.    If the file has been overwritten Windows will
not know the data has changed and can become confused.
If this message is issued during an Extract operation you can either extract the file to a different folder, or 
retry the operation after closing the program that is using the file.
If this message is issued while WinZip is trying to delete a folder or file you can either continue without 
deleting the folder or file (and delete it manually later on) or close the file in question and re-try the 
operation.



Message WZ67
Cannot create filename.    File already exists.    Open existing file?
This message is issued when you press the New button on the toolbar or choose New Archive from the 
File menu to create an archive but the specified archive already exists.    Since the file already exists it 
cannot be created.    Press the Yes button to open the existing file or the No button to cancel the 
operation.
Normally you should click the Open button or choose Open Archive from the File menu to open an 
existing archive.



Message WZ68
Cannot open filename.    File does not exist.    Create new file?
This message is issued in one of two situations:

· You pressed the Open button on the toolbar or selected Open Archive from the File menu and 
specified the name of a file that does not exist.

· You selected a filename from the File menu history list, but that file no longer exists.
Since the file does not exist it cannot be opened.    Press the Yes button to create a file with the specified 
name or the No button to cancel the operation.
Normally you should click the New button or choose New Archive from the File menu to create an 
archive.



Message WZ69
Due to Windows limitations it is not possible to run two different versions of the same program with the 
same name at the same time.    As a result, you cannot use WinZip's Install/Try/Uninstall feature to install 
WinZip®.



Message WZ70
This dialog box is displayed when Windows returns a “File Not Found” error when WinZip® tries to run 
another program.    Possible causes include:

· A program specified as a Windows association was deleted from your system or was moved to a 
different drive or folder.

· A required DLL or other component is not installed (e.g. VBRUN300.DLL).



Message WZ71
WinZip® could not create a folder because a file (not another folder) with the same name exists.    For 
example, if a file named “foo” exists you cannot create a folder called “foo” in the same folder.    Choose a 
different name for the folder you are trying to create, or delete the file with the conflicting name.



Message WZ72
For seamless integration with WinZip® your virus scanner must support automatic scanning.    At the time 
this version of WinZip was released MWAV did not to support automatic scanning.      Click Yes to continue
if you are sure your version of MWAV supports automatic scanning, otherwise press No and select a 
different scanner.



Message WZ73
WinZip® was unable to make the folder displayed in the Add dialog box the current folder.    In some 
operating environments this can be caused by using UNC names.    Another possible cause for this 
problem is a conflict with a “common dialog box” enhancement utility.



Caution
The Caution dialog box lists items that cannot safely be uninstalled but were changed during the install 
process.    These items are unlikely to interfere with a successful uninstall.    For example, a setup 
program might replace your existing copy of a common dynamic link library like CTL3D.DLL with the 
latest version of the same library.    In normal situations your existing applications should work with the 
latest version of the library, so leaving this new version installed will not cause problems.



WZ74
This archive contains files with long filenames or blanks.    However, you are using an external archive 
utility (e.g. LHA or ARJ 2.50) that doesn't support long filenames.    Thus some (or all) operations involving
this archive will fail.    For example, if the archive contains the file “A LONG NAME” and you try to extract it
using LHA,    the file will be called “A LONG N”.



WZ75
The archive does not contain complete filename information, so WinZip® cannot determine the full 
filename of the compressed file.    Replace all or some of the suggested filename with the corrected name 
and press OK.



WZ76
This compressed file contains an archive.    Normally you will want to have WinZip® automatically 
decompress and open the archive.    If you choose Yes WinZip will:

1. Decompress the archive into your temporary folder (as specified in the Options/Folders dialog 
box).

2. Open the archive in the temporary folder.
3. Later, when you close the archive in the temporary folder, WinZip will automatically delete it.

Note that the original compressed file is not changed by this operation.



WZ77
This compressed file is stored in the “KWAJ” format.    Some versions of LZ32.DLL, the system library 
used by WinZip® to assist with decompression of this file type, cannot handle this format. You can usually
decompress these files with the EXPAND command (from the DOS command prompt, type “expand /?” 
for instructions).



WZ78
The file you tried to open does not appear to be in the Microsoft Compress (LZEXPAND) format.    Note 
that not all files ending with an underscore are in the Microsoft Compress format.



WZ79
WinZip® could not create or replace the specified Zip file.    WinZip created or updated the Zip file in the 
temporary working folder, but was unable to copy the result to the destination disk.    The most likely 
cause for this error is a full or write-protected disk.    The updated file is left on your hard disk with the 
specified filename.    After correcting the problem (e.g. freeing up some disk space or removing the write-
protect tab from the disk), you can copy the specified filename to the destination disk manually.



WZ83
The SETUP or INSTALL program in this archive contains folder information, for example, win32\setup.exe
or win16\setup.exe.    Rather than using Install, choose CheckOut from the Actions menu for this 
archive.



WZ84
WinZip® encountered a problem processing a UUencoded, XXencoded, MIME, or BinHex file.    Details 
on the problem are in the message text.    Possible causes for this message include:
· The file is corrupt.    In this case, you will need to obtain another copy of the file.
· The file contains incomplete header information.    Be sure not to remove any header information, 
including subject fields, and MIME headers.    For example, never delete anything that looks remotely like 
this

Content-Type: multipart/mixed; boundary="----
=_NextPart_000_01BB5CFA.BB6BBC80"

Content-Transfer-Encoding: 7bit
------=_NextPart_000_01BB5CFA.BB6BBC80--

Hint for Microsoft Mail (MS-Mail) users: if you receive an encoded file by e-mail, save it to disk before 
opening the message.    Just select the message while it is in the inbox, then choose Save As from the 
File menu and specify a filename such as “message.uue”.    If instead you double click on the message, it 
may be truncated, because MS-Mail limits message text to about 16kb.



WZ85
The Favorite Zip Folders dialog box currently shows the results of searching one or more disks.    You 
have changed the search criteria (for example, from searching for all Zip files to all encoded files), so 
WinZip® needs to re-scan the disk(s) for files matching the new search criteria.    This could take a few 
moments.    Click Yes to start the search now.



WZ86
The PRE-RELEASE BETA TEST version of WinZip® you are using should be replaced with the current 
version of WinZip.    You can always download the current version from WinZip web site:

http://www.winzip.com 



WZ88
Windows is not configured to recognize this type of file, so WinZip® does not know which program to 
open for you to view it properly. For more information on associations and how to instruct Windows to 
know which program is required for this file type, see the section titled Windows Associations.



WZ89
The version of the Windows Common Control Library (comctl32.dll) installed on your system may not be 
able to properly display flat toolbar buttons.    At the time of this writing, the version of the Common 
Control Library you have installed was distributed only with Microsoft's Active Access Pack, and the latest 
version of the common control library available from the Microsoft web site did not support all the Active 
Access Pack features.
We expect Microsoft will update the Active Access Pack and/or the Common Control library in the not-too-
distant future.    Read about the Windows Common Control Library for a pointer to up-to-date information.



WZ90
Opening this .REG file will cause new data to be merged into your system registry.    Improper merges 
may cause damage to your registry, lost associations, etc.    Press OK to continue or Cancel if you are not
sure you want to merge this .REG file into your registry.



Password Mismatch
This message is displayed because the two passwords you typed were not the same.
When you choose to mask password entry by checking the Mask password checkbox, you can't see 
what you're typing.    In order to avoid saving your Zip file with an incorrectly typed password, WinZip® 
asks you to type the password again.    You will see this message when the two passwords you typed 
were different.
Please re-type the confirmation password and click OK.    If it is still incorrect, you probably mis-typed the 
original password.    Click Cancel and try again.



Mixed Drag and Drop Operation
You have dropped both files and folders on an archive that requires the use of an external archiving utility 
such as ARJ or LHA.
Due to limitations in the external utilities, this operation may not yield the results you expect.    Specifically,
it will archive all occurrences of files with the name(s) you specified found in all subfolders of the folder 
containing the file(s) you dropped.
For example, if you drop the file C:\MYSTUFF\README.TXT plus any folder, you will archive not only C:\
MYSTUFF\README.TXT but also all files named README.TXT found in any subfolder of C:\MYSTUFF.
To avoid this problem, simply drag and drop files separately from folders.



WZ91 - CRC Error
About CRC Errors
A CRC error indicates that some data in your Zip file is damaged.    CRC stands for “cyclic redundancy 
check”. It is a calculation made from all the data in a file to insure accuracy in transmission. When you 
add a file to a Zip file, WinZip calculates a CRC value for the file and saves the value in the Zip file.    
When you later extract the file from the Zip file, WinZip® calculates the CRC of the extracted file and 
compares it to the value stored when the file was zipped.    If these two CRC values do not match, the file 
that was extracted does not match the original file, and WinZip will display a “CRC Error” message.
When the data in a Zip file is damaged, it may not be possible to extract all of the files from the Zip file 
correctly.    Damaged data can affect the entire Zip file, multiple files, or just one file.
Why CRC Errors Occur
There are many possible causes for data damage. Among the most common is telephone line noise or 
some other transfer error when downloading a Zip file from an online source such as the Internet, AOL, or
CompuServe.    Such an error can introduce invalid data into a Zip file.    Some other possible causes 
include exposure of disks to excessive temperatures or magnetic fields, cross-linked disk sectors, and 
mechanical problems with disk drives.
What to do if a CRC Error Occurs
The best solution to the problem of a damaged Zip file is to try to obtain another copy of the file.    For 
example, use your backup copy of the file or get a new copy from the original source. If you obtained the 
Zip file by downloading it, then downloading it again will almost always solve the problem.
CRC Errors on Removable disks
If the damaged Zip file is on a removable disk, the removable disk may be physically damaged, or the 
data on it may have been corrupted.    In these cases, the only completely reliable solution is to use 
another copy of the disk or Zip file that is undamaged.    There are, however, two other situations in which 
it may be possible to recover some files from a removable disk.

· The removable disk drive that you are using to unzip the Zip file may be malfunctioning.    Try 
using a different disk drive, if possible.

· If the removable disk drive you are using to unzip the Zip file is not the same drive that was used 
to store the Zip file on the removable disk, and you have access to the original drive, try using this
drive to unzip.    It is possible that the original drive may be able to read the disk; if so, you can 
extract your files using this disk drive (and have your removable disk drives checked out--at least 
one of them may be out of alignment).    Otherwise, the removable disk itself or the data on it is 
probably damaged.

A “Last Resort” for CRC Errors
If you cannot download a new copy of the Zip file, obtain a replacement disk, or use a backup copy, you 
may still be able to recover some of your files, and even save portions of the files that are damaged in the
Zip file.    Here is the recommended procedure.

1. Start WinZip, switch to the Classic interface, and open the damaged Zip file.
2. Select Extract from WinZip's Actions menu, or click the Extract button on the WinZip toolbar.
3. In the Extract dialog, check the All Files option button and select the folder into which you want 

to extract files. Then click OK.
4. WinZip will extract any undamaged files to the selected folder; for any damaged files, WinZip will 

display a CRC Error message. For each such file, before clicking OK in the error message 
window, use Windows Explorer to open the extract folder and look for the file; some portion of it 
will probably already have been extracted. Copy the partial file to another folder and then click 
OK in the WinZip error message window.    This will erase the partially extracted file from the 
extract folder, leaving intact the copy of the file you made in the other folder.



Whether or not a damaged file partially recovered using this procedure will be useful depends on the 
nature of the file, what kind of damage there is, how much of the file was recovered successfully, and 
what kind of program(s) use the file.    In some cases, a partial file is of no use at all; in some cases, 
loading a partial file into your application program and re-saving it will completely restore the data.    In 
other (perhaps most) cases, the result will lie somewhere between these two extremes--some of the data 
will be recovered, and some will be lost.



Missing Theme Components
In some cases, a theme Zip file can be missing some of the components that are specified by the theme 
definition file (.Theme extension).    For example, the theme definition may specify that a file named 
NormalArrow.Cur contains the "normal" mouse pointer, but no such file exists in the Zip file.
It is safe to install a theme that is missing components.    Windows will substitute default components for 
critical items that are missing (e.g., mouse pointers) and simply ignore non-critical components (e.g., 
sounds).
If a theme is missing a few components, it may still be effective, and worth installing.    The system theme 
installer allows you to preview all of the components, and you can always decide then whether to 
complete or cancel installation.
If a theme is missing many components, it will probably not be very effective.    You can still install and 
preview it safely, but the results probably won't be what you hoped.



No Theme Association
WinZip® was unable to find an association for theme definition files (.Theme extension) in your system 
registry and can't continue installing your desktop theme.    This is generally caused by improper or 
missing installation of theme support on your system.
Windows 95 supports desktop themes only if the Plus! package or an equivalent is installed.    If you have
Plus! available, start the Plus! installation procedure and check the "Themes" checkbox.    No other Plus! 
components need to be installed or reinstalled.    Complete the installation procedure as directed and then
try installing your theme again.
Windows 98 and Windows Me include the equivalent of the theme support provided by the Windows 95 
Plus! package.    If theme support is not working on your system, you may not have elected to install 
theme support when you installed Windows.    You can easily install it now as follows: click Start and 
choose Settings and then Control Panel.    In the Control Panel window, double click Add/Remove 
Programs.    Choose the Windows Setup tab in the resulting dialog, then check the box labeled Desktop
themes and click Apply.    You will need your original Windows installation CD.
Windows NT 4.0 supports desktop themes only if add-on support from the NT Resource Kit or an 
equivalent is installed.    If you have the NT Resource Kit, insert the CD, click Desktop Themes, and follow
the instructions.    Then try installing your theme again.
Windows 2000: please read about desktop themes and Windows 2000.
Windows XP: supports desktop themes with no additional installation required.
If you are using Windows 95 and do not have Plus!, or if you are using NT 4.0 and do not have the NT 
Resource Kit, you may still be able to install desktop themes by obtaining a freeware or shareware 
replacement.    A number of these are available and can be found by searching the Internet. Please read 
about third-party theme installers if you are interested or if you are already using a third-party product and
you received this message. 



Third-party Theme Installers
WinZip's® Desktop Theme Installer proceeds in two main phases.    The first phase identifies and extracts
desktop theme components; the second phase launches the system theme installer to complete 
installation of the theme.    
The system theme installer is not part of WinZip, and its behavior may vary somewhat from the 
description given in the main help topic for WinZip's desktop theme installer.
In particular, some third-party (non-Microsoft) theme installers automatically activate the new theme by 
immediately applying its settings to your system.    In this case, you will not have the opportunity to 
preview, then accept or reject the theme as described in the main help topic.
WinZip Computing, Inc. cannot promise that the WinZip Desktop Theme Installer will operate correctly 
when used with third party theme installers.



Association Problem
Some of WinZip's® most useful features require that WinZip is associated with Zip files and other 
archives.    For more information on associations see the section titled Windows Associations.
It is strongly recommended that you answer Yes to this prompt.
Press the Info button for diagnostic information.



Invalid Filename
The name specified for at least one of the files in the archive is not a valid Windows filename.    It may 
include characters that are not allowed in Windows filenames, it may be too long, or it may contain a 
name that is reserved for a system device such as the printer.    WinZip® will not be able to extract the file 
using the name as it is specified in the archive.
WinZip does not list files with invalid names in the main window because it cannot predict what will 
happen if you attempt to extract the file: the result depends on the filename, the archive format (Zip, ARJ, 
etc.), and other factors. Therefore if you were to attempt to (for example) view the file, WinZip would not 
know the name under which the file had been stored and could not successfully open the extracted file or 
delete it after viewing.
Although WinZip will not automatically extract the file for operations such as viewing, you may be able to 
extract it manually.    Just be aware that the extraction might not be successful and that, if it is, the 
filename on disk will probably not be the same as the filename specified in the archive.    To try this, simply
extract from the archive using the Extract dialog box, making sure that you choose All files in the Files 
area.    WinZip will attempt to extract all files from the archive, including those with invalid filenames. Note 
that external archive utilities such as ARC, ARJ and LHA may handle invalid filenames differently from 
WinZip when they are extracted.



Association Problem Details
This dialog box lists the following information:
Full filename of current WinZip: note the exact drive and folder information.
Current Zip association: this field should include the EXACT name of the “current WinZip” shown 
above.    If this filename is different it is possible that you have two copies of WinZip® installed in different 
folders.    In this case you will probably want to remove the older copy.
Current registry value of the Zip key: this value should be “WinZip”.



Association Information
If the Associate WinZip with archives option is unchecked you will not be able to double click on Zip 
files and other archives to open them.    Other features, including Explorer shell extensions, rely on having
WinZip® associated with archives.    For more information on associations see the section titled Windows 
Associations.



Inflate Error
An error has occurred while decompressing one of the files in your Zip file. This error most commonly 
occurs for one of two reasons: either you are low on resources (memory) or the archive is damaged.
First, try to increase your available resources:

1. Click OK to close WinZip®.
2. Close any other active programs.
3. Restart WinZip and try to extract the file(s) again.

If the error recurs, the Zip file is probably damaged.    If you obtained the Zip file from an online source 
such as the Internet, AOL, or CompuServe, it is likely that the file was damaged during the download 
process; in most cases, you will be able to correct the problem by simply downloading the file again.    
Otherwise, you will need to obtain a new copy of the Zip file from your original source.
If you can't obtain a new copy of the Zip file, you may be able to extract many of the files by selecting 
them individually for extraction (rather than extracting all).    It is possible that only one or a few files are 
damaged.



Unsupported file format
WinZip 8.1 supports the Zip 2.0 standard file format, which is the specification used by the vast majority of
applications on the market that process Zip files. The file with which you are working is not based on the 
Zip 2.0 standard and is not supported by this version of WinZip. 
In order to work with this file using this version of WinZip, it will need to be re-zipped using a Zip 2.0-
compatible program (such as WinZip itself).
For current information about file format compatibility, visit our web site at 
http://www.winzip.com/zip20.htm.



Command line too long
Windows imposes a limit of about 250 characters on the total length of the names of files dropped on the 
WinZip icon.    It appears that this limit has been exceeded.
Click No if you want to cancel this drop operation.
Click Yes if you want to continue.    If you choose to continue, some of the files you dropped will not be 
processed.    You can review the results of your operation by choosing View Last Output from the 
Options menu.    The dialog will show the names of all files processed.
Tip: you can avoid this limit by first opening your archive in WinZip and then dropping the files on the 
WinZip window.



Unsupported ARJ version
WinZip does not support the 32-bit version of ARJ.    You must use the 16-bit version.
Please read Installing ARJ for information about the versions of ARJ that WinZip supports.



Unsupported LHA version
WinZip does not support the 32-bit version of LHA.    You must use the 16-bit version.
Please read Installing LHA for information about the versions of LHA that WinZip supports.



No temporary folder
The operation you requested requires the use of a temporary folder for the storage of intermediate files. 
WinZip was unable to identify or create a temporary folder using standard Windows techniques, so it is 
unable to complete the operation.
To locate a temporary folder, WinZip searches for a folder specified by either the TMP or TEMP 
environment variable.    If a folder is not found, WinZip then looks for a TEMP subfolder of the Windows 
folder; if the TEMP subfolder does not exist, WinZip attempts to create it.    You will see this message only 
if all of these attempts fail.
Additional information may be available from the WinZip web site at http://www.winzip.com/tempfldr.htm.



Character conversion error
The name of one of the folders containing files to be added contains characters that cannot be converted 
to the ANSI character set, and WinZip cannot continue this operation.
A full treatment of character sets is beyond the scope of this document.    Briefly, however, some file and 
folder names are represented on your Windows computer using a set of characters known as Unicode.    
WinZip must translate those characters into a simpler set of characters known as ANSI .
In most cases this presents no difficulty because both character sets include all of the most commonly 
used characters.    However, because the Unicode character set is much larger than the ANSI character 
set, it is possible for folder names to contain Unicode characters that have no ANSI equivalent in your 
computer's current configuration.
The simplest solution is to rename the folder using only common characters (letters A-Z, digits 0-9, 
spaces, etc.).    When this has been done, WinZip will be able to access the folder successfully and you 
can try the operation again.
If you are an experienced Windows user, you may be able to change your current ANSI code page to 
accommodate the invalid character(s).    Consult your Windows documentation for further information.



Add items
You have selected items in the Add dialog's file selection window, and you have also typed one or more 
wildcard file specifications in the File name field.
If there is any discrepancy between the items selected in the file selection window and the items specified
in the File name field, WinZip will add only the items specified in the File name field.    Wildcard file 
specifications are assumed to be relative to the folder shown in the Look in window at the top of the 
dialog.
For example, if you select a folder in the file selection window and then type *.* in the File name field, all 
files from the current folder (shown in the Look in field) are added, and the folder selected in the file 
selection window is ignored.



Windows Common Control Library
Some toolbar configuration options require version 4.71 or later of the Windows Common Control Library. 
This library is part of Windows 98, Windows Me, Windows 2000, Windows XP, Microsoft Internet Explorer 
4.0 or greater, and is available as a separate download from Microsoft.    For more information, see the 
web page http://www.winzip.com/common_control_library.cgi. 



Installing Quick View
When viewing a file that does not have an associated program, WinZip® uses the program identified as 
the "default association" in the Program Locations tab of the Configuration dialog box. 
Windows 95, Windows 98, and Windows NT 4.0 include an optional file viewing utility, Quick View, that 
can be used as the default association.    Quick View is capable of displaying files in a variety of formats.   
If you have one of these Windows versions and Quick View is not installed on your system, you can install
it as follows: open the Windows CD-ROM, click Add/Remove Programs, double click Accessories, 
check the Quick View box, then click OK.    To use Quick View with WinZip, select Configuration from 
WinZip's Options menu, click the Program Locations tab, type “quikview” in the Default association 
field (don't type the quotes), then click OK.



Search for Favorite Zip Folders
Click Search entire hard disk(s) to search all hard drives on your computer for folders containing Zip 
files and folders named “download” or “dnload”.    Click Quick search to search only for a few folders 
likely to contain Zip files (e.g. cserve\download and aol\download).
Diskette drives, network drives, and CD-ROMs are not searched.    To search for files on these devices, 
click the Search button in the Select Zip File panel (in the WinZip® Wizard) or the Favorite Zip Folders 
dialog box (in WinZip Classic), then click Let me find it.
Details on the File Type filters in the Search for files of type combo box are documented in the section 
File Type Filters.



How do I compress a folder and later restore it?
Note: there are easier ways to do this, but this is the easiest to explain.    In particular, using the drag and 
drop interface or the WinZip® menu entries in Windows Explorer's context menu can save you most of 
these steps.    (The examples assume that we are compressing and restoring the folder C:\MYDIR.)
How to compress a folder and its subfolders:

1. Start WinZip.
2. Choose New Archive from the File menu or click the New button in the toolbar.
3. Type the name of the archive, for example:

C:\MYDIR.ZIP
and press the Enter key.

4. Choose Add from the Actions menu or click the Add button.
5. In the Add dialog, navigate to the folder you want to compress, or type its name

C:\MYDIR
and press the Enter key.

6. Be sure the Include subfolders box is checked and the Save full path info box is not checked.
7. Click the Add with wildcards button. (In Windows “wildcards” are the asterisk and question mark

characters.    These let you specify multiple files at once, for example,“*.Txt” refers to all files with 
a file type of “Txt”.).

How to restore a folder and its subfolders:
1. Start WinZip and open the Zip file created in step 1 above.
2. Choose Extract from the Actions menu or click the Extract button.
3. Be sure the Use folder names checkbox is checked.
4. Navigate to the desired folder or type the folder's name 

C:\MYDIR
and press the Enter key.

5. Click the Extract button.



How do I view graphic/spreadsheet/word processing files in 
an archive?
In order to view a file in an archive, you need to have a program that is capable of displaying that type of 
file.    WinZip® can display text files using its built-in viewer, but for any other type of file (including word 
processor documents) you will need an external program.
The program you need will depend on the type of file you want to display.    For example, to display 
graphics files such as .jpg and .gif, you will need a graphics viewer; to display a Microsoft Excel 
spreadsheet (.xls), you need to have either Excel or a viewer that is capable of displaying Microsoft Office
documents.
If you use Windows 95, Windows 98, or Windows NT 4.0, you can use Microsoft's Quick View to view a 
variety of file types. See Installing Quick View for additional information on this viewer.
Otherwise, a variety of third-party programs, many of them free, are available for working with and 
viewing the main types of files that most people are likely to encounter in archives. For more information 
about these programs please visit our web page at:
http://www.winzip.com/viewer.htm



Do you keep track of address changes?
We track address changes, so we can send you upgrade notifications.    If you purchased a copy of 
WinZip® and have moved, please send us the following information:

1. Your name (If you are not sure how you spelled your name when you registered, please include 
common alternate spellings, e.g. “J. E. Smith", “Jim Smith", etc).

2. Your e-mail address, if any (please double check it!    almost 10% of the people that sign up for 
our mailing list type an invalid address; e-mail addresses are notoriously difficult to spell 
correctly).

3. Your new postal mailing address.
4. Your old postal mailing address.
5. Approximate purchase date.
6. Important: please indicate how you purchased WinZip:

Online order placed through the WinZip web site
By check
By telephone order to PsL (Public Software Library) or DigiBuy
Reseller (please include reseller name)

Thank you!



Command Line Support Add-On
The WinZip Command Line Support Add-On lets you use WinZip's® power within batch files, macros, and
other situations where you have a specific task and would prefer to accomplish it quickly or automatically, 
without using the usual WinZip graphical user interface.
A copy of the WinZip Command Line Support Add-On is available from the web page 
http://www.winzip.com/wzcline.cgi.



Install/Try/Uninstall Feature
NOTE: this help topic documents the WinZip® Install/Try/Uninstall Add-on.    A test version of this add-on 
was available from our web site at one time.    Due to low demand for the feature, we are no longer 
planning to make this add-on officially available.
WinZip's unique Install/Try/Uninstall feature makes it easy to install and uninstall software distributed in 
archives.    This feature can save megabytes of disk space by tracking and removing all traces of an 
application.    WinZip will run the installation program in an archive, give you a chance to try the program, 
and optionally offer to restore your system to its original state.    The uninstall step can selectively remove 
files, icons, or program groups created by an install program, and can restore any altered INI files.    You 
have complete control over the uninstall process, and no changes are made without approval.
Note: the Install feature is only available if an archive contains an “install” or “setup” program.    If the 
Install button is not displayed, use the CheckOut Feature to try the software in the archive.
To use the Install/Try/Uninstall feature

1. Press the Install toolbar button or select Install from the Actions menu to extract all files to a 
temporary folder and run the install program.

2. Try the program that was installed.
3. Decide whether to leave the program installed or to uninstall.

If you choose to uninstall, WinZip will display the Uninstall dialog box which will let you select whether to
· Delete any Groups and Icons created by the installation process.
· Delete any Folders or files created by the installation process.
· Restore your autoexec.bat, config.sys, or ini files if they were changed by the installation process.

Restrictions:
· All configuration changes made between an install and uninstall are considered to have been 

made by the install process.    For example, if you switch to your word processor and save a 
document during the installation process, the document is considered to have been created as 
part of the install process.    If you subsequently uninstall, WinZip will list the document you 
created in the Uninstall dialog box along with files created during the install procedure.    
Therefore it is strongly suggested that you do not run any programs other than those related to 
the program you are installing until you have decided whether to uninstall.

· The uninstall procedure does not let you restore files that are changed or deleted unless they are 
one of the special files that are backed up during initialization: autoexec.bat, config.sys, and 
the .ini files in your Windows folder.

Notes:
The uninstall feature does not notice files or folders created from DOS boxes (after all, this is a Windows 
program!).
The uninstall feature does not attempt to save information across sessions.
The Install operation requires that the entire product being installed is distributed in one archive.
WinZip determines whether an archive contains an install or setup program by checking for a file that 1) is
executable, 2) has “install” or “setup” in the filename, and 3) does not contain folder information.    If no file
matches these criteria the Install operation is disabled.

Related Topics:
Questions and Answers About Install/Try/Uninstall
Install Dialog Box
Uninstall Dialog Box





Questions and Answers About Install/Try/Uninstall
NOTE: this help topic documents the WinZip® Install/Try/Uninstall Add-on.    A test version of this add-on 
was available from our web site at one time.    Due to low demand for the feature, we are no longer 
planning to make this add-on officially available.
Here are answers to the three most frequently asked technical questions about WinZip's 
Install/Try/Uninstall feature:
Question: Why shouldn't I run unrelated programs during an install?
Answer: All configuration changes made between an install and uninstall are considered to have been 
made by the install process.    For example, if you switch to your word processor and save a document 
during the installation process, the document is considered to have been created as part of the install 
process.    If you subsequently uninstall, WinZip lists the document you created in the Uninstall dialog box 
along with files created during the install procedure.    Therefore it is strongly suggested that you do not 
run any programs other than those related to the program you are installing until you have decided 
whether to uninstall.
Question: What does WinZip do if a SETUP program replaces an existing DLL or VBX file?
Answer: WinZip's uninstall feature will never suggest you delete files that are used by other programs.    
WinZip “watches” the setup process, and notices whether any existing files were replaced.    If you later 
choose to uninstall a program WinZip will list changes to pre-existing files in the Cautions dialog box, and 
will not list them in the Uninstall dialog box, so these files cannot be accidentally deleted.    Since no well-
behaved SETUP or INSTALL program will replace existing files with older versions of the same file, and 
since all well-behaved DLLs and VBXs are designed so that new versions don't break programs relying 
on old versions, there should be no negative effects on your system.
Note that WinZip does not backup all files on your system before running an install, so it is possible for an
ill-behaved SETUP or INSTALL program to “break” other applications.    However, in no case will you be 
worse off running WinZip with the Install/Try/Uninstall feature than if you run the SETUP or INSTALL 
program without WinZip.
Question: Can I use WinZip to install a program, try the program for a week, and later use WinZip to 
uninstall it?
Answer: No.    WinZip's Install/Try/Uninstall feature was designed for the highest possible reliability.    You 
must decide whether to uninstall in the same session that you install.    The advantage to this approach is 
that WinZip has a very high uninstall success rate with a very easy to use interface.    It is almost 
impossible to guarantee a safe uninstall if you've had a chance to install other programs, make arbitrary 
changes to your system configuration, etc.    However, you can use the Report button in the WinZip 
Uninstall dialog box to generate a disk file listing files that were changed, and use this file to manually 
uninstall the program.    In this case it is up to you to determine whether any programs you've since 
installed depend on files that are part of the original install.



Uninstall Dialog Box
NOTE: this help topic documents the WinZip® Install/Try/Uninstall Add-on.    A test version of this add-on 
was available from our web site at one time.    Due to low demand for the feature, we are no longer 
planning to make this add-on officially available.
The Uninstall dialog box displays a list box containing one entry for each item that can be uninstalled.    
Entries are created for

· Groups and icons created by the installation process.
· Folders or files created by the installation process.
· Configuration files (e.g. win.ini) changed by the installation process.

Each entry contains a check box and a description of the action.    Select or deselect the check boxes 
depending on whether you want to uninstall the configuration change.    Usually it is best to remove all 
entries, however, this dialog box gives you a chance to avoid removing any files or icons you want to 
keep.

· The Select all button selects all check boxes.
· If a Cautions button is displayed in the Uninstall dialog box press it for information about system 

configuration changes that the uninstall procedure cannot restore, for example, dynamic link 
libraries in your Windows that have been replaced.

· Press the Report button to save a list of the suggested actions to a disk file.
· Press the Uninstall button to begin the uninstall, or Cancel to terminate the operation.    

Additional confirmation dialog boxes may be displayed depending on the specifics of the program
being uninstalled.

Notes:
All actions in the Uninstall dialog box are automatically checked except file deletions.    Individual files are 
not selected for deletion in case you created files using some other application during the install process; 
however, you can use the Select all button to quickly select all checkboxes in the list box.
If you decide to cancel the uninstall operation you may wish to create a report using the Report button to 
assist a manual uninstall.

Install Dialog Box    Beta Only Addendum
The Install dialog box gives you an additional option in the beta version:

· The Save configuration information for possible uninstall check box determines whether 
WinZip will save information about your program groups, icons, and ini files.    This information is 
required for an uninstall operation, so if this checkbox is not selected you will not be able to use 
WinZip to uninstall.



Wizard Interface
(topic entrance macro immediately takes you to wzwizard.hlp file - must be last topic before What's This so that 
people using Ctrl+Shift+right jump into Wizard help, not context help topics)



Displays a dialog that allows you to password protect (encrypt) the file(s) you are adding.    Please be sure to read about password 
protection in the WinZip help.



Adds the files specified in the File name field to the archive.    The files can be specified with wildcards, e.g., "*.txt".



Determines which files will be added to the archive.    Add (and replace) files adds all specified files to the archive.    Freshen 
existing files updates files that are already in the archive but adds no new files.    Update (and add) files is the same as Freshen, 
but adds any files that are not already in the archive.    Move (and replace) files is the same as Add but deletes files from disk or 
moves them to the Recycle Bin after they have been added.

All of these choices replace files already in the archive that have the same name and folder information as files being added or 
updated..



Determines the compression method.    Faster compression options usually result in larger archives.



Controls how WinZip handles disk-full conditions while creating a new archive on removable media.    This choice is available for 
new archives only.



Causes WinZip to store files in the archive using short ("8.3") MS-DOS filenames.



Looks in all subfolders of the specified folder when looking for files to add.



Stores any folder information specified in the File name: box in the archive.



Excludes files whose Archive attribute is not set.



Turns off a file's Archive attribute after the file is added to the Zip file.



Adds files with the System and Hidden attributes.    Normally files with these attributes are not added.



Performs the action specified in the Action field using the file(s) you've selected.



Lists the files and folders in the selected location.    Use this list to select files to be added to your archive.    To select multiple files, 
hold down the Ctrl key on your keyboard while selecting files.

To see what's in a folder, double click it.    To open the folder one level up, click  on the toolbar.
You can also use the Look in box to change drives, etc.



Closes this dialog without adding files to your archive.



Provides a space for you to type the name of the file you want attached.

You can use * as a wildcard.    For example, you can type *.txt to see a list of all files with a "txt" extension.

You do not have to type anything here if you select files from the list above--the names of the files you select will be automatically 
placed in this field.



Displays an overview of adding files to archives.

For help on an item, click  at the top of the dialog box and then click the item.



Type a name for the temporary CheckOut folder.    The folder will be created if it does not already exist.



Type a name to use for the CheckOut window.



Sets the maximum number of items to be placed in the CheckOut window.



Controls whether WinZip creates icons in the CheckOut window for all files in the archive or only for the specified files.    When 
checked, icons are created for only for executable files, files with associations, and likely documentation files.    When unchecked, 
icons are created for all files.



Controls whether WinZip will run a virus scanner on the files in the archive. This option is disabled if no virus scan utility is installed 
in the Program Locations dialog box (choose Configuration from the Options menu and click the Program Locations tab).



Performs the actions described in the dialog.



Closes this dialog box without performing the described actions.



View the file using the associated program, which is shown in parentheses.



View the file using WinZip's built-in file viewer.



View the file using the viewer whose name is specified below.



Type the name of the program you wish to use to view the file.



Allows you to browse your system for an external viewer.



Views the file using the specified viewer.



Closes this dialog without displaying the file.



Deletes the entire archive.



Removes the selected files from the archive.



Removes from the archive the files whose names you type.



Type the names of files to be removed from the archive.



Deletes the files or archive as specified by the option you chose.



Closes the dialog without deleting the archive or any files.



Specifies the name of the folder to which files will be extracted.



Expands the folder tree below to show the folder specified on the left.



Instructs WinZip to extract only the files that are selected in the main WinZip window.



Instructs WinZip to extract all files from the archive.



Instructs WinZip to extract the files specified to the right.



Type the name(s) of file(s) you want to extract.



Determines whether you are prompted before existing files are overwritten with files from the archive.



Determines whether WinZip skips (does not extract) existing files when the file on disk is newer than the file in the archive.



Determines whether WinZip will use folder names (also known as path names) stored in the archive.    You will probably want to 
check this option for most extract operations.    If this option is checked any folder names stored in the archive will be appended to 
the Extract To folder.    If this option is not checked all files will be extracted to the same folder, regardless of any folder names in the 
archive.



Selects the drive and folder to which the files should be extracted.



Extracts file(s) from the archive to disk.



Closes this dialog without extracting any files.



Opens a Windows Explorer window showing the Extract to folder after extracting.



Allows you to create a new folder on disk.



Extracts files to subfolders of the selected folder, using the names of the Zip files for folder names. Subfolders will be created if 
necessary.    If not checked, all files are extracted to the selected folder.



Specifies the name of the folder to which files will be extracted.



Expands the folder tree below to show the folder specified on the left.



Instructs WinZip to extract only the files that are selected in the main WinZip window.



Instructs WinZip to extract all files from the archive.



Instructs WinZip to extract the files specified to the right.



Type the name(s) of file(s) you want to extract.



Determines whether you are prompted before existing files are overwritten with files from the archive.



Determines whether WinZip skips (does not extract) existing files when the file on disk is newer than the file in the archive.



Determines whether WinZip will use folder names (also known as path names) stored in the archive.    You will probably want to 
check this option for most extract operations.    If this option is checked any folder names stored in the archive will be appended to 
the Extract to folder.    If this option is not checked all files will be extracted to the same folder, regardless of any folder names in the 
archive.



Selects the drive and folder to which the files should be extracted.



Extracts file(s) from the archive to disk.



Closes this dialog without extracting any files.



Opens a Windows Explorer window showing the Extract to folder after extracting.



Allows you to create a new folder on disk.



Extracts files to subfolders of the selected folder, using the names of the Zip files for folder names. Subfolders will be created if 
necessary.    If not checked, all files are extracted to the selected folder.



Type the name of the folder you want to create.    If you don't specify a complete path (from the root directory), the folder will be 
created under the current folder, shown above.



Creates the new folder.



Closes this dialog without creating a new folder.



Leaves intact any files already on the diskette; only the remaining free space is used for the new archive.



Deletes all files currently on the diskette before creating the new archive.



Creates the new archive.



Closes this dialog without creating the new archive.



Type the name of the archive to which the dropped file(s) should be added.    You can also use New to create a new archive or Open
to search for an archive.



Allows you to specify the name of a new archive for the dropped file(s) or folder(s).



Allows you to search for and open an existing archive to which the dropped file(s) or folder(s) should be added.



Determines which files will be added to the archive.    Add (and replace) files adds all specified files to the archive.    Freshen 
existing files updates files that are already in the archive but adds no new files.    Update (and add) files is the same as Freshen, 
but adds any files that are not already in the archive.    Move (and replace) files  is the same as Add but deletes files from disk or 
moves files to the Recycle Bin after they have been added.

All of these choices replace files already in the archive with the same name and folder information as files being added or updated.



Determines the compression method.    Faster compression options usually result in larger archives.



Controls how WinZip handles disk-full conditions while creating a new archive on removable media.    This choice is available for 
new archives only.



Stores full folder information (from root folder) in the archive.



Causes WinZip to store files in the archive using short ("8.3") MS-DOS filenames.



Excludes files whose Archive attribute is not set.



Turns off the Archive attribute of any file added to the archive.



Adds files with the System and Hidden attributes.    Normally files with these attributes are not added.



Allows you to password protect (encrypt) the file(s) you are adding.    Please be sure to read about password protection in the 
WinZip help.



Performs the action specified in the Action field using the dropped file(s) or folder(s).



Closes this dialog without adding the dropped file(s) or folder(s) to the archive.



WinZip will minimize its window to the taskbar during installation.



WinZip will save information about your installation, and you will be able to uninstall the software after trying it.



Begins installation.



Closes this dialog.



Closes this dialog without installing.



Displays a list of the screen savers found in the Zip file.    Click the one you want to install.



Continues with screen saver installation.



Closes this dialog without extracting any files or installing a screen saver.



Displays a list of the desktop themes found in the Zip file.    Click the one you want to install.



Continues with desktop theme installation.



Closes this dialog without extracting any files or installing a desktop theme.



Displays a list of files that will be extracted to your Windows folder when the screen saver is installed.



Files being extracted will automatically overwrite existing files with the same name in your Windows folder.    If not checked, you will 
be asked what to do.



Begins installation of the screen saver.



Closes this dialog without extracting any files or installing a screen saver.



Displays an informational list of the folders to which files will be extracted during theme installation.    The numbers in parentheses 
show how many files will be extracted to each folder.    Due to the nature of desktop theme installation, it is not possible to change 
the folders to which files will be extracted.



Files being extracted will automatically overwrite existing files with the same name in the destination folder(s).    If not checked, you 
will be asked what to do.



Continues with desktop theme installation.



Closes this dialog without extracting any files or installing the desktop theme.



Displays an informational list of the desktop theme components that appear to be missing from the Zip file.



Continues with desktop theme installation.



Closes this dialog without extracting any files or installing the desktop theme.



Starts WinZip in Wizard mode next time.



Automatically shows the Open dialog (to open an archive) when WinZip starts.



Uses a Windows Explorer-style "tree" view of your system for the Extract dialog box.    If not checked, a Windows 3.1-style view of 
your system is used.



Performs “smart” CR/LF conversion when extracting from TAR files.    Click Help for more information about this option.



Assigns the “always on top” attribute to the WinZip window so that it will always appear "above" normal windows.



Causes WinZip to beep after archive operations that take more than one second to complete.



Enables "Smart DOC file handling.”    When this feature is enabled and a file is double clicked, WinZip will attempt to determine 
whether files with .DOC extensions are word processor documents or ASCII text files and then launch the appropriate program to 
open the file.



Puts files in the Recycle Bin instead of deleting them after a Move operation in the Add dialog box.



Displays a dialog providing a choice of viewers when you View a file.    If not checked, WinZip skips this dialog and uses the default 
viewer for the file type, as determined by the Windows registry.



Enables the desktop theme and screen saver installers. If not checked, WinZip treats Zip files containing desktop themes or screen 
savers as normal Zip files.



If this option is checked when you dismiss the configuration dialog, WinZip restores all caution dialogs that you have turned off (a 
caution dialog is "turned off" by checking its "Do not display this dialog in the future" checkbox).



Sets the number of files that appear in the list of recently used files in the File menu.    You can set this to any number from 1 to 9.



Automatically displays the Zip file comment when you open a Zip file that contains a comment.



Displays a status dialog when WinZip is busy performing lengthy operations. 



WinZip displays the Add dialog when files are dropped on an archive in Explorer.    If not checked, dropped files are simply added to 
the archive without a dialog.



WinZip displays the Add dialog when files are dropped on an open WinZip window.    If not checked, dropped files are simply added 
to the open archive. (If no archive is open, the Add dialog is displayed regardless of this setting.)



If this item is checked, the password will be displayed as asterisks when you type it.    You will be asked to type the password a 
second time to confirm that you have not made any typing errors.



Provides a space for you to type the password.



Closes this dialog and applies the password you have typed to future archive operations.

Note: if you have checked "Mask password" you will be asked to type the password again.



Closes this dialog without applying a new password.



Displays general information about using passwords with archives.



Displays the column containing member file names.    This column is always displayed.



Displays a column showing the file type for each member file.



Displays a column showing the last modification date for each member file.



Displays a column showing the original (uncompressed) size of each member file.



Displays a column showing the compression ratio for each member file.    The higher the compression ratio, the more the file has 
been compressed.



Displays a column showing the size of each member file as stored in the archive (after compression).



Displays a column showing the CRC (checksum) of each member file.    This value is used for error checking during file extraction.



Displays a column showing the file attributes of each member file.



Displays a column showing the path (folder) stored in the archive for each member file.    Some files may not have folder information,
in which case the Path column will be empty.



Resets the displayed columns to the installation defaults (Name, Modified, Size, Ratio, Packed, and Path).



Filenames that contain no lower case characters appear in all upper case (rather than initial upper case). 



Allows you to click anywhere on a file's row of information in order to select it (otherwise you must click the file's name).



Displays grid lines to separate rows and columns in the main WinZip window.      Due to a problem in Windows XP, this option is not 
available to XP users.



Uses the same mouse selection settings as your Windows desktop.



Allows you to select a file with a single click.    Uncheck "Use current system folder settings" to enable this option.



Controls when filenames are underlined in single-click selection mode.    To enable, uncheck "Use current system folder settings" 
and select "Single click to open a file."



Controls when filenames are underlined in single-click selection mode.    To enable, uncheck "Use current system folder settings" 
and select "Single click to open a file."



Controls when filenames are underlined in single-click selection mode.    To enable, uncheck "Use current system folder settings" 
and select "Single click to open a file."



Requires you to double click a file to open it, regardless of your desktop mouse selection setting. Uncheck "Use current system 
folder settings" to enable this option.



WinZip uses large toolbar buttons.



WinZip uses Internet Explorer-style toolbar buttons: the buttons appear in gray until the mouse pointer passes over them.    This 
option also displays buttons that are simpler in appearance if Use large toolbar buttons is also checked.    Has no effect unless 
Use flat toolbar buttons is checked.



WinZip displays toolbar button names.



WinZip displays brief pop-up help text when you hover the mouse pointer on a toolbar button.



WinZip displays toolbar buttons with a flat look rather than a 3-D look.    If Use Explorer-style toolbar buttons is also checked, the 
buttons will appear in shades of gray until the mouse pointer passes over them.



WinZip displays toolbar buttons using more colors on systems configured to use more than 256 colors.



Displays a dialog that allows you to select and rearrange the buttons in the toolbar.



When WinZip starts, it does not change folders, so the system default folder is in effect.    Usually this is the folder containing 
WinZip.



When WinZip starts, it changes to the folder containing the last open archive during your last WinZip session, unless it is on your A: 
or B: drive.



When WinZip starts, it changes to the folder you specify here. Click the Folder button to the right to browse your system.



When WinZip starts, it changes to the folder you specify here. Click the Folder button to the right to browse your system.



When WinZip starts, it changes to the folder you specify here.    Click the Folder button to the right to browse your system.



The initial folder listed in the Extract dialog is the folder containing the currently open archive. 



The initial folder listed in the Extract dialog is the folder used in the most recent Extract operation, unless it's on your A: or B: drive.



The initial folder listed in the Extract dialog is the folder you specify here.    Click the Folder button to the right to browse your system.



The initial folder listed in the Extract dialog is the folder you specify here.    Click the Folder button to the right to browse your system.



The initial folder listed in the Extract dialog is the folder you specify here.    Click the Folder button to the right to browse your system.



The initial folder listed in the Add dialog is the folder containing the currently open archive.



The initial folder listed in the Add dialog is the folder used in the most recent Add operation, unless it's on your A: or B: drive.



The initial folder listed in the Add dialog is the folder you specify here.    Click the Folder button to the right to browse your system.



The initial folder listed in the Add dialog is the folder you specify here.    Click the Folder button to the right to browse your system.



The initial folder listed in the Add dialog is the folder you specify here.    Click the Folder button to the right to browse your system.



WinZip uses the folder specified here for temporary Zip files.    If you don't specify a folder here, WinZip uses the folder containing 
the open Zip file.    Click the Folder button to the right to browse your system.



WinZip uses the folder specified here for temporary Zip files.    If you don't specify a folder here, WinZip uses the folder containing 
the open Zip file.    Click the Folder button to the right to browse your system.



WinZip uses the temporary folder specified above only if the open Zip file is on removable media.



WinZip uses the folder specified here as the default folder in the CheckOut dialog box.    If you don't specify a folder here, WinZip will
use the folder containing the open archive.    Click the Folder button to the right to browse your system.



WinZip uses the folder specified here as the default folder in the CheckOut dialog box.    If you don't specify a folder here, WinZip will
use the folder containing the open archive.    Click the Folder button to the right to browse your system.



WinZip uses the folder specified here for temporary files.    Click the Folder button to the right to browse your system.



WinZip uses the folder specified here for temporary files.    Click the Folder button to the right to browse your system.



Windows will use WinZip to open archives from My Computer, Windows Explorer, most e-mail programs, etc.    You can use the 
Associations button to control the specific archive types to associate with WinZip.    Click Help for more information about WinZip 
associations.



Displays a dialog that allows you to control the types of archives with which WinZip is associated.    The "Associate WinZip with 
archives" checkbox must be checked to use this button.



Displays a WinZip icon in the system taskbar tray.    You can use the icon to start WinZip, quickly access recently opened archives, 
etc.



WinZip appears on the Windows Start menu.



A WinZip icon appears on the desktop.



WinZip menu items appear in Windows Explorer's context menu, and you can zip and unzip files without leaving Explorer. 



WinZip's Zip and E-Mail option appears in Explorer's context menu, allowing you to easily compress and mail files.    Enabled only if 
a supported e-mail application (e.g., Outlook) is installed.



You can enable or disable all of WinZip's Explorer enhancements by checking or unchecking this checkbox.



WinZip menu items will appear in a submenu of Windows Explorer's context menu.    If not checked, WinZip items appear 
individually in the main context menu.



A small WinZip icon is displayed with WinZip entries in Windows Explorer's context menu.



WinZip includes folder information for all files added when you right click a folder in Windows Explorer or My Computer and choose 
Add to folder-name.zip.    If unchecked, folder information is stored only for files added from subfolders.



WinZip checks to see if EXE files on local hard drives are self-extracting CAB files.



WinZip checks to see if EXE files on removable media are self-extracting CAB files.



WinZip checks to see if EXE files on other drive types are self-extracting CAB files.    "Other drive type" means anything other than 
removable media drives and local hard drives (e.g., network drives).



WinZip displays a comment tooltip when the mouse pointer is hovered over a Zip file on a local hard drive.



WinZip displays a comment tooltip when the mouse pointer is hovered over a Zip file on removable media.



WinZip displays a comment tooltip when the mouse pointer is hovered over a Zip file on other drives.    "Other drives" means any 
drive other than removable media drives and local hard drives (e.g., network drives).



Contains a list of commands that can be included in the My Computer or Windows Explorer context menu.    You can enable or 
disable specific commands by checking or unchecking the checkboxes.    Commands that are disabled will not appear in the context 
menu.

For more information on the specific items that can be added to the Explorer context menu, click anywhere in the Configuration 
dialog box to close this window, then click Help.



Specifies the name of the viewer used for file types that do not have a Windows association.    Click the Folder button to the right to 
browse your system.



Specifies the name of the viewer used for file types that do not have a Windows association.    Click the Folder button to the right to 
browse your system.



Specifies the name of the optional application used to make self-extracting Zip files ("Make .Exe File" from the Actions menu).    Click
the Folder button to the right to browse your system.



Specifies the name of the optional application used to make self-extracting Zip files ("Make .Exe File" from the Actions menu).    Click
the Folder button to the right to browse your system.



Specifies the name of the optional application used to scan files for viruses ("Virus Scan" from the Actions menu).    Click the Folder 
button to the right to browse your system.



Specifies the name of the optional application used to scan files for viruses ("Virus Scan" from the Actions menu).    Click the Folder 
button to the right to browse your system.



Specifies the parameters (command line) for your virus scanner.    If empty, WinZip adds the names of the files to be scanned to the 
virus scanner command line.    WinZip recognizes the following special character sequences:

*.* - WinZip adds the drive and folder of the files to be scanned.    For example, "*.*" might be changed to "c:\temp\*.*"

%d - WinZip substitutes the drive and folder of the files to be scanned.

%f - WinZip substitutes the name of a temporary report file (use for DOS-based virus scanners only)

%wscan - a special parameter required for McAfee's WSCAN program only.



Minimizes the virus scanner when it is running.



Specifies the name of the optional application used to process ARJ archives.    Click the Browse     button to browse your system.



Specifies the name of the optional application used to process ARJ archives.    Click the Browse     button to browse your system.



Specifies the name of the optional application used to process LZH (LHA) archives.    Click the Browse     button to browse your 
system.



Specifies the name of the optional application used to process LZH (LHA) archives.    Click the Browse     button to browse your 
system.



Specifies the name of the optional application used to process ARC archives.    Click the Browse     button to browse your system.



Specifies the name of the optional application used to process ARC archives.    Click the Browse     button to browse your system.



Overwrites the specified file.



Overwrites the specified file and automatically answers "Yes" to any additional Overwrite dialogs during the current operation.



Skips extraction of the specified file.



Skips extraction of the specified file and cancels the current operation.



Searches all local hard drives for folders containing Zip files and folders named "download" or "dnload".



Searches local hard drives for folders likely to contain Zip files (e.g., "download", "dnload", "\cserve\download").



Specifies the type(s) of archives to be searched for.



Performs the specified search.



Closes this dialog without performing a search.



Overwrites the specified file.



Overwrites the specified file and automatically answers "Yes" to any additional file replacement dialogs during the current operation.



Skips extraction of the specified file.



Skips extraction of the specified file and cancels the current operation.



Erases all files on the new disk before continuing with the Zip operation.



Continues the current operation, erasing all files on the new disk if the checkbox is checked.



Cancels the current operation.    No files on the new disk are erased.



Lists all file types with which WinZip can be associated, showing the current association for each type.    Checked file types will be 
associated with WinZip. 



Closes this dialog and creates associations for all checked file types.



Closes this dialog without changing any file associations.



Closes this dialog.



Allows you to obtain information about ordering WinZip from the help file or the WinZip web site.



Displays the WinZip License Agreement.



Displays acknowledgments to the people who helped make WinZip.



Displays information about your system: Windows and DLL versions, resource availability, Windows configuration, etc.    You may be
asked for this information if you request technical support.



Takes you to the WinZip web site.    You must have Internet access and a web browser.



Frequently Asked Questions about WinZip.    You can read this information from the help file or access the WinZip web site.



Allows you to enter registration information so that you can create a registered version of WinZip.



Connects you to the WinZip web site to access the information you requested.



Displays the information you requested from the WinZip help file without accessing the Internet.



Closes this dialog without accessing the Internet or displaying the information you requested.



Allows you to select the font to be used for printing.



Performs the requested print operation.



Closes this dialog without performing the print operation.



Automatically displays the Add dialog after you have specified the new archive name.



Creates a new archive using the name you've specified.



Closes this dialog without creating a new archive.



Specifies the general type of archive you want to create.    All existing files of the specified type(s) in the selected folder will be 
displayed in the window above.



Lists the existing files and folders in the selected location. 

To see what's in a folder, double click it.    To open the folder one level up, click  on the toolbar.
You can also use the Save in box to change drives, etc.



Displays a list of your Favorite Zip Folders.



Displays a dialog that allows you to select a folder to be added to your list of Favorite Zip Folders.



Removes the selected folder from your list of Favorite Zip Folders.    The folder is not deleted; it is simply removed from your 
Favorite Zip Folder list.



When you open a Zip file from Search results that is not in one of your Favorite Zip Folders, WinZip automatically adds the folder to 
your list of Favorite Zip Folders.



When you open a Zip file from Search results that is not in one of your Favorite Zip Folders, WinZip asks if you want to add the 
folder to your list of Favorite Zip Folders.



When you open a Zip file from Search results that is not in one of your Favorite Zip Folders, WinZip will not add the folder to your list
of Favorite Zip Folders.



Shows the folder to which files will be unzipped unless you specify a different folder in the Unzip panel.



Displays a dialog that allows you to change the default unzip folder.



Automatically displays the Zip file comment when you open a Zip file that contains a comment.



Starts WinZip with the Wizard interface next time.



Starts WinZip with the Classic interface next time.



WinZip will display the Switch Interface dialog if you start it in Classic mode and close it in Wizard mode or vice versa.



WinZip will use a simplified Wizard that is compatible with WinZip 7.0.    The 7.0 Wizard can unzip and install but it cannot create or 
update Zip files.    You may want to use the simplified Wizard if you use WinZip only for unzipping/installing because it eliminates the 
Wizard's Select Activity panel.



Enables or disables the desktop theme and screen saver installer.



Displays a WinZip icon in the system taskbar tray.    You can use the icon to start WinZip, quickly access recently opened archives, 
etc.



Context help for Product Updates OK button.



Context help for Product Updates Cancel button.



Context help for product Updates "products and other" radio.



Context help for Product Updates "products only" radio



Extracts the file specified in the message.



Extracts the file specified in the message and all additional selected files.



Skips extraction of the file specified in the message.



Cancels the extract operation (no additional files will be extracted).



A composite file that contains one or more other files, normally compressed.    Archives such as Zip files are convenient for grouping 
related files together, conserving disk storage, and reducing transfer times when sending files over the Internet.    You can work with 
this file by double clicking it or by right clicking it and choosing Open with WinZip from the pop-up menu.



Lists files in your Favorite Zip Folders.    To open a listed file, double click it or select it and click Open.    Click Search to find 
archives not located in your Favorite Zip Folders.    Click Options to add folders to or remove folders from your Favorite Zip Folders.



Specifies the type(s) of files to be listed.    Choose Zip files to list only Zip files, All archives to list all archive formats (Zip, ARJ, 
CAB, etc.), or Encoded files to list only MIME and other encoded files.



Opens the selected file.



Displays a dialog that allows you to search for archives not located in your Favorite Zip Folders.



Closes this dialog without opening a file.



Displays a dialog that allows you to add folders to your Favorite Zip Folders, remove folders from your Favorite Zip Folders, and 
specify what WinZip should do when opening a file from Search results when the file is not located in one of your Favorite Zip 
Folders.



If this box is checked, the Zip file will be password protected.    You will be asked for the password after you click OK.    The recipient 
of your attachment will need the password in order to extract files from the Zip file.



WinZip Zip and E-Mail Plus creates a name for your Zip file based on today's date. (not available)



WinZip Zip and E-Mail Plus creates a name for your Zip file based on the name of the file you select to be added. If multiple files are
selected, the name of the folder is used instead.



Allows you to specify the name for your Zip file.



Provides a space to type the name for your Zip file.



Displays information about WinZip Zip and E-Mail Plus. (not available)



Creates the Zip file attachment containing the files you have selected.    If the Password checkbox is checked, you will be asked for 
a password.



Closes this dialog without creating an attachment.



Displays an overview of using WinZip Zip and E-Mail Plus. (not available)

For help on an item, click  at the top of the dialog box and then click the item.



Provides a space for you to type the name of the file you want attached. (not available)

You can use * as a wildcard.    For example, you can type *.txt to see a list of all files with a "txt" extension.

You do not have to type anything here if you select files from the list above--the names of the files you select will be automatically 
placed in this field.



Lists the folders and files in the selected location. To see what's inside a folder, double click it. (not available)

You can also use the From box to change drives, etc.

To open the folder one level up, click  on the toolbar.



Provides a space for you to type the Zip file password. This password will be required to extract files from the Zip file.



Provides a space for you to type the Zip file password a second time.    This confirms that you have typed the password correctly.    
The two passwords must match before the Zip file will be created.



If checked, the password is "masked," i.e., displayed as asterisks when you type it.    You will need to type the password twice to 
confirm that you have typed it correctly.



Creates the Zip file attachment using the password you have specified.



Returns to the Zip and E-Mail Plus dialog without creating a Zip file attachment.



Specifies the size of the parts into which the Zip file will be split.    Common sizes are listed; choose "Other size" to specify your own 
size using the Other size field.



Creates the split Zip file using the name and size you've specified.



Closes this dialog without creating the split Zip file.



Provides a space for you to type the desired size of the parts into which the Zip file will be split.    To use this field, choose "Other 
size" from the Part size drop-down list.    The size you specify here is interpreted as bytes, kilobytes (KB) or megabytes (MB) as 
specified by the radio buttons to the right.



Specifies that the value in the Other size field is in bytes.



Specifies that the value in the Other size field is in kilobytes.



Specifies that the value in the Other size field is in megabytes.



Specifies the types of files that are displayed in the window above.



Provides a space for you to type the name of the split Zip file you want to create.



Specifies the location where you want to locate the split Zip file. Click the arrow to select another location, or click on the toolbar to 
move up levels. 

The window below lists the existing items in the specified location.



Lists files in your Favorite Zip Folders for quick opening.



Provides a space for you to type the name of the archive you want to open.    You do not have to type anything here if you select an 
archive from the list above--the name of the archive you select will be automatically placed in this field. 



Specifies the location where you want to locate a file or folder. Click the arrow to select another location, or click  on the toolbar 
to move up levels. 
The box below lists the items in the selected location. To open a file, double click its name.



Opens the selected archive.



Closes this dialog without opening an archive.



WinZip 8.1 Ordering Information
The following information is for the English language version of WinZip®.    All orders are subject to the 
WinZip License Agreement.

To Order WinZip Now
To order online and download your order immediately, go to the WinZip web site at:

http://www.winzip.com/order.cgi

You can also use our web site to order copies of WinZip on CD for delivery by postal mail.

Other Ordering Options
In addition to ordering online, you can also place orders in the following ways.    These orders will be 
shipped by postal mail (airmail outside the US) and will leave our office within two business days after the 
order is received:

Credit card orders by phone

Credit card orders by fax or mail

Ordering by check

Purchase orders

WinZip Pricing
WinZip Single-User License: $29

WinZip Site Licenses:

2 to 9 computers: $22 per computer

10 to 24 computers: $17 per computer

25 to 49 computers: $14 per computer

50 to 99 computers: $10 per computer

100 to 199 computers: $7 per computer

200 to 499 computers: $6 per computer

500 to 749 computers: $4 per computer

If you need a quote for higher quantities, please send a message to sitesales@winzip.com.

There is a $5.00 per order charge for shipping and handling.    Prices are in US dollars and are 
guaranteed through December, 2002.

Site Licenses
The WinZip site license from WinZip Computing is for the English language version of WinZip.    A site 
license for WinZip entitles your organization to receive one copy of the distribution package and to 
duplicate the software as necessary for use within your organization on the specified number of 
computers.

The WinZip site license is only for use within your own organization. For example, you cannot give or sell 
any of your site-licensed copies of WinZip to your customers, or include site-licensed copies of WinZip in 
products that you sell. 

The WinZip site license is not a concurrent user license.    Each copy of WinZip may either be used by a 
single person who uses the software personally on one or more computers, or used on a single 
workstation used non-simultaneously by multiple people, but not both.

If you have further questions, please send a message to sitesales@winzip.com.



German, French, and Japanese Versions
There are German and French language versions of WinZip.    For Japanese users there is an English 
version with the Help file in Japanese.    Click here for additional information.



WinZip Standard License
WinZip® Copyright © 1991-2001 by WinZip Computing, Inc.
All rights reserved.

This license applies to the standard-licensed version of WinZip.    If you have an evaluation version of 
WinZip, see the section titled WinZip Evaluation License.

WinZip License
WinZip Computing, Inc. 
Your Agreement to this License
You should carefully read the following terms and conditions before using, installing or distributing this 
software.    Unless you have a different license agreement signed by WinZip Computing, Inc. (“WCI”) your 
use, distribution, or installation of WinZip indicates your acceptance of this agreement ("License").    

If you do not agree to all of the terms and conditions of this License, then: (a) do not copy, install, 
distribute or use any copy of WinZip with which this License is included, and (b) in addition, if you paid 
WCI or an authorized WCI reseller for a package consisting of one or more copies of WinZip, you may 
return the complete package unused, within thirty (30) days after purchase, for a full refund of your 
payment.

The terms and conditions of this License describe the permitted use and user(s) of each Licensed Copy 
of WinZip.    For purposes of this License, if you have a valid single-copy license, you have the right to use
a single "Licensed Copy" of WinZip; if you or your organization has a valid multi-user license, then you or 
your organization have/has the right to use up to a number of "Licensed Copies" of WinZip equal to the 
number of copies indicated in the documents issued by WCI when granting the license.

Scope of License
Each Licensed Copy of WinZip may either be used by a single person who uses the software personally 
on one or more computers, or installed on a single workstation used nonsimultaneously by multiple 
people, but not both. This is not a concurrent use license.

Each Licensed Copy may be accessed through a network, provided that you have purchased rights to 
use a Licensed Copy for each workstation that will access WinZip through the network.    For instance, if 8
different workstations will access WinZip on the network, you must purchase rights to use 8 Licensed 
Copies of WinZip, regardless of whether the 8 workstations will access WinZip at different times or 
concurrently.

Each Licensed Copy of WinZip includes WinZip Self-Extractor Personal Edition, which may be used to 
create an unlimited number of freely distributable, royalty-free self-extracting Zip files. These self-
extracting Zip files contain, among other things, a portion of WinZip Self-Extractor Personal Edition, 
including copyrighted software, proprietary notices, and identifying information (the "Extraction Software").
You may not alter or modify the Extraction Software, nor permit anyone else to do so.

All rights of any kind in WinZip which are not expressly granted in this License are entirely and exclusively
reserved to and by WCI.    You may not rent, lease, modify, translate, reverse engineer, decompile, 
disassemble, or create derivative works based on, WinZip, nor permit anyone else to do so. You may not 
make access to WinZip available to others in connection with a service bureau, application service 
provider, or similar business, nor permit anyone else to do so. 

Warranty Disclaimers and Liability Limitations
WinZip, and any and all accompanying software, files, data and materials, are distributed and 
provided “AS IS” and with no warranties of any kind, whether express or implied. In particular, 
there is no warranty for the optional virus scanning feature. (WinZip does not scan for viruses, it simply 
runs external programs that claim to perform this function.)      You acknowledge that good data processing
procedure dictates that any program, including WinZip, must be thoroughly tested with non-critical data 
before there is any reliance on it, and you hereby assume the entire risk of all use of the copies of WinZip 



covered by this License.    This disclaimer of warranty constitutes an essential part of this License. 

Any liability of WCI will be limited exclusively to refund of purchase price.    In addition, in no event
shall WCI, or its principals, shareholders, officers, employees, affiliates, contractors, subsidiaries, 
or parent organizations, be liable for any indirect, incidental, consequential, or punitive damages 
whatsoever relating to the use of WinZip, or to your relationship with WCI.

In addition, in no event does WCI authorize you or anyone else to use WinZip in applications or 
systems where WinZip's failure to perform can reasonably be expected to result in a significant 
physical injury, or in loss of life.    Any such use is entirely at your own risk, and you agree to hold 
WCI harmless from any and all claims or losses relating to such unauthorized use.

General
This License is the complete statement of the agreement between the parties on the subject matter, and 
merges and supersedes all other or prior understandings, purchase orders, agreements and 
arrangements.    This License shall be governed by the laws of the State of Connecticut, without regard to 
Connecticut choice-of-law rules.    Exclusive jurisdiction and venue for all matters relating to this License 
shall be in courts and fora located in the State of Connecticut, and you consent to such jurisdiction and 
venue.    There are no third party beneficiaries of any promises, obligations or representations made by 
WCI herein.        Any waiver by WCI of any violation of this License by you shall not constitute, nor 
contribute to, a waiver by WCI of any other or future violation of the same provision, or any other 
provision, of this License. 



WinZip Evaluation License
WinZip® Copyright © 1991-2001 by WinZip Computing, Inc.
All rights reserved.

This license applies to the evaluation version of WinZip.    If you do not have an evaluation version of 
WinZip, see the section titled WinZip Standard License. 

WinZip License
Evaluation Version
WinZip Computing, Inc. 
Your Agreement to this License
By using, copying, transmitting, distributing or installing WinZip 8.1 ("WinZip"), you agree to all of the 
terms of this agreement (“License”).

Please read the license terms below.    If you do not agree to all of the terms of this License, then do not 
use, copy, transmit, distribute, or install WinZip.

Scope of License
This is not free software.    Subject to the terms below, you are hereby licensed by WinZip Computing, Inc.
(“WCI”) to use one copy of WinZip, on one (1) computer or workstation, for evaluation purposes without 
charge for a period of 21 days.    If you use this software after the 21-day evaluation period a registration 
fee of $29 is required.    Payments must be in US dollars drawn on a US bank, and should be sent to 
WinZip Computing, Inc., P.O. Box 540, Mansfield, CT 06268, USA.    See the WinZip web site at 
http://www.winzip.com for information about online ordering and quantity discounts.

Unregistered use of WinZip after the 21-day evaluation period is in violation of U.S. and international 
copyright laws.

You may, without making any payment to WCI:
a) give exact copies of this evaluation version of WinZip personally to anyone, except for the 

purpose of extending their 21-day evaluation period;
b) distribute exact copies of this evaluation version of WinZip, if done exclusively through electronic 

channels; and 
c) make as many exact copies of this evaluation version of WinZip as you wish, for purposes of 

distribution as described in (a) and (b) above.

You are specifically prohibited from charging, or requesting donations, for any copies, however 
made, and from distributing such copies with other products of any kind, commercial or 
otherwise, without prior written permission from WCI. WCI reserves the right to revoke the above 
distribution rights at any time, for any or no reason.
Self-extracting Zip files created by WinZip's Self-Extractor Personal Edition component contain, among 
other things, a portion of WinZip Self-Extractor Personal Edition, including copyrighted software, 
proprietary notices, and identifying information (this portion is the "Extraction Software").    You may not 
alter or modify the Extraction Software, nor give anyone permission to do so. Under no circumstances 
are you licensed to distribute self-extracting Zip files created by the evaluation version of WinZip 
Self-Extractor.

All rights of any kind in WinZip which are not expressly granted in this License are entirely and exclusively
reserved to and by WCI.    You may not rent, lease, modify, translate, reverse engineer, decompile, 
disassemble, or create derivative works based on, WinZip. You may not make access to WinZip available 
to others in connection with a service bureau, application service provider, or similar business. 

Warranty Disclaimers and Liability Limitations
WinZip, and any and all accompanying software, files, data and materials, are distributed and 



provided “AS IS” and with no warranties of any kind, whether express or implied. In particular, 
there is no warranty for the optional virus scanning feature. (WinZip does not scan for viruses, it simply 
runs external programs that claim to perform this function.)      You acknowledge that good data processing
procedure dictates that any program, including WinZip, must be thoroughly tested with non-critical data 
before you rely on it, and you hereby assume the entire risk of using the program.    This disclaimer of 
warranty constitutes an essential part of this License. 

Any liability of WCI will be limited exclusively to refund of purchase price, if any.    In addition, in 
no event shall WCI, or its principals, shareholders, officers, employees, affiliates, contractors, 
subsidiaries, or parent organizations, be liable for any indirect, incidental, consequential, or 
punitive damages whatsoever relating to the use of WinZip, or to your relationship with WCI.

In addition, in no event does WCI authorize you to use WinZip in applications or systems where 
WinZip's failure to perform can reasonably be expected to result in a significant physical injury, or
in loss of life.    Any such use by you is entirely at your own risk, and you agree to hold WCI 
harmless from any and all claims or losses relating to such unauthorized use.

General
This License is the complete statement of the agreement between the parties on the subject matter, and 
merges and supersedes all other or prior understandings, purchase orders, agreements and 
arrangements.    This License shall be governed by the laws of the State of Connecticut, without regard to 
Connecticut choice-of-law rules.    Exclusive jurisdiction and venue for all matters relating to this License 
shall be in courts and fora located in the State of Connecticut, and you consent to such jurisdiction and 
venue.    There are no third party beneficiaries of any promises, obligations or representations made by 
WCI herein.    Any waiver by WCI of any violation of this License by you shall not constitute or contribute 
to a waiver of any other or future violation by you of the same provision, or any other provision, of this 
License. 



WinZip 8.1 Order Form/Invoice
To print this order form, select Print Topic from the File menu.
To order by check, send this completed order form and a check (in US dollars drawn on a US bank) to 
WinZip Computing, Inc., PO Box 540, Mansfield, CT 06268 USA.    

All orders are subject to the WinZip® License Agreement. Customer information is considered confidential
and will not be shared with or distributed to any third party.    This order form applies only to the English 
language version of WinZip.      Prices are in US dollars and are guaranteed through December, 2002.

WinZip Single-User License (on CD): ______ copies at $29 each = ___________

WinZip Site Licenses (includes one distribution CD):

2 to 9 computers: _____ computers at $22 per computer = ___________

10 to 24 computers: _____ computers at $17 per computer = ___________

25 to 49 computers: _____ computers at $14 per computer = ___________

50 to 99 computers: _____ computers at $10 per computer = ___________

100 to 199 computers: _____ computers at      $7 per computer = ___________

200 to 499 computers: _____ computers at      $6 per computer = ___________

500 to 749 computers: _____ computers at      $4 per computer = ___________

Add $5.00 shipping and handling + $5.00

Connecticut residents add 6% sales tax + ___________

Total payment US$ ___________

If you need a quote for higher quantities, please send a message to sitesales@winzip.com

Date: ___________________________

Name: _______________________________________________________
__

Company: _______________________________________________________
__

Address: _______________________________________________________
__

_______________________________________________________
__

City, State, Zip, Country: _______________________________________________________
__

Phone: _______________________________________________________
__

Fax: _______________________________________________________
__

E-Mail Address: _______________________________________________________



__



WinZip 8.1 Credit Card Order Form
To print this order form, select Print Topic from the File menu.
To order with a credit card by fax or mail, please complete this credit card order form and send it to:

Fax: 1-860-429-3542
Mail: WinZip Computing, Inc., PO Box 540, Mansfield, CT 06268 USA

All orders are subject to the WinZip® License Agreement.    Customer information is considered 
confidential and will not be shared with or distributed to any third party.    This order form applies only to 
the English language version of WinZip.    Prices are in US dollars and are guaranteed through December,
2002.

WinZip Single-User License (on CD): _____ copies at $29 each = ___________

WinZip Site Licenses (includes one distribution CD):

2 to 9 computers: _____ computers at $22 per computer = ___________

10 to 24 computers: _____ computers at $17 per computer = ___________

25 to 49 computers: _____ computers at $14 per computer = ___________

50 to 99 computers: _____ computers at $10 per computer = ___________

100 to 199 computers: _____ computers at      $7 per computer = ___________

200 to 499 computers: _____ computers at      $6 per computer = ___________

500 to 749 computers: _____ computers at      $4 per computer = ___________

Add $5.00 shipping and handling +  $5.00    

Connecticut residents add 6% sales tax + ___________

Total payment US$ ___________

If you need a quote for higher quantities, please send a message to sitesales@winzip.com

Date: ____________________________

Name: _______________________________________________________
___

Company: _______________________________________________________
___

Shipping Address: _______________________________________________________
___

_______________________________________________________
___

City, State, Zip, Country: _______________________________________________________
___

Billing Address: _______________________________________________________
___

(if different from above) _______________________________________________________
___

City, State, Zip, Country: _______________________________________________________
___

Phone: _______________________________________________________
___



Fax: _______________________________________________________
___

E-Mail Address: _______________________________________________________
___

Credit Card (circle one): MasterCard VISA AMEX Discover

Credit Card #: _______________________________________________________
___

Expiration Date: _______________________________________________________
___

Name On Card: _______________________________________________________
___

Signature: _______________________________________________________
___



Credit Card Orders by Phone
You can place credit card orders by phone at 1-877-724-4600 (toll free; US only), or 1-860-429-4649.

WinZip Computing, Inc. cannot be reached at the phone numbers above.    These numbers are for our 
credit card order handling service only.    If you have questions about WinZip®, or need WinZip technical 
support, you can send e-mail to help@winzip.com; our goal is to respond to all e-mail inquiries within one 
business day.

WinZip Pricing
WinZip Single-User License (on CD): $29 each

WinZip Site Licenses (includes one distribution CD):

2 to 9 computers: $22 per computer

10 to 24 computers: $17 per computer

25 to 49 computers: $14 per computer

50 to 99 computers: $10 per computer

100 to 199 computers: $7 per computer

200 to 499 computers: $6 per computer

500 to 749 computers: $4 per computer

There is a $5.00 per order charge for shipping and handling.    If you need a quote for higher quantities, 
please send a message to sitesales@winzip.com.

Your order will be shipped by postal mail (airmail outside the US) and will leave our office within two 
business days after the order is received.

All orders are subject to the WinZip License Agreement.    Customer information is considered confidential
and will not be shared with or distributed to any third party.    This order information applies only to the 
English language version of WinZip.      Prices are in US dollars and are guaranteed through December, 
2002.



Purchase Orders
Purchase orders (Net 30 days) are accepted from government and educational institutions and major 
corporations, provided that they are submitted on purchase order forms with a purchase order number. 
Detailed order requests on signed company letterhead are also accepted. All orders are subject to credit 
approval. Please include a completed Order Form with your purchase order and fax it to 1-860-429-3542 
or mail it to:

WinZip Computing, Inc.
PO Box 540
Mansfield, CT 06268 USA



German, French, and Japanese Versions
There are German and French language versions of WinZip®.    For Japanese users there is an English 
version with the Help file in Japanese.    Prices for these versions may vary from the prices for the English 
language version as purchased from WinZip Computing, Inc.

German Version: For a German language version of WinZip, please contact H.C. Top Systems, B.V., 
Postfach 13 30, D-47630 Straelen, Germany, phone: 08000-946-947 (toll free; Germany only) or +31-(0)-
77-306-8100, fax: +31-(0)-77-306-8130, visit their web site or send e-mail to support@winzip.de.

French Version: For a French language version of WinZip, please contact AB Soft, Park Burospace #14, 
91572 Bievres Cedex, France, phone: +33-(0)-1-69-33-7050.

Japanese Users: For a version of WinZip that includes a Japanese Help file, please contact P. & A. Inc., 
Fudoya Bldg 4F, 2-10-1 Akebono, Tachikawa, Tokyo, Japan 190-0012, phone: +81-(0)-42-525-9501, fax: 
+81-(0)-42-525-9502, e-mail: info@panda.co.jp.    P. & A. also maintains web sites in Japanese and in 
English.



Support and Questions
To check whether you have the most recent version of WinZip®, please check the WinZip home page at 
http://www.winzip.com.

Please see the section titled Frequently Asked Questions for answers to common questions.

Technical support is available at no charge as described below.    The best way to report problems is with 
the support forms available from the “Support” link on the WinZip home page (http://www.winzip.com). 
You can also send e-mail to help@winzip.com or postal mail to WinZip Computing, Inc., P.O. Box 540, 
Mansfield CT 06268.

When reporting problems, please include the following information:
1. Is the problem reproducible?    If so, how?
2. What version of Windows are you running (Windows 98, Windows 2000, etc.)?
3. What version of WinZip are you running (to see what version WinZip you have, choose About 

WinZip from the Help menu)?    Please include the entire “version” line in your problem report.
4. If a dialog box with an error message was displayed, please include the full text of the dialog 

box, including the text in the title bar.
5. If the problem involves an external program like LHA.EXE or SCAN.EXE, what version of the 

failing program are you using?    Please see the section titled System Requirements for minimum 
version numbers for these programs.

Note: You can press F1 at any time while WinZip is active for context sensitive help.



Downloading and Processing Files with WinZip
WinZip® has special features that make it simple and convenient to download and process compressed 
files from the Internet and online services like America Online and CompuServe.

Click to choose the method about which you would like to learn more:

Downloading From The Internet
Downloading From America Online, CompuServe, and Other Online Services



Downloading from the Internet
You can use WinZip® to work with archives you download from the Internet just as you do with other 
archives, or you can use the free Internet Browser Support Add-On to simplify your work with Internet 
downloads, as described below.

The free WinZip Internet Browser Support Add-On will automate much of the 
work normally associated with downloading compressed files from the Internet.    When you click 
on an archive using Microsoft Internet Explorer or Netscape Navigator/Communicator, WinZip will
take over when the download is completed. WinZip automatically moves the downloaded file to 
your download folder (initially set to c:\download) and then opens the file.    This add-on is 
available for download from the web page http://www.winzip.com/ibrowser.cgi (this free add-on is 
not part of the WinZip distribution package).

If you download an archive without the add-on the current versions of Microsoft 
Internet Explorer and Netscape Navigator/Communicator will give you a choice of opening the 
archive or saving it to disk.    If you choose to open the archive, you should be aware that the 
Internet Browser will probably delete the file when the browser is closed.    To avoid this problem, 
use the Internet Browser's “save to disk” option, and specify an easy-to-remember folder, for 
example, c:\download.

Problems Downloading?  When you download a file, many things can go wrong, resulting in a damaged
copy of the file that WinZip cannot open. The solution to most download related problems is simply 
to download the file again.    For more information on resolving Internet download related problems, 
please check the web page http://www.winzip.com/downprob.htm.

Note:

Many files available for download on the Internet are executable (.exe) files.    The WinZip Internet 
Browser Support Add-On will not try to handle these files.    However, if the .exe file is a self-extracting Zip 
file, you can open and process it in the WinZip Classic interface by choosing Open Archive from the File 
menu, or by right-clicking on the file and choosing Open with WinZip.

Related Topics:
Downloading from America Online, CompuServe, and other online services



Downloading from America Online, CompuServe, and other 
online services
An online service with its own access software will generally have a specific folder on your computer 
where newly downloaded files are placed. For example, America Online uses a folder named c:\aol\
download, and CompuServe uses a folder named c:\cserve\download.    After you download a Zip file from
one of these services in the normal manner, it's easy to use WinZip to open and process the file.

Start WinZip® by clicking on its icon, then click the Favorites toolbar button or select Favorite Zip 
Folders from the File pull-down menu.    The resulting dialog box shows all the Zip files in your Favorite 
Zip Folders with the most recently downloaded files at the top of the list, along with the folder in which 
they are located.

If your file or the special download folder is not shown, you can have WinZip search for the item by 
clicking on the Search button, then clicking Search hard disk(s) on this PC, and then clicking OK.    
WinZip will check all your hard drives and make a new list of Zip files, and update your favorite folders 
(the places where WinZip has found Zip files stored on your PC).    When the process is complete, newly 
downloaded files should be near or at the top of the list.    Highlight the file you wish to work with, then 
click the Open button.

See the section titled Hints For Working With Downloaded Files for more suggestions.

Note:
Many files available for download on the Internet are executable (.exe) files.    WinZip's Internet Browser 
Support will not try to handle these files.    However, if the .exe file is a self-extracting Zip file, you can 
open and process it in the WinZip Classic interface by choosing Open from the File menu, or by right-
clicking on the file and choosing Open with WinZip.

Related Topics:
Downloading from the Internet



WinZip Internet Browser Support Add-On
The free WinZip® Internet Browser Support Add-On will automate much of the work normally associated 
with downloading compressed files from the Internet.    When you click on a Zip file using Microsoft 
Internet Explorer or Netscape Navigator/Communicator, WinZip will take over when the download is 
completed. WinZip automatically moves the downloaded file to your download folder (initially set to c:\
download) and then, optionally opens the file.

Notes:

WinZip's Internet Browser Support Add-On is not part of the WinZip distribution package; it is available as 
a free download from the web page http://www.winzip.com/ibrowser.cgi. 

WinZip's Internet Browser feature supports Microsoft Internet Explorer and Netscape 
Navigator/Communicator, and depends on the implementation these browsers use for “helper” 
applications.    WinZip 8.1 has been tested with the latest release and the latest publicly available beta 
versions of Microsoft Internet Explorer, Netscape Navigator/Communicator, Windows 
95/98/NT/2000/Me/XP, as of September 2001.    It is possible that at some point in the future the browser 
vendors will release new versions of their browsers with different interfaces and conventions that are 
incompatible with WinZip 8.1's Internet Browser integration. If this happens, we plan to adjust WinZip to 
make it compatible.    We cannot guarantee that this will be practical, however, and it is possible that 
WinZip's Browser Integration will not be available for future versions of these browsers.



Desktop Theme Installer
What's a desktop theme?
A desktop theme is a collection of desktop attributes--colors, mouse pointers, sounds, wallpaper, and so 
on--that create a "theme" for your desktop.    Windows 95 (with Plus! installed), Windows 98, Windows 
Me, Windows XP, and Windows NT 4.0 (with add-on theme support installed) provide support for desktop 
themes. Please read this additional information if you are using Windows 2000.

Windows users have contributed a wide variety of themes that you can obtain, usually at little or no cost, 
from online sources such as the Internet or AOL.    Most commonly these are packaged in Zip files as a 
collection of components, often lacking a Setup program for installation.    Without a Setup, themes can be
somewhat difficult to install--but WinZip's desktop theme installer makes it easy.

The WinZip® desktop theme installer
If WinZip determines that the open Zip file contains a desktop theme, the Install button is enabled and you
will be able to use it to install your theme.    Simply click the Install button or choose Install from the 
Actions menu and follow the screen instructions.    Note: if the Install button isn't enabled, see the notes 
below; the desktop theme installer may be turned off.

After WinZip has extracted the necessary files to the correct folders, it will run the system theme installer 
(normally Themes.Exe) to complete your installation.    Here you can preview many of the changes, such 
as color, desktop icons, and wallpaper, provided by the theme designer. (Under some versions of 
Windows you may need to first select the new theme from the list of available themes in the Theme drop-
down list.)    If you like the theme, just click Apply and Themes will convert your desktop to the new theme.
If you don't like the theme, click Cancel and your desktop will be unaffected.    Consult your Windows 
documentation or help for more information about the theme installation program.

If you use the WinZip Wizard, the Wizard will automatically lead you through theme installation when you 
unzip a Zip file that contains a theme.

Please read this additional information if you are using a third party theme installer.

Notes
Here are some additional notes regarding desktop theme installation.

· A desktop theme is defined by a Desktop Theme File (.Theme extension), which must be 
contained in the Zip file.    WinZip assumes that any Zip file that contains a file with a .Theme 
extension is a desktop theme Zip file.    The Desktop Theme File identifies the various 
components of the theme and specifies exactly where they are to be located.    Because the files 
must be stored in the folders defined by the Desktop Theme File, WinZip does not provide you 
with an option to specify the folders to which the theme should be extracted.    It does, however, 
show you what folders will be used and allows you to cancel installation if desired.

· Microsoft has not documented the format of .Theme files.    The WinZip Desktop Theme Installer 
is designed to work with .Theme files as used by the current version of Microsoft's THEMES.EXE 
(4.0). It is possible that Microsoft may change the format of .Theme files or other aspects of 
desktop theme support and that, as a result, WinZip will no longer be able to support desktop 
theme installation.    Current information about desktop theme compatibility issues can be found 
on our website at http://www.winzip.com/thminfo.htm.

· Some desktop theme Zip files contain more than one theme.    When this is the case, WinZip 
allows you to choose which theme to install.

· If you would prefer to install desktop themes manually, you can disable the theme installer by 
choosing Configuration from the Options menu, clicking the Miscellaneous tab, and 
unchecking the box labelled "Desktop theme/screen saver installer."    This disables both the 
theme installer and the screen saver installer.

· We have found that many free desktop theme Zip files obtained from online sources are missing 



some components (such as cursors or sound files).    In some cases, filenames are simply 
misspelled in the Desktop Theme File; in others, components were omitted from the Zip file.    
This does not necessarily mean that the themes are unusable, just that they are incomplete.    
Before it extracts any files, WinZip will show you which components, if any, are missing from the 
theme package.

· A small percentage of free desktop themes simply do not work at all, for various reasons.    
Unfortunately, WinZip Computing, Inc. cannot offer support in getting malfunctioning desktop 
theme packages to work; please contact the theme's author or supplier instead.    (But don't let 
this discourage you--there are many excellent free theme packages available!)

· WinZip supports desktop themes only when they are packaged in Zip format.    It cannot install 
themes from other archive formats (ARJ, LZH, etc.).

· If the Zip file contains a SETUP or INSTALL program, WinZip will use the standard software 
Install feature rather than the desktop theme installer.



Screen Saver Installer
If WinZip® determines that the open Zip file contains one or more screen savers (.SCR extension), the 
Install button is enabled and you will be able to use it to install your screen saver.    Simply click the 
button or choose Install from the Actions menu and follow the screen instructions.    Note: if the Install 
button is disabled, see the notes below; the screen saver installer may be turned off.

After WinZip has extracted the necessary files to your Windows folder, it will run Microsoft's Display 
control panel application to complete your installation.    Here you can try out the screen saver and 
possibly modify its settings.    If you change your mind and don't want to install the new screen saver, 
simply select a different one from the installer's list before leaving the Display application.    Note that 
clicking Cancel from the Display application does not cancel installation of the new screen saver--it has 
already been installed.    Consult your Windows documentation or help for more information about the 
Display application.

If you use the WinZip Wizard, the Wizard will automatically lead you through screen saver installation 
when you select a Zip file that contains a screen saver.

Notes
Here are some additional notes regarding screen saver installation.

· Screen savers are typically installed to the Windows folder.    Therefore, WinZip does not provide 
you with an option to specify the folder to which the screen saver should be extracted.    It does, 
however, show you which files will be extracted and allows you to cancel installation if desired.

· Some Zip files contain more than one screen saver.    When this is the case, WinZip allows you to 
choose which one to install.

· Some screen savers require additional components (.DLL, .VBX, .OCX, .MID, and .WAV 
extensions).    WinZip assumes that any file in the Zip file with one of these extensions is a 
component of the screen saver and will extract it to your Windows folder along with the screen 
saver itself.

· If you would prefer to install screen savers manually, you can disable the WinZip screen saver 
installer by choosing Configuration from the Options menu, clicking the Miscellaneous tab, and
unchecking the box labelled "Desktop theme/screen saver installer."    This disables both the 
screen saver installer and the desktop theme installer.

· WinZip supports screen saver installations only when they are packaged in Zip format.    It cannot 
install screen savers from other archive formats (ARJ, LZH, etc.).

· If the Zip file contains both a desktop theme and a screen saver, WinZip will use the desktop 
theme installer (the screen saver is probably part of the theme and will be installed along with it).   
If the Zip file contains a SETUP or INSTALL program, WinZip will use the standard software 
Install feature.



Desktop Themes and Windows 2000
WinZip® does not officially support desktop theme installation under Windows 2000.    Please read
the following information carefully.
The WinZip desktop theme installer is not officially supported under Windows 2000 because Windows 
2000 itself does not support themes in the same way that earlier versions of Windows did.

The initial release of Windows 2000 (build 2195) does not include the Plus! package (or its equivalent) 
that was available for Windows 95, 98, or NT 4.0.    As a result, there are some differences between 
desktop theme support under Windows 2000 and earlier versions of Windows, and some potential 
problems that you should be aware of when using WinZip® to install desktop themes under Windows 
2000:

· The system theme installer (THEMES.EXE) is included with Windows 2000, but it is installed in 
the Windows system folder (typically C:\WinNT\System32) rather than in a separate folder as in 
the past (typically C:\Program Files\Plus!\Themes).

Because theme components are often extracted to folders that are relative to the folder where 
THEMES.EXE is stored, installing some themes may require WinZip to extract files to the system 
folder.    Some users may consider this to be undesirable behavior, and it is even possible for 
important system files to be overwritten.

· Some desktop themes specify that theme components must be extracted to the Plus! themes 
folder (C:\Program Files\Plus!\Themes) or to its subfolders.    In order to do this, WinZip must 
create the Plus! themes folder if it does not already exist.    Under Windows 2000, if this folder 
exists, the system theme installer THEMES.EXE may fail to recognize themes and theme 
components that are properly stored in the system folder and its subfolders.    That is, you may no
longer be able to use THEMES.EXE to activate themes that you have previously installed.

You may be able to correct this situation by deleting the Plus! folder, but be certain that there are 
no important files in the Plus! folder or its subfolders before doing so!

· Under previous versions of Windows, WinZip was able to tell the system theme installer which 
theme it should display when it starts up.    This does not work under Windows 2000; when the 
system theme installer starts, it displays the current desktop settings rather than the theme that 
WinZip has just extracted.    In order to view the components of the new theme, you must select it 
from the drop-down list labeled Theme.

It is possible that Microsoft might update Windows 2000 or release a Plus! equivalent that will address 
these issues.    However, at this time WinZip does not officially support desktop theme installation under 
Windows 2000.

Please visit our website for current information on themes and Windows 2000:

http://www.winzip.com/xw2kthm.htm

Related topics
Desktop theme installer



Viewing Zip Comments
A Zip comment is optional text information that is embedded in a Zip file.    It is often used to describe the 
contents of the Zip file or to provide other information that is not in the files contained in the Zip file.

Zip comments can be displayed automatically when you open a Zip file that contains a comment.    To 
enable this feature, choose Configuration from the Options menu, click the Miscellaneous tab, and 
check the box labeled Show comments when opening Zip files.

Zip comments can also be viewed from the WinZip® Wizard if you are using the Wizard to install software
or a desktop theme or screen saver from a Zip file that contains a comment.    Simply click the View Zip 
Comment button.

In the View Comment dialog:
· Click the Close button to close the dialog.
· Click Font to specify a new display font. This does not affect the comment in the Zip file, but is 

retained as your preference for viewing comments in future sessions.
· If the View Comment dialog was displayed automatically when opening a Zip file, there will be a 

checkbox labeled Show comments when opening Zip files.    Uncheck this box to disable the 
automatic comment display feature.

Tip: to edit or remove a Zip comment, open the Zip file in Classic mode and choose Comment from the 
Actions menu.



Why aren't WinZip's e-mail features working for me?
WinZip® support for e-mailing archives requires that you have an e-mail program installed and properly 
configured. If there is a problem with your e-mail configuration, then these features will either be disabled 
or nonfunctional.

WinZip uses a Windows feature called MAPI (Mail Applications Program Interface) to "talk" to your e-mail 
program. MAPI is a standard interface that allows WinZip and other programs to instruct your e-mail 
program to create a new message, attach a file to it, etc.    If MAPI is not properly configured on your 
system, then WinZip and other programs can't create e-mail for you.    "Properly configured" means that:

· you have a MAPI-compliant e-mail program installed, and
· the e-mail program properly supports the "Simple MAPI" interface that WinZip requires, and
· the e-mail program is configured to be the default e-mail program (sometimes called the "default 

MAPI client").

Examples of popular MAPI-compliant e-mail programs include (but are not limited to) Outlook, Outlook 
Express, Eudora, and AOL 7.0.

AOL versions 4.0, 5.0, and 6.0 are not MAPI-compliant and therefore do not support WinZip's e-mail 
features.

If you are having difficulty e-mailing your archives with WinZip, we have tips for some popular 
configurations available on our website.    Please visit http://www.winzip.com/xmapi.htm.



The WinZip Quick Start Guide
This Quick Start Guide introduces some file compression terms, describes some of the initial steps in 
installing WinZip, and provides a first look at using some WinZip® features. For additional information, 
see the tutorials that come with WinZip, WinZip help, and visit the WinZip web site at 
http://www.winzip.com.

What is an Archive or Zip file, anyway?
Zip files are "archives" used for storing and distributing files, and can contain one or more files.    Usually 
the files "archived" in a Zip file are compressed to save space. Zip files are often used to:

· Distribute files on the Internet: Only one Zip file transfer operation (download) is required to 
obtain all related files and file transfer is quicker because the archived files are compressed.

· Send a group of related files to an associate: When you distribute the collection of files as an 
archive you benefit from the file grouping and compression as well.

· Save disk space: If you have large files that are important but seldom used, such as large data 
files, simply compress these files into an archive and then unzip (or "extract") them only when 
needed.

What does WinZip do?
WinZip makes it easy for Windows users to work with archives.    WinZip features an intuitive point-and-
click drag-and-drop interface for viewing, running, extracting, adding, and deleting files in archives with a 
standard Windows interface, and also provides a Wizard interface that further simplifies the process of 
working with Zip files.

About WinZip's Setup Options
During the WinZip setup procedure you are asked to select either the WinZip Wizard interface or the 
WinZip Classic interface.

· WinZip Wizard: If you are new to computers, or unfamiliar with the Windows operating system, 
then you should first try using the WinZip Wizard to open and create your Zip files.

· WinZip Classic: The more powerful WinZip Classic interface is recommended if you are an 
experienced computer user, comfortable with using Windows and Zip files.

In the following section we will describe the WinZip Wizard Setup screens. With either interface, the setup
panels provide information about the options offered. Whichever setup option you choose, you can easily 
switch between the two interfaces at any time with a single click, and you can always change the default 
settings later.

Installing the WinZip Wizard
We will refer to the on-screen panels using the title that appears at the top of each panel.    

1. In the WinZip Setup panel, choose Start with the WinZip Wizard and click Next. The Search for 
Favorite Zip Folders panel will appear.

2. In the Search for Favorite Zip Folders panel, choose Search Entire Hard Disk so the Wizard can
search your system for Zip files (this is the recommended option).    You will see the search 
progress, and then a panel that says something like "17 folders were added to your 'Favorite Zip 
Folders'".    Click Next. 

3. The WinZip Wizard Setup is complete panel displays. Click Next to continue, and the Wizard 
Welcome panel will appear.

4. In the Wizard Welcome panel, click Next again, and the Select Activity panel will appear.

That's it, you have installed WinZip, and you're ready to begin using the WinZip Wizard. The sections 
below describe using the Wizard for unzipping and zipping files.



Using the WinZip Wizard
If you have just installed WinZip and selected the WinZip Wizard interface, then at this point the Select 
Activity panel is on the screen.

If you have previously installed WinZip, you can start a WinZip session using the WinZip program item in 
the WinZip program group, the Start menu, or the WinZip icon on your desktop.

Here is a brief introduction to the features of the WinZip Wizard.

Quick Unzipping with the WinZip Wizard
1. In the Select Activity panel, choose Unzip or install from an existing Zip file and click Next. 

The Select Zip File panel will appear. 
2. In the Select Zip File panel, click on the Zip file you want to work with and click Next. The Unzip 

panel will appear.
3. In the Unzip panel, click Unzip Now to open the files in the archive. The WinZip Wizard will open 

a Windows Explorer window showing the unzipped files.

That's it, you've just unzipped (extracted) a Zip file using the WinZip Wizard. You can now work with the 
unzipped files, or click Next to choose another activity within WinZip, or close the WinZip Wizard window.

Quick Zipping with the WinZip Wizard
1. In the Select Activity panel, choose Create a new Zip file and click Next.
2. In the Choose Zip Name panel, type the name you want to use for your new Zip file and click 

Next. For example, if you are creating a Zip file that will contain some files related to monthly 
reports, you might type “June reports” as the name for your Zip file.

3. In the Select Files panel, click Add files to add files to your Zip file, then select the files you want 
to add and click OK.

4. Click Zip Now to create the new Zip file.

That's it, you've just created a Zip file using the WinZip Wizard. You can now click the WinZip Classic 
button if you would like to examine the contents of your new archive, or click Next to choose another 
activity within WinZip, or close the WinZip Wizard window.

Using WinZip Classic
Here is a brief introduction to some of the features of WinZip Classic.

Quick Unzipping with WinZip Classic
1. In the WinZip Window click the Open toolbar button, or choose Open Archive from the File 

menu. The Open Archive dialog box will appear.      
2. In the Open Archive dialog box you can locate the archive you want to unzip. Then click Open. 

The contents of the archive will be displayed in the WinZip window.
3. To extract files from the archive click the Extract toolbar button, or choose Extract… from the 

Actions menu. The Extract dialog box will appear. 
4. In the box labeled Extract to: choose the folder where you want to place the extracted files and 

click Extract.
That's it, you have extracted the contents of the archive to the chosen directory. You can now work with 
the extracted files, or choose another activity within WinZip, or close the WinZip window.

Note: You can also extract files from an archive in the WinZip Classic window by dragging them to the 
desired folder in Windows Explorer or to the desktop.

Quick Zipping with WinZip Classic
1. In the WinZip Window click the New toolbar button, or choose New Archive from the File menu. 

The New Archive dialog box will appear.      



2. In the New Archive dialog box you can specify the location where you want to create the archive, 
and type the name you want to use for your new archive. Then click OK. The Add dialog box will 
appear.

3. In the Add dialog box select the files that you want to add to your new archive and click Add.

That's it, you have created a new archive. You can now examine the contents of your new archive, or 
choose another activity within WinZip, or close the WinZip window.

Note: You can also add files to an archive by dragging the files from My Computer or Windows Explorer 
and dropping the files on the WinZip window.

WinZip Classic and Wizard: Switching Interfaces
You can easily switch between the WinZip Wizard and WinZip Classic Interfaces with a single mouse 
click. Here's how:

In WinZip Wizard click the WinZip Classic button at the lower left part of the Wizard panel to switch to 
the WinZip Classic Interface.

In WinZip Classic click the Wizard button at the upper right end of the WinZip Classic toolbar to switch 
to the WinZip Wizard Interface.

WinZip Classic Tips
You can view the contents of most files in an archive by just double clicking on them in the WinZip Classic
window.

You can extract files from an archive in the WinZip Classic window by dragging them to the desired folder 
in Windows Explorer or to the desktop.

Using the WinZip Classic Help menu, you can:
· work with the built-in Brief Tutorial to get acquainted with more of WinZip's features 
· view collections of Hints and Tips 
· find answers to Frequently Asked Questions

Zip and Unzip Files without Leaving Explorer
To create an archive: you can select file(s) in Windows Explorer, right click, and choose Add to Zip file 
from the context menu that appears. 

To extract files from an archive: you can select the archive in Windows Explorer, and either: 
· right click and choose Extract to... from the context menu that appears, or 
· right click and drag the archive onto the folder where you want it extracted, and then choose an 

extract option from the context menu that appears.

Contacting Technical Support
You can contact our technical support staff as follows:

Internet: The best way to report problems on the Internet is with the support forms available from the 
“Support” link on the WinZip home page at http://www.winzip.com. You can also send electronic mail to 
support@winzip.com.    We normally answer all questions within one business day. 

Postal Mail:    Write to Technical Support, WinZip Computing, Inc., P.O. Box 540, Mansfield, CT 06268, 
USA. 

Please include the following information with any technical support questions: 
· Is the problem reproducible? If so, how?
· What version of Windows are you running (for example, Windows Me or Windows 2000)?



· What version of WinZip are you running? If you are using the WinZip Classic Interface, choose 
About WinZip from the WinZip Help menu. If you are using the WinZip Wizard Interface, click the
About button on the WinZip Wizard Welcome screen. Please include the entire "version" line in 
your problem report.

· If a dialog box with an error message was displayed, please include the full text of the dialog box, 
including the title in the title bar.



Password Security
WinZip® uses the standard Zip 2.0 encryption format, a format that is also supported by most other Zip 
utilities.

Password protecting files in a Zip file provides a measure of protection against casual users who do not 
have the password and are trying to determine the contents of the files. However, the Zip 2.0 encryption 
format is known to be relatively weak, and cannot be expected to provide protection from individuals with 
access to specialized password recovery tools.

You should not rely on WinZip password protection to provide strong security for your data.    If 
you have important security requirements for your data, you should look into more robust cryptography 
solutions. 
Using password security while using the Extract, Test, CheckOut, or Install features:
If you use the Extract, Test, CheckOut, or Install features on a password protected archive, you will 
automatically be prompted for the password.

Using password security while adding or updating an archive:
To password protect files, it is important to specify the password AFTER opening or creating an archive 
and BEFORE adding the files.

Follow these steps to password protect files in an archive:
1. Open or create an archive.    If you are using the New Archive dialog box, check the Add Dialog 

checkbox at the bottom of the dialog box.
2. In the Add dialog box, click the Password button, and type a password.

Notes
· The main WinZip window lists password protected files with a plus sign following the filename.
· In addition to the methods specified above, you can choose Password from the Options menu to

specify a password.
· Use the Mask password checkbox to control whether the password is hidden while typed.    If 

you check this option, you will have to re-type the password for confirmation (to avoid 
typographical errors).

· Passwords are cleared (reset so that no password is in effect) when an archive is closed or 
another archive is opened.

· Passwords can also be used for ARJ files; in this case, the external ARJ program is responsible 
for all data encryption.

· In general, longer passwords (for example, passwords with 8 or more characters) are more 
secure than shorter passwords, and passwords that contain a mixture of alphabetic characters, 
numeric characters, and punctuation characters are more secure than passwords containing only 
alphabetic characters.

· Be sure to remember any passwords you use, so that you can extract your files!



Select Folder
Use this dialog to select a folder for the operation you are performing or the configuration option you are 
setting.

Use the Folders and disk drives tree to browse your system for the desired folder.

You can create a new folder by clicking the "new folder" button  and typing the name of a new folder.    
Note: this button is not present when you are choosing a folder where WinZip should look for existing 
files; it is only present when you are choosing a folder where WinZip will be storing files.

Click OK when the desired folder appears in the field at the top of the dialog.



WinZip Quick Pick taskbar tray icon
The WinZip® Quick Pick taskbar tray icon  gives you instant access to WinZip and recently used 
archives.
Enabling and disabling Quick Pick
To enable or disable the WinZip Quick Pick taskbar tray icon, check or uncheck Include WinZip Quick 
Pick in the taskbar tray in the System tab of WinZip's Configuration dialog.    When Quick Pick is 
enabled, the WinZip icon will automatically appear in the system taskbar tray whenever you start your 
system.

Using the WinZip Quick Pick taskbar tray icon
To open WinZip, simply click the Quick Pick icon using the left mouse button.    For more options, right 
click the icon to open the Quick Pick menu and:

· Click any archive in the list of recently opened archives to start WinZip and reopen the archive.
· Click Favorites to start WinZip and display a list of files in your Favorite Zip Folders.    You can 

open any listed archive by double clicking it.
· Click Open WinZip to start WinZip (same as left clicking the icon).
· Click WinZip Help to view WinZip's help.
· Click About for Quick Pick version and copyright information.
· Click Close to close WinZip Quick Pick and remove the icon from the taskbar tray.    You will have 

the option to close Quick Pick but leave it enabled (so it will return the next time Windows is 
started) or to close it and disable it (so it won't return the next time Windows is started).

Restarting Quick Pick after closing
· If you close Quick Pick but leave it enabled, Quick Pick will restart automatically the next time 

Windows is started.    To restart it manually (without restarting Windows), click the Start button, 
choose Startup from the Programs menu, and click WinZip Quick Pick.

· If you close and disable Quick Pick, it will not restart automatically the next time Windows is 
started.    To restart it, you must re-enable it as described above.



Explorer context menu enhancements
You can access many WinZip® features directly from the context menus of My Computer and Windows 
Explorer.    When you right click files or folders in My Computer or Windows Explorer, Windows displays a 
pop-up ("context") menu containing actions that are appropriate for the selected items.    WinZip can add 
entries to the context menu that allow you to open and create archives, add and extract files, mail 
archives, etc.

Configuring the context menu
You can configure WinZip's context menu enhancements using the Explorer Enhancements tab of the 
WinZip Classic configuration dialog (choose Configuration from the Options menu; Wizard users will 
need to temporarily switch to Classic mode to do this).    

Alternatively, if WinZip is configured to display its entries in a submenu of the Explorer context menu, you 
can access the configuration dialog directly by right clicking any file or folder in an Explorer window and 
then clicking Configure in the WinZip submenu.

In the configuration dialog you'll find options on how and where WinZip's menu items are displayed, and 
you can enable or disable many of the items individually.    Click the Help button or press F1 in the dialog 
for specific help on the options.

Using the context menu
To use the context menu, simply right click a file or folder in My Computer or Windows Explorer.    WinZip 
will add items to the context menu that are appropriate to the file or folder you selected.    These items will 
appear either in the main context menu or in a submenu labeled "WinZip," depending on your 
configuration option.

Some WinZip context menu items are also appropriate for multiple selections.    For example, you can 
select several files and add them all to a Zip file in one operation, or you can select multiple Zip files and 
extract from all of them at once.    To do this, left click a file or folder to select the first item, hold down the 
Ctrl key and left click to select additional items, and then right click any selected item to pop up the 
context menu.    See your Windows help for more ways to select multiple files.

Main context menu items
These items appear in the main Explorer context menu if the selected item is an archive.

· Open with WinZip: starts WinZip and opens the selected archive.    If multiple archives are 
selected, a separate WinZip window will be opened for each archive.    See also the separate 
Open with WinZip submenu entry described below.

· Print: this is a standard Windows menu entry; however, if the selected item is an archive, 
Windows will use WinZip to print a list of files contained in the archive. 

Submenu items
These are the menu entries you may see in the WinZip submenu.    The actual entries that appear in any 
particular case depend on the type(s) of file(s) you have selected.    Note: these items will appear in the 
main menu rather than a submenu if you have cleared the Display context menu items in a submenu 
checkbox in your configuration.

· Add to Zip file…: adds the selected items to a new or existing Zip file.    A dialog appears in 
which you can specify the Zip file name, and WinZip remains open after the add operation is 
complete.

· Add to filename.zip: adds the selected items to the named Zip file; the name is based on the 
name of the selected item, or the folder name if multiple items are selected.    WinZip adds the 
selected items to the Zip file, creating a new Zip file if necessary.

· Add to recently used Zip file: opens a submenu listing recently used Zip files.    The selected 
items are added to the Zip file you pick from the list.  Note: this item is enabled or disabled by the



configuration option labeled "Add to recently used Zip file <file history>".
· Open with WinZip: this is a separate entry from the Open with WinZip that appears at the top of

the main context menu when an archive is selected.    It appears when the selected item is a self-
extracting archive (.exe) or a media "skin" file for programs such as Windows Media Player 
(.wmz, etc.).    These types of files are not associated with WinZip, so Windows will place a 
standard Open option at the top of the menu; Open will start the program (if it is a self-
extracting .exe file) or open the file in the media player (if it is a skin file).    However, these file 
types can also be opened with WinZip, just like standard Zip files.    To do this, choose Open with 
WinZip from the submenu.
Note: this item is enabled or disabled by the configuration option labeled Open unassociated 
archives with WinZip.

· Zip and E-Mail filename: WinZip compresses the selected items into a temporary Zip file with the
specified name, creates a new e-mail message, and attaches the Zip file.    You can then address 
and send the e-mail as you usually would.    WinZip deletes the temporary Zip file when it is no 
longer needed.

· Zip and E-Mail Plus…: this item is similar to Zip and E-Mail filename, but you can specify the 
filename to be used for the Zip file, and you can optionally password-protect it.

· Configure…: displays the configuration dialog for WinZip's Explorer enhancements, including the
context menu.    This allows you to adjust the context menu and other options without starting 
WinZip.    Note that this option is only available if WinZip's context menu items appear in a 
submenu. 

The following submenu items appear only if the selected item is an archive or, in some cases, multiple 
archives or self-extracting archives.

· Extract to …: WinZip's Extract dialog appears and you can choose a folder to which the files in 
the archive(s) will be extracted. Note: this menu entry also appears when you use the right mouse
button to drag and drop an archive.

· Extract to here: the files in the archive(s) are extracted to the folder that is displayed in the 
Explorer window. Note: this menu entry also appears when you use the right mouse button to 
drag and drop an archive.

· Extract to folder folder-name: the files in the archive are extracted to the specified folder, which 
is created if necessary.    The folder name is derived from the archive name.

· Extract to here using file names for folders: this item appears only if multiple archives are 
selected.    The files in the archives are extracted to subfolders of the currently displayed folder 
("here"), using the archive names for the subfolder names.    For example, if the Explorer window 
shows the folder Downloads and you choose this option to extract from the Zip files One.zip and 
Two.zip, the files are extracted to Downloads\One and Downloads\Two.

· Extract to folder …: opens a menu listing folders to which files have recently been extracted.    
The files in the archive(s) are extracted to the folder you pick from the submenu. Note: this item is
enabled or disabled by the configuration option labeled "Extract to folder <folder history>".

· E-mail filename: creates a new e-mail message and attaches the selected archive.    This option 
appears only if a single archive is selected.

· Create Self-Extractor (.Exe): starts WinZip Self-Extractor, which allows you to create a self-
extracting program file (.exe) from the Zip file.    This option is available only if the selection 
consists of a single non-self-extracting Zip file.

See also
Using the Explorer Interface
Explorer Enhancements (Configuration Dialog)




